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INTRODUCTION 
 
This document is for Consultant and State Employees responsible for working on Capital 
Projects.  This manual covers the preparation, review, and delivery of capital project documents 
across the whole project timeline from project initiation to project completion.  This manual also 
covers design phase scheduling.   
 
Questions or inquiries regarding the subject matter can be forwarded to the following contacts:  
 
William Pratt P.E. 
Transportation Principal Engineer 
AEC Applications  
HUwilliam.pratt@ct.gov 
860.594.3320 
 
Bruce Bourgoin P.E. 
Transportation Supervising Engineer 
AEC Applications 
HUbruce.bourgoin@ct.gov 
860.594.2760 
 
Mathew Calkins P.E. 
Transportation Supervising Engineer 
AEC Applications  
mathew.calkins@ct.gov 
860.594.2988 
 
             

 

Revision History 
 
Digital Project Development Manual Revision History 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:Uwilliam.pratt@ct.gov
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ce.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/preparing_fio_sheets.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/DigitalProjectDevelopmentManualRevisionHistorypdf
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DEFINITIONS  
ACD – The attribute applied to a revision requested by the Processing unit to an ADP discipline 
subset.   
 
ACD2 – The attribute applied to a revision requested by the Processing unit to an ACD discipline 
subset.   
 
ADP – The attribute applied to an Addendum discipline subset. 
 
ATLAS – This tool is used to manage the location of various assets, projects, and investigations.  
 
Bluebeam – PDF software similar to Adobe Acrobat.  Bluebeam software will be required to 
package and markup all Shop Drawing Submittals. 
 
CIM – Civil Integrated Management 
 
CSI – Construction Special provisions Institute  
 
DCD – The attribute applied to a revision requested by the Processing unit to an FDP discipline 
subset.    
 
DCD2 – The attribute applied to a revision requested by the Processing unit to a DCD discipline 
subset.    
 
Discipline Subset – A multi-page PDF document that includes all the contract plan sheets for a 
discipline.  Example would be all the structures sheets would be packaged in (1) multi-page PDF 
document.   
 
DCO – The attribute applied to a design initiated change order discipline subset. 
 
DPD – Digital Project Development Manual. 
 
EED – Electronic Engineering Data 
 
Engineer of Record – The engineer’s digital signature that is applied to the discipline subsets.  
For CTDOT staff this would be the Principal Engineer.  
 
FDP –The attribute applied to a final design plans discipline subset. 
 
FIO – The attribute applied to a “for information only” discipline subset.   
 
FPL – The attribute applied to an advertised FDP discipline subset 
 
O365 – Microsoft Office 365 
 
Project Manager – Lead designer on the project.  For CTDOT staff this would be the TE 3 or 
Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.     
  
ProjectWise - CTDOT is currently using Bentley’s ProjectWise as a data management software 
for digital projects and asset document storage.  ProjectWise allows the CTDOT, and authorized 
business partners to access its data anywhere internet access is available. 
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Set File – Is a consolidated viewer file that is created using Bluebeam.  When this file is opened 
all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels in the 
correct order.  
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 Prerequisites and Policies 

The following details various requirements and policies that need to be followed when working 
on a Capital projects for the Connecticut Department of Transportation (CTDOT).   
Software Requirements 

1. Document Management Software – CTDOT currently uses Bentley’s ProjectWise for a 
document management solution, but is transitioning to COMPASS/O365.  See Section 2 
for more information. 

2. PDF Software – CTDOT has standardized on Bluebeam for our PDF software and shall be 
the only PDF software supported by the Connecticut Department of Transportation for 
the processes set forth in this manual.    

a. Bluebeam Revu was used in the production of all figures and procedures in this 
manual.  A license of Bluebeam Revu version 16.5 or higher must be purchased 
to perform all the procedures in this manual.    

b. A CTDOT Bluebeam profile has been created that includes a standard set of 
tools in the tool chest.  This profile can be found in Appendix A of this manual.  

Digital Signatures Requirements 
1. All contract plans, working drawings, and applicable engineering reports submitted to 

the Department shall be digitally signed by a CT licensed Engineer or CT licensed 
Architect in accordance with this manual.   

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design 
Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated 
Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be 
digitally signed in conformance with this manual. 

a. Digital signatures must meet the requirements of Adobe’s Certified Document 
Services (CDS) or Adobe Approved Trusted List (AATL).   

b. AATL and AATL vendor information is provided at the following website: 
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html  

c. Trial CDS/AATL Signatures will not be accepted by the Department, a signature 
must be purchased from one of the CDS/AATL Vendors.  

3. Bluebeam Revu or Extreme is required for all digital signature processes. After contract 
plans have been advertised, the digital signature is not allowed to be removed.   

CAD Standards 
1. Standard Computer Aided Design (CAD) Applications shall conform to those listed here 

CTDOT CAD Standards Website 
Policies 

1. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using 
the [Digital Submission Procedure set forth in this Manual] has the same force and 
effect for the purposes of the Consulting Engineer’s agreement with the State as a 
signature and seal of a Connecticut Licensed Professional Engineer or Architect as set 
forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the 
Connecticut General Statutes, as applicable. Nothing in this DPD serves as an 
authorization for, or endorsement of, the use of this [Digital Submission Procedure] 
generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed 
Professional Engineer or Architect with respect to other work it performs for the State 
or work it performs for other clients. 

2. When on call consultants are used for CTDOT projects, the title sheet shall be digitally 
signed by CTDOT following the procedure in Section 5.6.1 of this manual.     

3. When a document reaches a final status a “Final Status” shall be placed on the 
document.  This will lock for editing and ensure document retention.  

https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
https://portal.ct.gov/DOT/Engineering-Applications/Digital-Project-Solutions---AEC-Main-Page
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 Document Management Systems 

CTDOT is currently using Bentley’s ProjectWise as a data management software for CTDOT 
Capital Projects and CTDOT Assets.  ProjectWise has the ability to store documents and 
associated business data in one centralized location and allows the CTDOT, and its authorized 
business partners access its data anywhere internet access is available.  ProjectWise access is 
available to all CTDOT employees, consultant engineers, contractors, municipalities, utility 
companies, or any other supporting agencies that work on Capital Projects or Assets for CTDOT.     
 
CTDOT is also working to transition from ProjectWise to a new system called COMPASS.  The 
objective of COMPASS is to provide CTDOT with project management processes that work in 
conjunction with a cloud-based digital Transportation Management Solution, utilizing Microsoft 
Commercial Off-the-Shelf Software (MCOTS) to manage the delivery of all capital projects.  
Specifically, this solution will provide improved quality and control over complex transportation 
projects by providing: 

• Submittal and Transmittal Ball-In-Court functionality 

• Better collaboration and communication using SharePoint online 

• Real-time project scheduling capabilities using integrated MS Project files 

• Improved resource management 

• Real-time project status dashboards 

• Document control and content management 

• Improved transparency and accountability 

• Improved risk management 

This manual will be updated as more functionality is transitioned from ProjectWise to COMPASS, 

but to help in this transition period, the following table details what needs to be done in what 

system.  

 

Functionality System 

Project Team Assignment COMPASS 

Engineering Document Submittals ProjectWise 

MS Project Engineering Schedules COMPASS 

Design Reviews  ProjectWise 

FDP Submittal and any addenda ProjectWise 

Design Initiated Change Order Submittals ProjectWise 

Construction Submittals COMPASS 

 ProjectWise  
The following form can be filled out to gain access to the CTDOT’s ProjectWise Site:  ProjectWise 
New User Form   
 
Each users working at a consultant firm, contractor, municipality, utility company, and other 
supporting agency is given a unique user name.  If a person leaves a firm, it is the firm’s 
responsibility to notify CTDOT so we can disable that person’s account.  
 
The following links allow the user to change their password or reset the password if it is 
forgotten or lost: 

Change ProjectWise Password 

https://portal.ct.gov/-/media/DOT/documents/AEC/ProjectWiseNewUserFormpdf.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ProjectWiseNewUserFormpdf.pdf
https://extranet.projectwiseonline.com/Shared%20Documents/Change%20Password.aspx
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Forgot or Lost ProjectWise Password 
 
There are two ways to access CTDOT’s ProjectWise site:  Either ProjectWise Thin Client (Web 
Version) or ProjectWise Explorer Client (thick client – installed software).  
 

ProjectWise Thin Client 
Thin client is a web based version of ProjectWise, which does not require any software 
installation.  All that is required to access ProjectWise over the web is a user name and 
password supplied by CTDOT.   Thin client allows access to the CTDOT dataset anywhere 
internet access is available.  To use Thin Client, follow this document for the initial setup.  This 
only needs to be done once:   Thin Client First Time Set Up   
 
After the above settings document has been followed, use this link to access ProjectWise Thin 
Client:  https://ctdot.projectwiseonline.com  
 

ProjectWise Thick Client 
The thick client conversely requires the installation of the ProjectWise client software. In 
addition to performing all the functions of thin client; thick client has the addition functionality: 
 

- Delta file transfer – Improves speed of downloads 
- Managed workspaces – Eliminates the need to install the CTDOT DDE 
- Attributing multiple documents at once 

 
Download ProjectWise Explorer Client from Bentley using your select ID.  Once ProjectWise is 
installed on your computer use this document to connect to the data source:  
 

Connecting to Data source Using Thick Client 
 

ProjectWise Apps 
Users can also get to CTDOT’s ProjectWise data source using the various applications.  These 
applications require a URL to connect to a ProjectWise data source.  The table below lists the 
server URL for each application:   
 

Applications  URL 

ProjectWise  ctdot-ws.projectwiseonline.com/pwmobileaccess 
 

WorkSite  
ProjectWise Edge 

https://Ctdot-ws.projectwiseonline.com/ws 
 

 

Access in ProjectWise 
Access to content in ProjectWise is set at the folder level based on the group a user is in.  The 
following details, at a high level, the access for the various groups.  Section 2.3 of this document 
provides more information for the folders mentioned below:  

• CTDOT Employees - Access to all projects and all asset content. 

• Consultants  and CE & I Firms 
o Active Projects – Can only access projects that the firm is working on.  
o Legacy Projects – Access to all the legacy projects. 
o Assets – Access for asset content if firm is pre-qualified to work on that asset 

based on CTDOT’s pre-qualified consultant lists.   

• Contractors  
o No Access to ProjectWise 

• Municipalities 

https://extranet.projectwiseonline.com/Shared%20Documents/Forgot%20Password.aspx
https://portal.ct.gov/-/media/DOT/documents/AEC/ProjectwiseThinClientFirstTimeSetuppdf
https://ctdot.projectwiseonline.com/
http://www.bentley.com/
http://www.ct.gov/dot/lib/dot/documents/aec/Connecting_to_Datasource_using_Thick_Client.pdf
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o Active Projects – Can only access projects in their town. 
o Legacy Projects – Access to all the legacy projects. 
o Assets – No access to asset content. 

• Utility Companies  
o Active Projects – Can only access projects that a firm is working on. 
o Legacy Projects – Access to all the legacy projects. 
o Assets – No access to asset content. 

• Other Supporting Agencies 
o Active Projects – Can only access projects that an agency is working on. 
o Legacy Projects – Access to all the legacy projects. 
o Assets – No access to asset content. 

Setting Documents to Final Status in ProjectWise 
Once a document has reached it final status, where no more editing is required and it is ready 
for permanent storage a final status will be applied to the document as shown below: 

1. Right click on the file and select Change State>Set Final Status.   

 

Figure 1 - Set Final Status 

This will lock the file so no one can delete it.  If a user needs to remove the final status contact 
DOT.AECApplications@ct.gov  

 COMPASS Overview 
COMPASS is a cloud-based application built on Microsoft SharePoint pages.  Thus, users require 
an Office 365 (O365) account to access the site.  This account provides access to COMPASS as 
well as many other useful Office 365 applications.  CTDOT users are provided with a CTDOT 
O365 license.  External user invitations are sent to non-CTDOT personnel – such as consultants 
and contractors – to grant project-specific COMPASS site access. 
 
Presently, COMPASS provides a single place to display the following project information: 

• Rights-of-Way 

• Environmental Permits 

• CORE data 

• Viewport data 

• Composite Project Database (CPD) 

• Submittal/Transmittal Application 

• Project Staff Management 

mailto:DOT.AECApplications@ct.gov
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• MS Project Schedule Integration 

• Document Storage/Control 

• Security/User Management 

• Project Geospatial Location (Polygon) 

The Microsoft Online sign-in page is located at https://www.office.com, or can be found by 
internet searching for “Office 365 log-in.” 
 

 

Figure 2 - O365 Sign In 

 

Sign-In Name 
For CTDOT personnel, user sign-in names match computer sign-in names and are not the ct.gov 
email addresses.  Sign-in names are typically in the following format:   
 

[Full Last Name] + [First Initial] + [Middle Initial] @dot.ct.gov 
 

Examples:  LynchKL@dot.ct.gov, MurphyZ@dot.ct.gov 
 

Sign-In Password 
For CTDOT personnel, user sign-in passwords match computer sign-in passwords.  If the 
computer password is changed, the Microsoft Online password is automatically changed. 

It is recommended that users add COMPASS as a web browser trusted site.  This needs to be 
done one time per each user log-in name and per each device.  If the trusted sites are not 
added, when a user tries to access COMPASS the following error message may appear (“Loading 
Projects…”): 

 

Figure 3 - COMPASS Browser Set Up 

 

https://www.office.com/
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Take the following steps to add the COMPASS trusted sites to Internet Explorer (IE).  
1. Open an Internet Explorer browser window. 

2. Click on the settings gear in the upper-right hand corner of the window.  Select Internet 

Options. 

 

Figure 4 - COMPASS Trusted Sites 

 
3. Navigate to the Internet Options Security tab.  Click Trusted Sites.  Then press the Sites 

button. 

 

Figure 5 - COMPASS Trusted Sites 
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4. In the top field labeled “Add this website to the zone,” input the following three sites:   

https://compassapis-prod.azurewebsites.net 
https://ctgovdot-myfiles.sharepoint.com    
https://ctgovdot.sharepoint.com 
 

Press Add after inputting each individual site. 
 

 

Figure 6 - COMPASS Trusted Sites 

 
5. The site names will now show in the Websites section.  Press Close to exit the Trusted 

sites window. 

 

Figure 7 - COMPASS Trusted Sites 

 

https://compassapis-prod.azurewebsites.net/
https://ctgovdot.sharepoint.com/
https://ctgovdot.sharepoint.com/
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6. In the Internet Options window, select the Security tab.  Check Enable Protected Mode. 

 

Figure 8 - COMPASS Trusted Sites 

 
7. Press OK to exit the Internet Options window. 

8. Close Internet Explorer.  

For CTDOT users, after logging in to Office 365, navigate to SharePoint, then search for the 
COMPASS site.  This location can also be reached via the following URL:  
https://ctgovdot.sharepoint.com.  The first project shown in the list will be highlighted by a blue 
bar and display the Landing Page information in the center and right sections of the page.   
 

 

Figure 9 - O365 

 

https://ctgovdot.sharepoint.com/
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Figure 10 - Searching for COMPASS 

 

 

Figure 11 - COMPASS 

 Project Container for an Active Capital Project 
ProjectWise and COMPASS are setup to automatically create a project container for any project 
that is added to the Obligation Plan.  This automatic process runs on a nightly basis.  CTDOT 
employees will have access to all projects, but access for consultants, municipalities or other 
agencies must be requested by the Consultant Liaison Engineer.  For ProjectWise the Consultant 
Liaison Engineer can request access for these groups by emailing: Julie.Annino@ct.gov.  Project 
Managers have rights to add any necessary users to the project site.  See COMPASS Project Site 
Permissions for details on COMPASS project site access. 

 Project Folder Structure and Required 

Documents for Capital Projects 
This section details the project folder structure and the required project documents that must 
be submitted for each project.  The figure below illustrates a CTDOT project folder structure for 
a Capital Project. The folder structure is identical for both the ProjectWise and COMPASS 
solutions.  The Department is currently transitioning from ProjectWise to COMPASS; see  
Document Management Systems for details on what system shall be used during project 
delivery.  If the project container in ProjectWise or COMPASS does not look like the following, 
please report to DOT.AECapplications@ct.gov. 
 

mailto:Julie.Annino@ct.gov
mailto:DOT.AECapplications@ct.gov


 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 19 Version 5.01 
     

Section 3 of this manual details the processes for each contract document.  
 

 

Figure 12 - Capital Project Folder Structure 

Note:  In the case where two or more projects are combined or advertised as (1) project, all 
contract documents for these projects will be submitted into the lowest numbered project in  
ProjectWise or COMPASS. 
   

Project Folder Structure and List of Project Documentation 

100_Contract Plans (PDF) – This folder contains only final Contract Plans, which includes the following:  
There shall not be any working documents uploaded into this folder. 

• Final plans 

• Addendum plans  

• Design Initiated Change Order plans 

• As-Built plans 

• Electronic Engineering Data (EED) – Final Prepared by AEC Applications 

110_Contract Documents (PDF) – This folder shall only contain the following final documents.  There 
shall not be any working documents uploaded into this folder. 

• Signed Contract 

• Environmental Permit Applications/Approvals 

• Pre-Bid Questions and Answers 

• Contract Special Provisions – Final, Addendum, and Change Order special provisions   

• State and Federal Minimum Wage Rates and Classifications. 
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Project Folder Structure and List of Project Documentation 

• SOM (Source of Materials) 

• Insurance documents 

• Pre-Award DBE Review – Specific Contractor 

• Bonds  

120_Contractor Submittals (PDF) – This folder contains the following: 

• Working drawings 

• Shop drawings 

• Product data submittals 

• RFCs 

121_Contractor RFIs– This folder contains the following: 

• RFIs 

122 Contractor Closeout Documents – This folder contains contractor closeout documents.  

• Operation and Maintenance Manuals 

• Warranties 

130_Engineering Reports – This folder contains all the final engineering reports.  There shall not be any 
working documents uploaded into these folders.   

• Hydraulic  
o Hydraulic Report and Hydraulic Report Data 
o Scour Report and Scour Report Data 
o Floodway Report and Floodway Report Data 
o Final Drainage Reports and Final Drainage Report Data 
o USGS Bridge and Channel Assessment Reports 
o Miscellaneous Technical Data, Studies, Investigations or Reports 

• Environmental Compliance  
o Task 110 
o Task 210 
o Task 310 
o Underground Storage Tank System Closure Reports 

• Bridge 
o Load Rating 

• Geotechnical 
o Geotechnical Report Project files - including test boring, laboratory testing data file, and 

computations 
131_Engineering Reports Confidential –This folder is only seen by a select number of people.  

• Bid Analysis 

140_Project_Administration_Documents– This folder is for final permanent milestone project 
administration documents.  These project administration documents can be defined as, but not limited 
to, deliverables such as agreements, project approvals, project scope, regulatory documents, design 
phase schedules, etc.  There shall not be any draft documents uploaded into this folder.    

• Agreements – Utility, Railroad, Municipal, etc.  

• Categorical Exclusion 

• Certification Acceptance Checklist 

• Commitment list 

• Consultant Selection Documents – Scope of Services, Notice to Proceed, etc. 
• Construction Incidental Cost Establishment Report 

• DBE/SBE Approval with percentage, participation level 

• Design Approval 

• Design Exceptions 

• Design Phase Microsoft Project Schedule - COMPASS 

• Environmental Impact Study – EIS 
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Project Folder Structure and List of Project Documentation 

• Final Design Report 

• Finding of No Significant Impact - FONSI 

• Lighting Agreement 

• Record of Decision – ROD 

• Rehabilitation Study Report 
• Risk Management Documents 
• RPM – Request for Project Memorandum  

• Sidewalk Maintenance Agreement 

• Standalone Transportation Management Plan Document, taken from the final design report 
• Stewardship Agreement 

• Structure Type Study 
• Waiver to Obligate Funds 

• White Papers 

141_Project Administration Confidential – This folder shall be used for documents that only CTDOT 
should have access to.   

• Consultant Payroll information 

142_Project Administration Correspondence – This folder is for all final project correspondence 
documents.  This is defined as any request memos, response memos, letters, etc., and does not include 
any documents that are defined in the 140_Project Administration folder.  This folder shall not include 
any working/draft documents.   

• Meeting Minutes 

• Request Memos – Survey Request, Design Reviews, Support unit design.    

• Response Memos – Response to the Request Memos 

150_Quantity Calculations – This folder is where all the final quantity calculations for contract items 
shall be stored. 

151_Final Design Calculations – This folder is where all the final design calculations shall be stored. 

160_Project Photos – This folder is where all project photos shall be stored.  Both engineering and 
construction photos shall be stored in this folder.    

170_ROW and GIS Files - This folder is where the final property maps shall be stored until they are 
uploaded into the IRMS.   Also the project polygons and parcel polygons file shall be stored here. 

210_Construction Folders – See Construction Documentation for more information 

• 01 – Project Documents 
o Semi and Monthly Payment Estimates 
o Construction Orders with Backup 
o Copies of Cost-Plus Sheets with backup 
o All Delivery Tickets, Bituminous Concrete, Processed Aggregate Base, Concrete, etc. 
o Material Certifications, etc. (All Laboratory Reports) 
o Nuclear Density Test and Data Sheets (CON-125, 133) 
o Pile Driving Logs (CON-87) 
o Environmental Correspondence, Logs, etc. 
o Utility Forms (CON-40 and 41) 
o Contractor Payrolls 
o EEO/AA Reports (30-60-90s) 
o Labor Wage Checks (CON-131) 
o Hazardous Waste Manifests 
o Stores Requisitions and Transfer Vouchers 
o Purchase Orders and Requisitions 
o Correspondence 
o Consultants Billings with Backup 
o Computer Disks - properly labeled 
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Project Folder Structure and List of Project Documentation 

o Any Other Related Records 
o Town Correspondence File - Includes: 
o General Material 
o Request for and response to matters concerning highway, bridge, signing, lighting, etc. 

by town officials 
o Written commitments to first officials and/or elected, appointed state, federal officials 
o Mapping Prepared by district or filed with district 

• 02 - Internal Documents 
o Consultant Ratings 
o Other Sensitive Documents 

• 03 – Measurements and Payments 
o Field Books (all) Volumes 1,2,3,& 4s 

220_FHWA – This folder is used by the FHWA for their purposes 
 

230_Contract Administration – This folder is used by the CTDOT Contracts unit. 
 

240_Contract Development – This folder contains the paper plan order form and the location where the 
Designer uploads the following supplemental contract documents: 

• All contract special provisions and Notice to Contractors (NTC), in word format, both final and 
addendum special provisions 

• Estimator Proposal Estimate  

• Calendar Day Estimate 

• Electronic Engineering Data Files uploaded by the Designer 

241_Contract Development Confidential – This folder contains the final engineers estimate and 
calendar day estimate developed by the cost estimating unit. 

• Final Engineers Estimate 

• Final Calendar Day Estimate 

310_Milestone_Submissions – The designer shall submit all milestone submission documents into this 
folder.  This includes plans, special provisions, reports, estimates, etc. This folder has sub-folders for 
30%, 60%, 90%, and 100% submissions 

320_Permit_Development – This folder can be used to store documents for the development of 
permits.  Note: At FDP, the permit applications and approvals must be uploaded into the 240 Contract 
Documents folder.   The processing unit then adds the permits and applications to the contract and 
uploads the contract into the 110 Contract Documents folder.  

• Permits Needs Determination Form (PNDF) 

• Wetland Flagging Coordination  

• Natural Diversity Database (NDDB) Coordination  

• CTDEEP Fisheries Correspondence   

• LEAN Meeting Minutes 

• Project Manager Meeting (PMM) Minutes  

• Permit Review Comments 

• Responses to Permit Review Comments 

330_Design_Data – This area is used for working on documents such as letters, memos, etc. and 
working on CAD files.  Under this folder there are discipline specific sub-folders that provide each 
discipline an area prepare their design documents.  The DOT Confidential subfolder shall be used to 
work on draft confidential documents.  

500_Survey 

• 01_Central_Surveys – This folder is where the approved survey files will be stored for use by 
design.   

• 02_District_Surveys – This folder is used by the district survey units.  The files stored in this 
folder are considered working files.     
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Project Folder Structure and List of Project Documentation 

• 03_Consultant_Survey – This folder is used to store consultant survey information.  

• 04_Survey Transfer – This folder is used by District Survey units to transfer their completed 
survey files to Central Surveys.  Central Surveys will review the files in this folder and then when 
they are found acceptable, the files will be transferred into the 01_Central Survey folder for use 
by design.  

600_Project Initiation Documents – This folder is where any project initiation documents can be stored.  
This would include any plans developed by the Project Concepts unit or any other documents created in 
the project concepts phase.   

 Asset Areas 
ProjectWise is also being used to store all asset related documentation and asset information.   
In the future these will be transferred over to O365.   The following details the assets and 
documents are being stored for that asset: 

• 02.0 – Assets – Bridges 
o Inspection Reports 
o Fracture Critical Reports 
o Maintenance Memos 
o Load Ratings not performed for a Capital Project 

• 02.1 – Assets – Bridges (under 20’ Town owned) 
o Inspection Reports 

• 02.2 – Assets – Signal Intersections 
o Signal Plans – Active and Legacy 

• 02.3 – Assets – Sign Structures 
o Inspection Reports 

• 02.4 – Assets – Towns 
o Office State Traffic Administration (OSTA) documents 
o Bridge Safety Town Letters 

• 02.5 – Assets – Buildings 
o Building Inspection Reports 

• 02.6 – Assets Radio Towers 
o Inspection Reports 

• 02.7 – Asset – Railroad Crossing Signals 
o Inventory document that provides detail for the crossing. 
o Photos 

 COMPASS Project Site Permissions 
Access to COMPASS project sites is provided using site permission groups.  Each permission 
group has a unique set of rights and restrictions. 
 
AEC Applications will provide each Project Manager with administrative rights to their projects. 
This is accomplished by adding the PM to the Owners site permission group in a COMPASS 
project. The PM will then be responsible for granting and maintaining access to all team 
members, including CTDOT staff, Consultants and Contractors. Once the PM has administrative 
rights they may grant the same authority to any team member(s) by adding that team member 
to the site Owners permission granted group.  It is recommended to limit the number of staff in 
the site Owners group. The majority of participants should be granted access through the 
Members site permission group.    
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There are four permissions group per project:  Site Owners, Site Members, Site Contractors and 
Site Visitors. 

Site Owners Group 
Staff added to this group will obtain full control of the site, including the ability to add, edit or 
delete documents.  Site Owners have the ability to grant access to the site to internal and 
external users and perform several other administrative functions.     

Site Members Group 
Site Member is the most common classification for individuals attached to a project.  Site 
Members may add items to project libraries and folders and edit information in the Contacts 
menu.  Individuals who need to review submittals and access document folders should be added 
to the Members group.  Construction Contractors should not be added to the Members group; 
they should be added to the Site Contractors Group.  External users included in the Members 
group do not have access to the Landing, Dashboard and Details pages; they are only able to 
access the Submittals / Transmittals (S&T) page and project folders.  External users invited to 
join a project Members group should follow instructions for Accepting an Invitation (External 
Users). 

Site Contractors Group 
Users in the Site Contractors permissions group have the ability to create new submittals in the 
COMPASS S&T application and respond to requests to revise and resubmit.  Contractors cannot 
access any of the project folders or the comment log.  Contractors are limited to viewing 
submittals in the Submittals / Transmittals table that a member of the Contractors group 
created.  If multiple members are included in this group, they will see each other’s submittals in 
the S&T table.  The project Contractor(s) should be added to this group.  The User Manual for 
Construction Contractors provides instructions to Contractors on how to accept invitations and 
use the COMPASS S&T application. 

Site Visitors Group 
Site Visitors are limited to read-only access.  Site Visitors can view project libraries, menu items 
and documents.  Site Visitors cannot add, edit or delete any information from the site.  By 
default, all CTDOT personnel who have a Department issued Office 365 license are members of 
the COMPASS Visitors group, which grants Visitor access to all projects in COMPASS (not 
including the Submittals/Transmittals Application). 

Site Permissions Summary Table 
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Add or remove users to site permissions groups X    

Delete a submittal X    

Start or edit a review cycle on behalf of another user X    

Start or finalize a Bluebeam Studio Session on behalf of another user X    

Mark workflow status as Revise and Resubmit on behalf of another user X    

Mark workflow status as Complete on behalf of another user X    

https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en
https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en
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Modify the Approval Matrix X    

Create a submittal X X X  

Replace a submittal in response to an R&R X X X  

Function as a submittal Owner as assigned in the S&T Approval Matrix X X   

Review a submittal X X   

Access Internal Documents folder X X   

View submittal documents X X X X 

The site permissions should be assigned when a COMPASS project is first created.  Thereafter, 
the PMs or delegated staff member should maintain access privileges as needed.  The PMs are 
responsible for adding and removing members of the COMPASS site permissions group 
throughout the duration of the project. 

Site Settings Gear 
To access the Site Settings menu via the gear: 

1. Navigate to the Project Details page of the chosen project. 

 

Figure 13 - Site Settings 

2. Navigate to the Submittals/Transmittals page. 

 

Figure 14 - Site Settings 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 26 Version 5.01 
     

3. Navigate to the Gear in the upper right hand corner of the Submittals/Transmittals page 

 

 

Figure 15 - Site Settings 

 
4. Select Site Settings 

 

Figure 16 - Site Settings 

5. Select Site Permissions 

 

Figure 17 - Site Settings 

 
6. Select the Members, Owners, Contractors or Visitors permissions group, as appropriate. 
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Figure 18 - Site Settings 

 
7. To add a new member to the group, press New → Add Users 

 

Figure 19 - Site Settings 

 
8. To add CTDOT personnel, type and select the correct name into the names / email 

addresses field.  Contact information is automatically sourced from AD Manager.  For 

external users, the email address needs to be inputted manually.  Multiple users can be 

added to a specific site group at one time.   

By default, an email invitation will be sent to new users that includes an optional 

personal message typed by the Owner.  To avoid sending an email notification to CTDOT 

personnel, click Show Options and uncheck the box “Send an email invitation.”   Email 

invitations must be sent to external users.  Email invitations should not be forwarded 

between users; a separate invitation should be sent to each person who requires site 

access.   

Once the names, email addresses, optional personal message and optional email 

invitation selection are complete, press Share to add individuals to the selected Group.   

 

Figure 20 - Site Settings 
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Figure 21 - Site Settings  

 

 

Figure 22 - Site Settings 

Site Settings URL 
To access the Site Settings menu for any COMPASS project: 

1. After logging into COMPASS, a URL address can be used to assign permissions to any 

project.  Only COMPASS Owners and Owners of the specific project may modify the 

project-specific permission groups.  Below is an example of how to enter the URL for 

Project No. 0134-0148.  Replace the project number in the example (shown in red font) 

with the project number in question.  All eight digits and the hyphen must be included: 

https://ctgovdot.sharepoint.com/projects/0134-0148/_layouts/15/user.aspx 
 

2. Follow steps 6-8 as described in the Site Settings Gear section to add users to the 

appropriate permissions groups. 

Restricted Elements 
Please do not use any of the functionality under the Settings menu. 

 

Figure 23 - Restricted Elements 

 

https://ctgovdot.sharepoint.com/projects/0134-0148/_layouts/15/user.aspx
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Please do not use the menu items in the ribbon. 

 

Figure 24 - Restricted Elements 

External users (e.g., Contractors, Consultants, Stakeholders, etc.) invited to join a COMPASS 
project site will need to take the following steps to accept a COMPASS invitation.  External users 
should never forward their invitations to other users.   
 
If other individuals need access to a COMPASS project site, a request should be sent to the PM.   
 
Note:  Depending on the user’s email settings, the email notification may route to the SPAM or 
Junk folder. 
 

1. The external user will receive an email invitation with a direct link to the project page. 

 

Figure 25 - Accepting an Invitation 

2. On the SharePoint Online invitation acceptance page,  

a. External users with an existing work / company Office 365 account should click 

Organizational Account and log-in using their company Office 365 user name 

and password. 

b. External users with an existing personal Microsoft account as described should 

select “Microsoft account” and sign-in.   

c. External users without an existing Microsoft account should select “Create a 

Microsoft account” and follow the steps to set-up a new, free account.  It is 

recommended that the user’s company email address be used to set-up this 

account. 
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Figure 26 - Accepting an Invitation 

**External users will sign in directly to their project sites and do not have access to the 
COMPASS Landing Page, Dashboard or Details page. 

 Navigating COMPASS 
For CTDOT users, follow the instructions provided in COMPASS Overview to log-in to Office 365 
and access COMPASS. 

Searching for Projects 
Once within the COMPASS site, search or filter by Project Number, Project Name, Project 
Manager or Schedule Phase.   

• When searching by Project Number, the hyphen and full eight-digit number should be 

used, including leading zeroes (####-####).   

• Multiple Project Managers and / or Schedule Phases can be selected at the same time.   

• Click Reset Filters to clear all filters and begin a new search. 

 

Figure 27 - Searching for Projects 
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• Click the Filter / Search Projects arrow to collapse or expand the filtering section. 

 

Figure 28 - Searching for Projects 

 

• If a search produces multiple results, scroll between the Project Landing Pages by using 

the up and down arrows located on the upper-right hand side of the page. 

 

 

Figure 29 - Searching Projects 

The following resources can be accessed from each Project Landing page: 
1. Project Dashboard 

2. Project Details   

3. Copy Project URL – Copies the project site URL to the clipboard. 

4. MS Project Schedule   – The MS Project schedule button will only be active if there is an 

associated schedule and if the user has an MS Project Online license.  See COMPASS 

Software License Requirements for details.   

 

Figure 30 - COMPASS Pages 

The following information resides on each Project Landing page: 

• Project Description 

• Schedule details including number of tasks remaining, overall schedule health and 

current Schedule Phase   
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• Permit and ROW status 

• Location map showing the project polygon – Refresh the page to reset the map to its 

original position. 

• Key dates for the project – Open in CORE and FDP 

• Staff assigned to the project with their contact details 

• Budget donut graphs – Roll over the graph sections to view monetary details 

• Funding data 

Accessing the Project Dashboard 
The Project Dashboard can be reached from the Project Landing page, Project Details page, or 
Submittals / Transmittals page by clicking the Project Dashboard button. 

 

Figure 31 - Project Dashboard 

Project Dashboard Contents 
The following resources can be accessed from the Project Dashboard: 

1. Project Menu 

2. Project Details 

3. Submittals/Transmittals 

4. Back to Project List button 

 

Figure 32 - Project Dashboard 
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The following information resides on each Project Dashboard: 

• Project Description 

• Project Value – roll over graph sections to view monetary details 

• Project Schedule FDP dates – obligation date, MS Project Schedule date and the 

associated delta 

• Project Expenditures Graph (PEG) (under construction) 

• Permitting status 

• Rights of Way status 

Location map showing the project polygon – Refresh the page to reset the map to its original 
position. 

Accessing the Project Details Page 
The Project Details page can be reached from the Project Dashboard, Project Landing page or 
Submittals / Transmittals page by clicking the Project Details button. 

 

Figure 33 - Project Details 

Project Details Contents 
The following resources can be accessed from the Project Details page: 

1. Project Menu 

2. MS Project Schedule   – The MS Project schedule button will only be active if there is an 

associated schedule and if the user has an MS Project Online license.  See COMPASS 

Software License Requirements for details.   

3. Back to Project List button 

4. Staff assigned to the project with their contact details, including the ability to edit. 
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Figure 34 - Project Details 

The following information resides on each Project Details page: 

• Town(s) 

• Project Description 

• Schedule details including number of tasks remaining, overall schedule health and 

current Schedule Phase   

• MS Project schedule milestone details 

• Permitting and ROW details 

• Budget donut graphs – Roll over the graph sections to view monetary details 

• Funding data 

The Engineering Lead Unit, Engineering Support Units and Construction Districts are responsible 
for entering and maintaining project staff information in COMPASS.  Each Unit and District is to 
decide which employee(s) are responsible for entering and maintaining the project staff; all 
CTDOT COMPASS users have the ability to perform this function.  Staff information is found on 
the right-hand side of the Project Landing and Details pages.  When this page is correctly 
populated and maintained, it will provide an authoritative resource of all project staff including 
Engineering Lead Unit, Engineering Support Units, Consultant staff, Construction staff, 
Construction Consultants and Contractors.  Titles, units / companies, email addresses and phone 
numbers will be readily available to all who have access to the page.   

Editing Project Staff 
To edit the project staff: 

1. Click the Project Details button to navigate to the Project Details page.  The Details 

button can be accessed from the Landing page, Dashboard or Submittals/Transmittals 

page. 
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Figure 35 - Project Details 

 

 

Figure 36 - Project Details 

 
2. Click Edit in the Staff section of the Details page.   

 

Figure 37 - Project Details 

 
3. Add all project staff to the page.  Press Show and Hide to expand or conceal the 

different staff categories.   

a. Engineering Lead Unit Staff:  Only one CTDOT unit is to be added to this section.  

The Transportation Supervising Engineer (TSE) should be the highest level 

employee added to this section.  Unit, title and contact information will 

automatically populate once a name is added. 

b. Engineering Support Unit Staff:  All CTDOT engineering support staff are to be 

added to this section by their respective units.  Unit, title and contact 

information will automatically populate once a name is added. 

c. Consultant Staff:  All design consultant staff are to be added to this section by 

the Engineering Lead Unit.  Since this section is comprised of external users, all 

information needs to be manually entered. 

d. Construction Staff:  All CTDOT construction staff are to be added to this section 

by the Construction District.  Unit, title and contact information will 

automatically populate once a name is added. 

e. Construction Consultant Staff:  All construction consultant staff, such as CE&I, 

are to be added to this section by the Construction District.  Since this section is 

comprised of external users, all information needs to be manually entered. 

f. Contractor Staff:  All project contractors are to be added to this section by the 

Construction District.  Since this section is comprised of external users, all 

information needs to be manually entered. 
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Figure 38 - Edit Staff 

Project Staff Features 
The Staff page has several built-in, automated features, including:   

• Engineering Lead Unit Staff:  The Engineering Lead Unit Staff section will populate the 

lead unit header based on the personnel inputted in this section.  Only CTDOT personnel 

from one unit should be included in this section.   

• Auto-sort by sub-section:  Users are to add personnel into the appropriate category on 

the Edit Project Staff page.  When the changes are saved, COMPASS will automatically 

sort personnel by sub-section in all categories except Engineering Lead Unit Staff.  For 

Engineering Support Unit Staff, sub-groups such as Bridge State Design and Highway 

Consultant Design will be created.  For Construction Staff, sub-groups will be created 

based on Construction District.  For the three sections containing non-DOT users, 

COMPASS will sort individuals by company name. 
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• Auto-sort hierarchy:  For the three categories containing CTDOT personnel, COMPASS 

will automatically sort individuals by rank.  This is not a direct chain of command listing; 

rather, COMPASS will sort staff by title within each sub-section.   

Contacting a Member of the Project Staff 
To contact a member of the project staff, either click on the email address listed to open a new 
email window or utilize the phone number provided.  

The Project Communication window operates as a message board.  It is a location where 
members of the project team can post messages, updates or other communications to the rest 
of the team. 
 
To create a new message, type in the New Communication box and click post. 
 

 

Figure 39 - Project Communications 

 
To respond to a Communication thread, click the Reply button associated with the relevant 
communication and insert text.  
 

 

Figure 40 - Project Communications 

 
Project Communication messages can be searched by typing a keyword or phrase in the Search 
bar.  

 

Figure 41 - Project Communications 
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The Project Menu – located on the left side of Dashboard and Details pages – is comprised of 
the following sections: 

• Contacts:  The Contacts folder can be used to add contact information for project staff, 

stakeholders, agencies or other relevant users. 

• Internal Documents:  The Internal Documents folder is structured to mirror ProjectWise.  

Documents routed through the Submittal / Transmittal tool automatically save to pre-

allocated Internal Documents subfolders.  Users with access can also save and share 

documents directly through the Internal Documents folder. 

• Documents:  Under Construction.  Do not use this folder at this time. 

• Project Emails:  Project-related emails that need to be memorialized can be saved to the 

Project Emails folder.  The contents of this folder are viewable to those with project site 

access.  Highly confidential project emails that require more restricted access should not 

be stored in this location. 

• Report of Meetings:  The Report of Meetings tab provides a project-specific OneNote 

notebook.  Project staff can use this OneNote to document meeting minutes, or expand 

its use to record other notes. 

When a selection is made from the Project Menu, a new window will automatically open to 
provide the information.  For example, if the Internal Documents item is selected, a new 
browser window will be created. 

 

Figure 42 - Project Menu 

The Executive Dashboard provides an overall summary of all active projects.  The Executive 
Dashboard is accessed from the COMPASS Landing Page and any Project Landing page.  Select 
the blue button to view data. 

 

Figure 43 - Executive Dashboard 
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Figure 44 - Executive Dashboard 

Click on the question mark (?) option in the upper-right hand corner of each section of the 
Executive Dashboard to determine how each assessment is calculated.  For details, see 
COMPASS Data Sources and Computations table. 
 

 

Figure 45 - Executive Dashboard 

 Digital Project Processes  

 Processes by Project Phase 
The following shows the processes included in this manual separated by project phase.  Also 
included in this table is a link to the process map that corresponds to each document/process:    

Project Initiation Phase 
Document/Process Requirements 

PPI Process • See Section 14 of this manual.      

Project Schedule • Project Schedule should be set up in accordance with Section 11 

Preliminary Design Phase 

Preliminary 
Contract Plans 

• Plans shall be grouped in accordance with Section 4.1 

• Plans shall be formatted in accordance with Section 4.2 
 

Preliminary • Contract Special Provisions shall be prepared in accordance with Section 4.5 
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Contract Special 
Provisions 

Cost Estimate • Cost Estimates shall be prepared in accordance with Section 4.6 

Preliminary Design 
(30%) Review 

• Design Reviews shall be accomplished in accordance with Section 10 

Project Schedule • Project Schedule should be set up in accordance with Section 11 

Permit 
Applications/ 
Documents 

• Shall be uploaded and formatted in accordance with Section 4.7 

Rehabilitation 
Study Reports 

• Shall be uploaded and formatted in accordance with Section 4.9 

Structure Type 
Studies 

• Shall be uploaded and formatted in accordance with Section 4.9 

Categorical 
Exclusion 

• Shall be uploaded and formatted in accordance with Section 4.10 

Design Exception • Shall be uploaded and formatted in accordance with Section 4.10 

Design Approval 
Letter 

• Shall be uploaded and formatted in accordance with Section 4.10 

Project 
Correspondence 

• Shall be uploaded and formatted in accordance with Section 4.10 

Project Polygon • Shall be prepared and uploaded in accordance with section 4.11 

Final Design Phase 
Document/Process Requirements 

Contract Plans • Plans shall be grouped in accordance with Section 4.1 

• Plans shall be formatted in accordance with Section 4.2 

Contract Special 
Provisions 

• Special Provisions shall be prepared in accordance with Section 4.5 

Engineering 
Reports 

• Engineering Reports shall be prepared in accordance with Section 4.9 

Project Schedule • Project Schedule should be set up in accordance with Section 11 

Cost Estimate • Preliminary Cost Estimates shall be prepared in accordance with Section 4.6 

Permit 
Applications/ 

Approvals 

• Shall be uploaded and formatted in accordance with Section 4.7 

Design Calculations • Design Calculations shall be submitted in accordance with Section 4.13 

Semi Final (60%) 
and Final Design 
(90%) Reviews 

• Design Reviews shall be accomplished in accordance with Section 10 

Quantity 
Calculations 

• Quantity Calculations shall be submitted in accordance with Section 4.6 

Final Design Report • Shall be uploaded and formatted in accordance with Section 4.10 

Final Design 
Statement 

• Shall be uploaded and formatted in accordance with Section 4.10 

Sidewalk 
Maintenance 
Agreement 

• Shall be uploaded and formatted in accordance with Section 4.10 

Lighting Agreement • Shall be uploaded and formatted in accordance with Section 4.10 

DBE/SBE Goals • Shall be uploaded and formatted in accordance with Section 4.10 

Commitment List • Shall be uploaded and formatted in accordance with Section 4.10 

Waivers • Shall be uploaded and formatted in accordance with Section 4.10 

Standalone • Shall be uploaded and formatted in accordance with Section 4.10 
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Transportation 
Management Plan 

Project 
Correspondence 

• Shall be uploaded and formatted in accordance with Section 4.10 

Contract Processing Phase 
Document/Process Requirements 

FDP 

Contract Plans • Plans shall be grouped in accordance with Section 4.1 

• Plans shall be formatted in accordance with Section 4.2 

• Plans shall be checked by the PDF checker in accordance with Section 6.2 

Contract Special Provisions • Special Provisions shall be prepared in accordance with Section 4.5 

Proposal Estimate • Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Federal Estimate • Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Calendar Day Estimate • Calendar Day Estimate shall be prepared in accordance with Section 4.6 

Permit Applications/ 
Approvals 

• Shall be uploaded and formatted in accordance with Section 4.7 

Ordering Paper Copies of 
Contract Documents 

• Paper copies of contract documents can be ordered in accordance with 
Section 3.2.11 

EED • Shall be prepared and uploaded in accordance with Section 4.14. 

Project Polygon • Shall be prepared and uploaded in accordance with section 4.11 

DCD 

Contract Plans • Plans shall be grouped in accordance with Section 4.1 

• Plans shall be formatted in accordance with Section 4.2 

• Plans shall be checked by the PDF checker in accordance with Section 6.2 

Contract Special Provisions • Special Provisions shall be prepared in accordance with Section 4.5 

Proposal Estimate • Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Federal Estimate • Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Calendar Day Estimate • Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Permit Applications/ 
Approvals 

• Shall be uploaded and formatted in accordance with Section 4.7 

Addendum 

Contract Plans • Plans shall be prepared in accordance with Section 7.1  

Contract Special Provisions • Special Provisions shall be prepared in accordance with Section 7.1.5 

EED • Shall be prepared and uploaded in accordance with Section 4.13. 

Award Phase 
Signed Contract • Signed Contract will be uploaded into ProjectWise in accordance with 

section xx. 

Construction Phase 
Document/Process Requirements 

Contractor 
Submittals 

• Contractor submittals shall be uploaded in accordance with Section 9 

Contract Plans • Plans shall be prepared in accordance with Section 7.2  

Contract Special 
Provisions 

• Special Provisions shall be prepared in accordance with Section 7.2.5 

DCO Memo • DCO memo shall be prepared in accordance with Section 7.2.6  
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Plan As-Builts • Plan As-Builts shall be accomplished in accordance with Section 8 

Project 
Correspondence 

• Shall be uploaded and formatted in accordance with Section 4.10 

EED • Shall be prepared and uploaded in accordance with Section 4.13. 

Project Polygon • Shall be prepared and uploaded in accordance with section 4.11 

 

 Digital Project Process Maps 
This section provides high level process maps for the procedures detailed in this manual. 

Click Here for Formatting and Submittal Requirements 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 43 Version 5.01 
     

Click here to go to the Digital Review Section 
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Click Here for Formatting and Submittal Requirements 
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Click Here for Formatting and Submittal Requirements 

 
X  
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Click Here for Formatting and Submittal Requirements 
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See Section 9 for detailed instructions.  Process maps for Shop Drawings, Working Drawings, 
Product Data Sheets, and RFIs are in development.  

The Paper Plan Order Form was created to allow each unit in the Department to order contract 
plans and special provisions for DOT Projects.  This form is located in each project in ProjectWise 
and each unit in the Department that needs paper copies of contract plans and special 
provisions is required to update this form for their paper needs.  This form is then used by the 
Department’s Engineering Records unit to make the prints and send them out.  
  
Any Addendum or Change Order that is submitted for a project will be printed and sent out 
using the information indicated on the form.  Addendums will be printed and sent out 
automatically.  When a Change Order is submitted, the designer must notify Engineering records 
that a Change Order has been submitted and that paper copies of the Change Order need to 
printed and sent to the applicable units indicated on the Paper Plan Order Form.   
 
This following shows the procedure for how the Paper Plan Order Form is filled out and the 
prints are made.  Contact Information for Engineering Records: Print Shop: 860-594-3086 Plan 
and Specification Printing 

Step Project Stage Group Action 
1 FDP Processing After the contract plans and special provisions have been 

submitted for FDP an email is sent to each unit in the 
Department that requires paper copies of contract plans and 
special provisions.   

2 FDP Units Open the Paper Plan Order Form from ProjectWise and fill out 
the form for their unit’s needs.  Save the form and check the 
form back into ProjectWise. 

3 DCD Processing At DCD, lock the form by placing it in the Processing state. 

4 Advertise Contracts Notify Engineering Records that the project is going to be 
advertised and they can print the required paper copies 
indicated on the Paper Plan Order Form. 

5 Advertise Engineering 
Records 

Print the required paper copies indicated on the Paper Plan 
Order Form. 

6 All 
Addendums 

Contracts Notify Engineering Records that an Addendum is going to be 
advertised and they can print the required paper copies 
indicated on the Paper Plan Order Form for this Addendum.  
Make sure to tell Engineering Records which subsets are 
included in the Addendum. 

7 All 
Addendums  

Engineering 
Records 

Print the required paper copies indicated on the Paper Plan 
Order Form for the Addendum.  Make sure to print all the 
subset that were affected by the Addendum including the 02-
Revisions subset. 

8 All Change 
Orders 

Lead Designer Notify Engineering Records that a Change Order has been 
submitted and they can print the required paper copies 
indicated on the Paper Plan Order Form.  Make sure to tell 
Engineering Records which subsets are included in the Change 
Order.  If a unit is not listed on the Paper Plan Order Form, 
give Engineer Records those units’ contact information so 
those units’ can receive a copy of the Change Order.  

9 All Change 
Orders 

Engineering 
Records 

Print the required paper copies indicated on the Paper Plan 
Order Form for the Change Order and for any other units’ 
requested by the Lead Designer. Make sure to print all the 
subsets that were affected by the Change Order including the 
02-Revisions subset.   
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 Document Preparation and 

Format 

 Contract Plan Grouping 
Contract plans shall be grouped, by discipline into individual multiple page PDF files called 
discipline subsets.  The project manager is tasked with determining the discipline subset 
numbering and grouping and whether to use a single volume or multiple volumes for the 
project.   The number of sheets in a discipline subset shall contain a maximum of 150 sheets.  
The following details each of these options: 
 
Single volume digital contracts are used when each discipline or consulting firm designing the 
project is responsible for 3 subsets or less.  The following is an example of a single volume 
project.   

Note:  The first and second subsets shall always be 01-General and 02-Revisions.  The 03 
subset does not always need to be 03-Highways, the 04 does not always need to be 04-
Structure, etc.  FIO subsets shall be numbered at the end of the project before the 
standard subsets.   The Standards subsets shall not be numbered.   

 
Multiple volumes are used if the project has 1 or more of the following characteristics: 

a. The majority of the discipline/firm designers are responsible for more than 3 
subsets each.  This allows the individual designers to number their subsets 
independently of the other disciplines. 

b. There are multiple sites on the project.  Splitting these sites up into volumes will 
provide better organization of the project.   

c. Combining multiple projects into one project.  
The larger the project is, typically the more subsets will be required and their labels will be more 
specific.   The subsets shall be split up by volume and each volume shall be controlled by its 
assigned designer.   For example, all the subsets designed by the highway designer shall be in 
the same volume (02) and each subset shall have a unique subset number. 

Note:  The first and second subsets when using multiple volumes shall always be 01.01-
General and 01.02-Revisions.  The 01.03 subset does not always need to be 01.03-
Highways, the 01.04 does not always need to be 01.04-Structure, etc.  FIO subsets shall 
be numbered at the end of the project before the standard subsets.   The Standards 
subsets shall not be numbered.   

Combining Projects 
In the event 2 or more projects are combined into one project, the following shall be done: 

• Each project shall be given its own volume. 

• The lowest project shall always be volume 1.   

• Each project shall have its own title sheet, which reference each other with a note.   

• There shall only be (1) Revisions subset.  This subset shall be in volume 1 and named 
01.02 – Revisions. 

• The Revisions subset shall be the responsibility of the project manager on the projects.   

• Each project shall have its own detailed estimate sheets.   

• There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when 
the projects are combined.   

• There shall not be any duplicate special provisions after the projects are combined.  

• There shall only be (1) calendar day chart. 
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The next two figures show examples of the single volume and multiple volume options.   

Single Volume Option 
 

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

01-General 
Title Sheet 

Detail Estimate Sheet 
 

02-Revisions 

Index of Revisions Sheets  

03-Highways 

Index of Plans 

Survey Data 

Alignments 

ROW 

Typ Sections 

Misc Details 

Intersect Grading 

Boring Logs 

Highway Plans 

Breakout Drainage 

Highway Profile 

Highway X-

Sections 

Landscape Plan 

Wetland Mitigation 

04-Structure 

Index of Drawings 

All Structure Sheets  

Note: Multiple subsets may be required for 

multiple Sites 

Ex: 04_Structure_Br.No.1266 

05-Traffic 

Index of Drawings 

Signing 

Pavement Markings 

MPT 

Traffic Signal Plans 

Etc. 

06-Environmental 
Index of Drawings 

All Environmental Compliance Sheets required 

07-Utiltiy Utility Design plans.  For example 07_AT & T, 
07_CL & P, 07_MDC, etc.   

08-CL&P FIO** CL & P For Information Only plans 

09-AT&T FIO** AT & T For Information Only plans 

 CTDOT Highway STD CTDOT Highway Design Standard Index and 
Sheets required 

CTDOT Traffic STD CTDOT Traffic Engineering Standard Index and 
Sheets required 

Figure 46 Typical Highway Project Discipline Subset Contents 

* If a discipline has to be broken up into more than one subset, keep the label the same with the 
addition of “1” at the end of the first subset, “2” at the end of the second subset, etc.  
** For Information only discipline subset shall be submitted as individual pdf files based on the 
entity providing the information only.   
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Multiple Volume Option 
  

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

Designer/ 

Firm 

01.01-General Title Sheet, Detail Estimate Sheet Lead 

01.02-Revisions Index of Revision Sheets Lead 

01.03-Wtlnd Re-establish Wetland Reestablishment plans Designer 1 

01.04-Stg Acc. Staging and Access Plans Designer 1 

02.01-Typ Sections Typical Sections Designer 2 

02.02-Alignments Alignment Geometry Designer 2 

02.03-Plan Plans Designer 2 

02.04-Profiles Profiles Designer 2 

02.05-ROW Brk Right of Way Breakout Designer 2 

02.06-Drain Drainage Plans Designer 2 

03.01-Retaining  Wall 1 Retaining wall details Designer 3 

03.02-Retaining Wall 2 Retaining wall details Designer 3 

03.03-Bridge 00456 Bridge_456 Designer 3 

03.04-Bridge 01983 Bridge_1983 Designer 3 

03.05-Bridge 01984 Bridge_1984 Designer 3 

04.01-Stage 1 Stage Construction Details 1 Designer 4 

04.02-Stage 2 Stage Construction Details 2 Designer 4 

04.03-Stage 3 Stage Construction Details 3 Designer 4 

05.01-SPM Signing and Pavement Marking Site 1 Designer 5 

05.02-SPM Signing and Pavement Marking Site 2 Designer 5 

05.03-SPM Signing and Pavement Marking Site 3 Designer 5 

06.01-IMS IMS Plans and Details Site1,2,3 Designer 6 

07.01-Env 1 Environmental Details Site 1 Designer 7 

07.02-Env 2 Environmental Details Site 2 Designer 7 

07.03-Env 3 Environmental Details Site 3 Designer 7 

08.01-”Utiltiy Utility Design plans.  For example 07_AT & T, 07_CL 
& P, 07_MDC, etc.   

Designer 8 

09.01-CL&P FIO CL & P For Information Only plans Designer 8 

09.02-AT&T FIO AT & T For Information Only plans Designer 8 

CTDOT Highway STD *CTDOT Highway Design Standard Index and Sheets 
required 

Designer 1 

CTDOT Traffic STD  CTDOT Traffic Engineering Standard Index and 
Sheets required 

Designer 5 

Figure 47 – Multiple Design Firms CTDOT Project Subsets 
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 Contract Plan Format 
Digital contract plans (preliminary, semi-final, FDP, ADP, DCO, etc.) shall be formatted in 
accordance with the following: 

1. Contract Plans shall be in submitted to CTDOT in PDF format 
2.  PDF Plans must be sized either 36” x 24” for projects created before June 2007 or sized 

34” x 22” for projects created after June 2007 
3. PDF plans shall be measurable to scale in the PDF 
4. PDF plans shall be able to be printed to paper and scaled appropriately 
5. Text must be searchable 
6. All levels must have the ability to be displayed on or off, unless approved otherwise.   
7. All information on the digital contract PDF plans shall have been created from Bentley 

Software or an approved alternate.  The only information that shall be added to the 
plans using a PDF editing software are as follows: 

• Page labels (see Section 4.14.2) 

• Sheet numbers (see Section 4.14.2) 

• Watermarks and flatten comments(see Section 5.4)  

• Any digital signature fields (see Section 5.5) 

• Digital Signature (see Section 5.6)       
8. Discipline subsets shall be published directly from a CAD application. Scanned images or 

raster image formats will not be accepted with the exception of For Information Only 
sheets, these can be scanned.    See Publishing CAD Files  for more instructions on how 
to publish from Bentley Software.    

9. Each discipline subset shall contain bookmarks; one for each page. 
10. The first page of each subset shall be a subset cover sheet, this includes FIO subsets.  

This cover sheet shall contain both; an index of drawings contained within the subset 
that includes both drawing numbers and drawing titles and the form field place 
holder(s) which receives the digital signatures.  This table must include the subset name 
and number displayed as a heading in the table as shown in the figure below.   

 

Figure 48 Discipline Subset Bookmarks, Index of Drawings, and Signature fields 

 
 
 
 
 

https://portal.ct.gov/-/media/DOT/documents/AEC/CAD_SelectSERIES/publishingmicrostationpdf.pdf
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11. The first page of the subset 01_General shall be the CTDOT digital project title sheet 
which includes an index of the subsets contained within the project, sheet count totals 
for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for 
applying the digital signature(s) (see Section 5.5).   
Consultants will need to delete the CTDOT signature blocks on the title sheet and place 
a digital signature placeholder as detailed in Section 5.5 CTDOT engineers can find the 
digital title sheet in the seed files on our W: drive.   

12. The 01-General subset shall include all detailed estimate sheets.   
13. The 02_Revisions subset must be included in each digital project and there shall only be 

(1) revisions subset.    
14. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See 

Section 7.3. These revision sheets are used for tracking all sheet changes due to 
addenda and design initiated change order (DCO) with respect to the entire project. 
These sheets are originally blank and unsigned, and shall be managed and updated as 
needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained 
here: 

  CTDOT Designed Projects - 02-Revisions Subset 
  Consultant Designed Projects - 02-Revisions_CE_Subset  

15. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based 
on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc.  These 
subsets do not require a digital signature, but each sheet in the subset shall be labeled; 
“For Information Only”. The subset numbers shall be selected by the lead designer so 
that the FIO subsets are last.  Each sheet shall be numbered correctly, see Section 
4.14.2.    Upload and attribute in accordance with Section 6.1.  

16. Utility drawings shall be submitted in accordance with the following:   

• Utility plans For Information Only (FIO) shall be submitted in a utility subset 
based on the utility company, AT&T subset, CL&P subset, etc.  These subsets do 
not require a digital signature, but each sheet shall be labeled; “For Information 
Only”.  FIO utility subsets shall be numbered so that they are the last subsets. 
Example Labels; 10_CL&P_FIO, 11_AT&T_FIO.  These subsets must have page 
labels assigned,  see Section 4.14.2 

• Utility company designed plans that include work being done by the State’s 
Contractor shall be submitted in a utility subset based on the utility company, 
AT&T subset, CL&P subset, etc.  These subsets do not require a digital signature.  
Example Labels; 10_CL&P, 11_AT&T.  These subsets must have page labels 
assigned,  see Section 4.14.2 

• Utility plans that are designed by a Consultant firm that include work being 
done by the States Contractor shall be submitted in a utility subset based on the 
utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in 
accordance with this manual. Example Labels; 10_CL&P, 11_AT&T.  These 
subsets must have page labels assigned,  see Section 4.14.2 

17. CTDOT Standard sheets shall also be delivered digitally.  See Section 4.4 for how to 
prepare and submit CTDOT Standard Sheets.  

18. Footers, displaying the sheet number, shall be placed on each page of each PDF subset. 
See Section 4.14.2, “Sheet Numbering”  

19. As-built information shall be digitally applied to the contract subsets by District 
Personnel after the job is complete using Bluebeam.  See Section 8.   

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, 
but do not need to be digitally signed.  These review documents shall be uploaded into 
the 310_Milestone Submission folders in ProjectWise in accordance with Section 6.1. 

21. A Bluebeam set file shall be created at FDP and updated for any addendums or change 
orders in accordance with Section 4.15.2. 

https://portal.ct.gov/-/media/DOT/documents/AEC/02-revisions_ctdot.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/02-revisions_ce.pdf
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22. Contract Plan subsets, FDP, DCD, DCD2, ADP, and DCO, must be checked by the 
Discipline Subset PDF Checker in accordance with Section 6.2. 

   CTDOT For Information Only Sheets 
 
Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets 
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc.  These 
subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For 
Information Only”.  The first sheet of each FIO subset shall be a subset cover sheet.  These 
sheets shall be placed on a border and numbered in accordance with section 4.14.2.   
 
The subset numbers shall be selected by the Project Manager so that the FIO subsets are last.  
See Section 6.1 for uploading and attributing FIO Plans. Information only sheets may be 
scanned, but must conform to the following:  

• Minimum Size 22”x34” 

• Minimum dpi = 300.   
 
This link shows an optional procedure that can be used to create a For Information Only subset 
that uses Bluebeam:  Preparing a For Information Only Subset 

 CTDOT Standard Plan Sheets 
Standard sheets shall also be delivered digitally into ProjectWise. The following shows how to 
obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital 
project. 

1. Download the latest standards from the following link for the project:  CTDOT Standard 
Drawings Website 

2. Upload the standard subset into ProjectWise in accordance with Section 6.1.     
3. Next open up the standards from ProjectWise by double clicking on it.  Once it opens 

click on the index sheet. 

 

Figure 49 - Preparing the Standard Subsets 

 
 
 
 
 
 
 
 
 

https://portal.ct.gov/-/media/DOT/documents/AEC/preparing_fio_sheets.pdf
http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
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4. Then enter the project number and check the standards to be included in the project.   

 

Figure 50 - Enter Project Number and Check Boxes 

5. Delete the standards that are not included in the project as shown below: 

 

Figure 51 - Deleting Drawings from Standard Set 

6. Next digitally sign all index sheets in accordance with Section 5.6.4. 
7. Then upload the standards into the 100_Contract Plans folder in ProjectWise in 

accordance with Section 6.1 of this manual.  
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 Contract Special provisions 
1. Digital Contract Special provisions shall be submitted in MS Word format and in 

accordance with the Departments policies and procedures for Contract Development.   
CSI special provisions shall be submitted in pdf format.  

2. Preliminary special provisions and CSI special provisions shall be combined into (1) pdf 
document and then uploaded to the applicable folder under the 310_Review 
Documents folder under the project in ProjectWise.  

3. FDP and Addendum special provisions and CSI special provisions shall be submitted to 
CTDOT in accordance with the following: 

• For projects where a consultant is the Project Manager on the project, the 
Specification and CSI special provisions in WORD format shall be submitted in 
(1) zipped folder. 

• For projects where a CTDOT design unit is the Project Manager on the project, 
the Specification and CSI special provisions in WORD format shall be submitted 
in individual zipped folders per discipline. 

• Addendum special provisions shall be submitted in WORD Format in a zipped 
folder.  Each page of the specification section shall be marked in the bottom 
right corner of the footer with “Addendum No. Y”, where “Y” equals the 
addendum number.  Also a line shall be placed on the right side indicating 
where language was changed in the specification.   

• Special provisions shall be submitted in a zipped folder for the following 
submissions:  FDP, revised FDP special provisions, Addendum special provisions, 
and revised addendum special provisions.  Revised FDP and revised addendum 
submissions shall only include the revised special provisions. 

• FDP, revised FDP special provisions, Addendum special provisions, and revised 
addendum special provisions shall be uploaded into the 240 Contract 
Development folder under the project in ProjectWise in accordance with 
Section 6.1 and attributed in accordance with ProjectWise Attribute Table of 
this manual. 

4. Design Initiated Change Order special provisions shall be prepared and submitted in 
accordance with the following: 

• On each sheet of the revised specification, “C#” and the date shall be placed in 
the bottom right corner of the footer.   An example would be “Rev. C1 - 
mm/dd/yy”. 

• For projects where a consultant is the Project Manager on the project, the 
Specification and CSI special provisions in WORD format do not need to be 
uploaded into ProjectWise. 

• For projects where a CTDOT design unit is the Project Manager on the project, 
the DCO Specification and DCO CSI special provisions in WORD format shall be 
submitted in individual zipped folders per discipline. 

• The project manager shall combine all the DCO specifications into (1) multi-page 
PDF document. 

• The consultant or state design Project Manager shall follow Section 7.2 for the 
submission of DICO specs.  

 
 
 
 
 

http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
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 Estimates and Quantity Calculations 
Estimates 
Cost Estimates shall be prepared in accordance with the procedures detailed on this website: 
Cost Estimating 
 
Preliminary cost estimates shall be uploaded into the 310_Milestone Submissions under the 
applicable project in accordance with Section 6.1 of this manual. 
 
Final Proposal and Federal Estimates shall be uploaded into the 240_Contract Development 
folder under the applicable project in accordance with Section 6.1 of this manual. 
 
Calendar Day estimates shall be uploaded into the 240_Contract Development folder under the 
applicable project in accordance with Section 6.1 of this manual. 
Quantity Calculations 
Quantity Calculations shall be formatted and submitted in accordance with the following: 

• Shall be native PDF whenever possible. 

• Scanned pages shall be readable and have a minimum resolution of 200 dpi.    

• Pages in the PDF can be any size.  8.5” x 11” is recommended. 

• Shall be uploaded into the 150 – Quantity Calculations folder under the project in 
ProjectWise in accordance with Section 6.1 and attributed in accordance with 
Projectwise Attribute Table of this manual.  The final status shall also be applied as 
shown in Section 2.5.   

 Environmental Permits 
Environmental permit applications, permit approvals, and other permit documents shall be 
uploaded into ProjectWise and formatted in accordance with the following: 
Permit Need Determination Form (PNDF) and Other Permit Documents 

• Shall be native PDF whenever possible. 

• The PNDF shall be uploaded into the 320_Permit Development Folder under the project 
in ProjectWise in accordance with Section 6.1 and attributed in accordance with 
Projectwise Attribute Table 

Environmental Permit Applications: 

• Shall be native PDF whenever possible. 

• Scanned pages in the application must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

• All pages, except plans sheets, shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

• Before FDP, each permit application shall be in an individual multi-page PDF file.  Each 
permit shall be shall be then uploaded into the 320_Permit Development Folder under 
the project in ProjectWise in accordance with Section 6.1 and attributed in accordance 
with the  Projectwise Attribute Table 

• At FDP, the individual multi-page PDF files shall be uploaded into the 240_Contract 
Development folder under the project in ProjectWise in accordance with Section 6.1 and 
attributed in accordance with the Projectwise Attribute Table 

Environmental Permit Approval 

• Shall be native PDF whenever possible. 

• Scanned pages in the permit must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

• Shall be sized 8.5” x 11”. 

• Before FDP, each permit approval shall be in an individual multi-page PDF file.  Each 
permit shall be shall be then uploaded into the 320_Permit Development Folder under 

https://portal.ct.gov/DOT/Engineering-Applications/Submissions---Cost-Estimating
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
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the project in ProjectWise in accordance with Section 6.1 and attributed in accordance 
with Projectwise Attribute Table 

• At FDP, the individual multi-page PDF files be uploaded into the 240_Contract 
Development folder under the project in ProjectWise in accordance with Section 6.1 and 
attributed in accordance with Projectwise Attribute Table 

 Contractor Submittals  
See Section 9 for format, submittal and review requirements for Contractor Submittals: Working 
Drawings, Shop Drawings, Product Data, RFI, and RFC.  

 Engineering Reports 
Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in accordance with 
the following: 

• Shall be native PDF whenever possible. 

• Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

• All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

• Shall be digitally signed and watermarked in accordance with Section 5 of this manual. 

• Any data files that must accompany the PDF report shall be uploaded into ProjectWise 
in a zipped folder.   

• The reports and zipped folder for any data files shall be submitted into the 
130_Engineering Reports folder under the applicable project in accordance with Section 
6.1 of this manual.  The final status shall also be applied as shown in Section 2.5.   

• Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
ProjectWise.  

Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be formatted in 
accordance with the following.  The content of the report shall be in accordance with the Scope 
defined by the Division of Environmental Compliance: 

• Shall be native PDF whenever possible. 

• Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

• All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

• Shall be digitally signed in accordance with Section 5 of this manual. 

• These reports shall be submitted into the 130_Engineering Reports folder under the 
applicable project in accordance with Section 6.1 of this manual.  The final status shall 
also be applied as shown in Section 2.5.   

• Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
ProjectWise.  

Rehabilitation Study Reports and Type Study Reports:  Shall be created and formatted in 
accordance with the Bridge Manual: 

• Final reports shall be uploaded into the 140_Project Administration folder in 
ProjectWise.   The final status shall also be applied as shown in Section 2.5.   

• Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
ProjectWise.   

Bridge Load Ratings:  Shall be created and formatted in accordance with the Bridge Load Rating 
Manual:  

• Final load ratings shall be digitally signed in accordance with Section 5 of this manual. 

• Final reports shall be uploaded into the 130_Engineering Reports folder in ProjectWise.   
The final status shall also be applied as shown in Section 2.5.   

https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/DOT/State-Bridge-Design/State-Bride-Design-Manuals
https://portal.ct.gov/-/media/DOT/documents/dbridgepubs/Local-Bridge-Program-Manual---April-2019.pdf?la=en
https://portal.ct.gov/-/media/DOT/documents/dbridgepubs/Local-Bridge-Program-Manual---April-2019.pdf?la=en
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• Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
ProjectWise.   

Geotechnical Reports: 

• Shall be native PDF whenever possible. 

• Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

• All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

• These reports shall be submitted into the 130_Engineering Reports folder under the 
applicable project in accordance with Section 6.1 of this manual.  The final status shall 
also be applied as shown in Section 2.5.   

• Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
ProjectWise.  

 Project Administration and Project 

Correspondence Documents 
Project Administration Documents 
Final project administration documents shall be stored in the 140_Project Administration folder 
under the project in ProjectWise in accordance with the following: 

• Shall be in PDF Format. 

• Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 
dpi. 

• The document must be uploaded into ProjectWise in accordance with Section 6.1 and 
attributed in accordance with Projectwise Attribute Table of this manual.   The final 
status shall also be applied as shown in Section 2.5.   

Note: The discipline attribute must match the author of the document.  For example, if the 
Highway design unit sends out a memo for a design review, the discipline attribute on this 
document shall be HW.   

• Draft project administration documents can also be created and worked on in 
ProjectWise.  These file shall be located under the user’s discipline 330_Design_Data 
folder under the project in ProjectWise.  

Project Correspondence Documents 
Project correspondence documents shall be stored in the 142_Project Administration 
Correspondence folder under the project in ProjectWise in accordance with the following:    

• Shall be in PDF Format. 

• Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 
dpi. 

• The document must be uploaded into ProjectWise in accordance with Section 6.1 and 
attributed in accordance with Projectwise Attribute Table of this manual.  The final 
status shall also be applied as shown in Section 2.5.   

Note: The discipline attribute must match the author of the document.  For example, if the 
Highway design unit sends out a memo for a design review, the discipline attribute on this 
document shall be HW.   
 
This folder is for all final project correspondence documents.  This is defined as any request 
memos, response memos, emails, letters, etc. and does not include any documents that are 
defined in the 140_Project Administration folder.  This folder shall not include any working/draft 
documents.  The final status shall also be applied as shown in Section 2.5.   

• Emails – The sender of the email is required to store a PDF of the email message in 
ProjectWise.   

• Letters 

https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
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• Meeting Minutes 

• Request Memos – Survey Request, Design Reviews, Support unit design.    

• Response Memos – Response to the Request Memos 

 Project Location (Geo-Spatial Boundary or 

Route ID and Mileage) 
The project location shall be prepared and submitted in accordance with Section 13. 

 Design Calculations 
Design Calculations for all structural elements on a project shall be formatted and submitted in 
accordance with the following: 

• Shall be native PDF format whenever possible.   

• Scanned pages shall be readable and have a minimum resolution of 125 dpi.    

• Pages in the PDF can be any size.  8.5” x 11” page size is recommended. 

• Shall be uploaded into the 151 – Final Design Calculations folder under the project in 
ProjectWise in accordance with Section 6.1 and attributed in accordance with 
Projectwise Attribute Table of this manual.  The final status shall also be applied as 
shown in Section 2.5.   

 Electronic Engineering Data (EED) 
Electronic Engineering Data shall be prepared and submitted in accordance with Section 12. 

 Contract Plan Drawing and Sheet Numbering 

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited 
to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall 
consist of the discipline designator followed by a hyphen and the sheet number.  Examples of 
discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.   
 
The first sheet in a discipline subset shall have “01” in the drawing number as shown below: 

 

Figure 52 Contract Drawing Numbering 

Page labels and sheet numbers are applied to the discipline subset after the contract plans are 
published to PDF. 
 
Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the 
number pages and header and footer tools within Bluebeam.  Page labels and sheet numbers 
shall be applied to all submissions of contract plans. 
 

https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
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The first sheet in every subset shall start out at 01.  For example the first sheet in the 05-Traffic 
subset shall be 05.01.  

 

Figure 53 - Drawing and Sheet Numbering 

The page label and sheet number place holder shall be determined by the total estimated sheet 
count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100 
sheets three place holders are necessary.  For subsets less than 10 sheets, two placeholders 
shall be used i.e. 01.01 thru 01.04 for a four sheet subset. 
The page labels and sheet numbers must be placed correctly because it is used to correctly 
assemble the contract plans into a properly ordered consolidated set that District Construction 
takes advantage of during construction of the project.  
 
Single Volume Projects: 
The page labels and sheet numbers, for single volume projects shall be a concatenation of the 
discipline subset number, a decimal point, and the sheet number. For example; the page labels 
and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03, 
etc. or Greater than 100 sheets 04.001, 04.002, 04.003 etc.  
The Project Manager should determine the total number of subsets and give each discipline 
their corresponding subset number, see Section 4.1. 
 
Multi Volume Projects: 
For a multi volume project the page labels and sheet numbers shall be a concatenation of the 
volume number, a decimal point, the discipline subset number, a decimal point, and finally the 
sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.  
 
Volume numbers shall be used on large projects. They are effective because the Project 
Manager only has to deliver to the other engineers their perspective volume numbers, allowing 
them to manage their subset numbers independently of the other discipline volumes and subset 
counts, see Section 4.1. 
 
Subset numbers shall start at 01 for all volumes. 
 
BLUEBEAM - Applying Page Labels and Sheet Numbers  
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to the discipline subset.  Go to the thumbnail pane as 
shown below, right click on a thumbnail and select Number Pages: 
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Figure 54 - Adding Page Labels 

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at 
once.  In the case where there are 10 or more sheets in the subset the following will have to be 
done twice in order to get the correct number of place holders.   
  

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply 
to the correct pages.  For example, if the 04 subset has 99 sheets the prefix shall be 
“04.0” for sheets 1-9 and “04.” For sheet 10 through 99. 

 

 

Figure 55- Page Labeling 

 
3. Now the pages will be labeled: 
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Figure 56 - Labeled Pages 

4. Next we will apply the sheet numbers.  From Bluebeam select the Document tab and 
then “Header & Footer” 

 

Figure 57 - Header Footer Tool 
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5. Place the sheet numbers, as shown below:  Note the margins may have to be adjusted 
as necessary.  After you select the font, set the margins, and type in <<PageLabel>> as 
shown below.  Then click save for save settings.  The next time you are going to apply 
sheet numbers to a subset, you can simply select the saved settings.  Then click OK. 

 

 

Figure 58 - Applying Header and Footer 

 

 

Figure 59 - Insert Sheet Numbers 
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Page labels and sheet numbers for an Addendum need to have “.A##” at the end and Change 
Orders need to have “.C##” at the end (see Section 7 for addendum and change order sheet 
numbering requirements). 
 
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to each sheet in the addendum or change order.  This 
can only be done one sheet at a time.   

2. Go to the thumbnail pane as shown below and then double click on the page label.  
Then type in the correct page label for the sheet. 

 

Figure 60 - Adding Page Labels 
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3. After all page labels have been applied, the sheet numbers can be applied.  From 
Bluebeam select the Document tab and then “Header & Footer” 

 

Figure 61 - Header Footer Tool 

4. Select your sheet numbers saved settings from before and click OK.  Note the margins 
and size may have to be adjusted as necessary.   

 

 

Figure 62 - Applying Header and Footer 

 

 

Figure 63 - Applying Addendum or DCO Sheet Numbers 
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 Consolidating Contract Plan Discipline Subsets  
The consolidation of the contract plan discipline subsets is accomplished using the Set feature in 
Bluebeam version 11 or newer.  This feature creates a single viewer file called a “Set File” that 
allows users to take multiple digitally signed files, sort them by their sheet numbers, and view 
them in order without actually combining the files.   
 
The project manager shall create a Set file for the project at DCD that contains all the discipline 
subsets, DO NOT include the highway and traffic standard subsets.  When an Addendum or 
Change Order is required for the project, the project manager shall update the set file to include 
the Addenda or Change Order subsets. 
 
The following shows when and how a set file will be created and updated throughout the life of 
a project.  
 
See Appendix C for general use of a set file. 
 

Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature 
in Bluebeam.   
 
Also the PDF checker must be run on the subsets and they must receive a PASS status 
for the Set File to sort the subsets correctly.  See section 6.3 information on the PDF 
checker  

Set File Creation  
1. The project manager shall create a set file of all the discipline subsets at DCD, see 

Section 4.15.2 

Set File Updates 
2. If any Addendum subsets are required for the project, these Addendum subsets shall be 

added to the set file by the project manager.  

3. If any Design Imitated Change Order subsets are required for the project, these Design 

Initiated Change Order subsets shall be added to the set file by the project manager.  

See Section 4.15.3 for updating the set file. 

Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature 
in Bluebeam.   
 
Also the PDF checker must be run on the subsets and they must receive a PASS status 
for the Set File to sort the subsets correctly.  See section 6.3 information on the PDF 
checker  
 
After all the discipline subsets have been submitted into ProjectWise for DCD the project 
manager shall create the project’s set file in accordance with the following:   

1. Launch Bluebeam from the desktop icon on your computer.  

2. Next Click on the Set Icon and select New Set as shown below: 
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Figure 64 - Creating a Set File 

 
3. Then click Add and then ProjectWise and OK as shown below: 

 

Figure 65 - Adding Files to the Set File 

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except 

the standard subsets.  Then click Open:  After you click Open it may take a minute for 

Bluebeam to load all the files into the set, please be patient.   
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Figure 66 - Adding Files to the Set File 

5. Next Click on Relative Paths and then click options: 

 

Figure 67 - Set File Options 

6. Next on the sorting tab, make sure all the options shown below are set: 
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Figure 68 - Configuring the Set File 

 
7. Then on the Categories Tab make sure the categories are turned off: 

 

Figure 69 - Set File Categories 

8. Then on the Tags Tab make sure nothing is checked and then click OK: 
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Figure 70 - Tags Tab 

 
9. Next click Save, this may take a while depending on how big the project is, please be 

patient.  When the box pops up choose ProjectWise and click OK: 

 

Figure 71 - Saving the Set File 
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10. Select the Advanced Wizard, and then on the Select target folder browse out to your 

project’s 100_Contract_Plans folder.  Then click next until you get to the attributes 

page.  Attribute the Set File as shown below: 

 

Figure 72 - Attributing the Set File 

 
11. Click OK after the set file has been saved into ProjectWise: 

 

Figure 73 - Creating a Set File 
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12. When the Tags box pops up just click OK: 

 

Figure 74 - Set File Tag Dialog Box 

13. Now the set file has been created.  As you see below all the sheets from the files are 

listed and crossed out accordingly.  For use of the Set File see Appendix C:

 

Figure 75 - Set File 
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Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature 
in Bluebeam.   
 
Also the PDF checker must be run on the subsets and they must receive a PASS status 
for the Set File to sort the subsets correctly.  See section 6.3 information on the PDF 
checker  
The following will show how to update a set file.  When an Addendum or Change Order is 
required for the project, the set file shall be updated by the project manager.   

Adding a File to the Set File 
1. Double click on the set file from ProjectWise and open as shown below:  This may take a 

while depending on how big the project is, please be patient. 

 

Figure 76 - Opening a Set File 
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2. Next click on the Set icon and click Add as shown below: 

 

Figure 77 - Modifying a Set File 

3. Next browse out to your project and select the files to add to the set and click Open.  

This may take a minute to add the additional file to the set so please be patient.  After it 

finishes click OK.   

 

Figure 78 - Adding Files to the Set File 
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4. Now the file will be added to the set, scroll down and you will see it.  

 

Figure 79 - Set File 

Deleting a File from the Set 

Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature 
in Bluebeam.   
 

1. Double click on the set file from ProjectWise and open as shown below: 
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Figure 80 - Opening a Set File 

2. Next click on the Set Icon.  Then select the file to remove from the set and click delete: 

 

Figure 81 - Deleting a File from the Set File 
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 Digital Signatures for Contract 

and Other Engineering Documents 

The follow contract documents must be digitally signed when submitted to the Department in 
accordance with the following section: 

• Contract Plans – FDP, Addendum, Change Orders 

• Engineering Reports 
o Hydraulic Report 
o Scour Report 
o Floodway Report 
o Final Drainage Reports 
o Bridge Inspection Reports 
o Bridge Load Ratings 
o Task 110 
o Task 220 
o Underground Storage Tank System Closure Reports 

• Working Drawings for Permanent and Temporary Structures – Plans and Calculations 
 
This manual refers to digital signatures in two ways: certifying signatures, and signing signatures. 
The Engineer of Record or document signer will always digitally sign using a visible certifying 
signature.  If multiple signatures are required per document, the second signer or sub-engineers 
shall always digitally sign using a visible signing signature after the primary signer or engineer 
has applied his certifying signature.  Certifying signatures allow controlled changes, to the now 
certified document.  These controlled changes include; allowing PDF digital comments, and the 
application of additional signatures.  Signing signatures should always be accompanied by a note 
listing the sheets the signer is responsible for within a subset.   
 
In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the 
first sheet of the document, regardless of the number of pages the document contains. This 
digital signature secures the entire document.  
 
A graphic image of the signer’s signature must be created, and shall be used for the following 
purposes:    

• It shall be attached to the digital signature and displayed when the digital signature is 
applied.  

• It shall be placed as a watermark on all contract plan sheets a particular engineer of 
record is responsible for (digitally signing for).   

• It shall be placed on the first sheet by the preparer and checker of an engineering 
report. 

• The watermark shall be placed on all contract plan sheets and all plan sheets contained 
in a working drawing submittal. 

 
A digital ID must be purchased in order to apply a digital signature.  Digital ID’s must meet the 
special provisions of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List 
(AATL).  The necessary hardware and software needed to apply the required digital signatures 
may be purchased from the vendor list provided at the following website: 
HUhttp://www.adobe.com/security/partners_cds.htmlUH, additional information on Adobe’s CDS is 
also available at this website. 
 
Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.  
 

https://helpx.adobe.com/acrobat/kb/certified-document-services.html
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 Graphic Image of Signature 

The following figures display an example of both a state designer and a consultant designer’s 
digital signatures, and their accompanying graphic image(s) of their signature(s). See Section 5.2. 
for instructions on how to create a graphic image.    
 
The consultant engineer’s graphic image must contain his companies name and address; his 
signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state 
employee’s graphic image must contain only his signature. See Below. 
 

      

Figure 82 - Graphic Image of Signature 

In addition to a digital signature being placed on the first sheet of any contract plan, working 
drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages 
be watermarked with a copy of the engineer of records graphic signature before they are 
digitally signed. Watermarks containing these signatures are applied using Bluebeam and are 
always placed in the border of contract plans and working drawings for permanent structures. 
This is to prove validation of a digital document if printed. 
 

         
 

        

Figure 83 – Watermarks 

 

 

1st page of Subset 

Watermark of State Design Graphic 
Signature 

Watermark of Consultant Designers  
Graphic Signature 
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Hydraulic, Scour, Floodway, and Final Drainage Reports 
The following shows the watermarks that need to be placed on the first sheet of a Hydraulic, 
Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital 
signature of the Approved Hydraulic Engineer.  The digital signature must include the graphic 
image of the signer’s PE stamp and signature as shown below, Section 5.2. for instructions on 
how to create a graphic image.  These reports shall be digitally signed in accordance with 
Section 5.6.7   
 

 

Figure 84 - Engineering Reports 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 80 Version 5.01 
     

Bridge Inspection Reports 
The following shows how Bridge Inspection reports are to be digitally signed in the bottom right 
hand corner of the report. The digital signature must include the graphic image of the signer’s 
PE stamp and signature as shown below, Section 5.2. for instructions on how to create a graphic 
image.  These reports shall be digitally signed in accordance with Section 5.6.7   

 

Figure 85 - Bridge Inspection Reports 
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Bridge Load Ratings 
The following shows how Bridge Load Ratings are to be digitally signed. The digital signature 
must include the graphic image of the signer’s PE stamp and signature as shown below, Section 
5.2. for instructions on how to create a graphic image.  The load ratings shall be digitally signed 
in accordance with Section 5.6.1  
 

 

Figure 86 - Bridge Load Ratings 

 
Environmental Compliance Reports 
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure 
Reports must include a graphic image of the Professional engineer’s signature or a graphic 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 82 Version 5.01 
     

image of the signer’s signature where applicable, see Section 5.2. for instructions on how to 
create a graphic image. These reports shall be digitally signed in accordance with Section 5.6.7   

Working Drawings for Permanent and Temporary Structures 
The following shows the digital signature and Professional Engineering watermark requirements 
for the engineer who prepares the working drawing submittal.   These types of submittals shall 
be digitally signed in accordance with Section 5.6.6   Note:   Working Drawing for Temporary 
Structures only require that the first sheet in the submittal be digitally signed, watermarks are 
not necessary.  See Section 5.2 for instructions on how to create a graphic image. 
 
Working Drawing Plans 
The first plan sheet in the submittal shall have a digital signature and a watermark placed on it 
as shown below. All others sheets will only have the watermark.  A place in the border of the 
plan sheets shall have a spot for this watermark.  
 

 

Figure 87 - Working Drawing for Permanent Structures 

 
Working Drawing Calculations 
The first sheet of the calculations shall have a digital signature as shown below: 
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Figure 88 - Working Drawing for Permanent Structures 

Documents that do not require to be signed by a Professional Engineer shall have a graphic 
image of the signer’s signature attached to their digital signature. See Section 5.2. for 
instructions on how to create a graphic image. 

 Creating Graphic Image of Signature: 

The graphic signature will be used by CTDOT employees and signers that are not signing as a 
Professional Engineer.   
 
CTDOT graphic signatures shall be created as follows: 
 

1. Signer must sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.  
4. Save the images, in PDF to an area on your PC. 

 

Figure 89 (Example of CTDOT Graphic Image of Signature – Used with Digital Signature and as a Watermark) 

Consultant Engineers shall create two different graphic signature images: one that shall 
accompany their digital signatures and a different one that shall be placed as a watermark on all 
the plan sheets the engineer is signing for.  
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This section shows an example of a Professional Engineer preparing their graphic image of their 
signature; Architect’s shall follow this section when they are preparing their digital signature.   
Graphic Appearance Attached to Digital Signature 
The graphic signature that accompanies the digital signature only needs to include the 
designer’s signature and P.E. Stamp. , and shall be created as follows:   
 

1. Stamp and Sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image to approximately 250 pixels wide by 250 pixels high. 
4. Save the image, in PDF to an area on your PC or server, where you can easily access it 

for later use in the signature set-up procedure.  

 

Figure 90 ((Example of Consultant Engineer Graphic image of Signature – Applied to 1st page only with digital signature) 

 
Graphic Appearance used as a Watermark  
In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a 
watermark shall also include the designer’s company name and address, and shall be created as 
follows:   
 

1. On blank paper – Print company name and address. 
2. Place P.E. stamp next to company name and address. 
3. Sign P.E. Stamp.  
4. Scan the image created in steps 1 thru 3 above.   
5. Crop the image to approximately 500 pixels wide by 250 pixels high. 
6. Save the image, in PDF to an area on your PC or server, where you can easily access it 

for later use in the watermarking procedure.   
 

 

Figure 91 (Example of Consultant Engineer Graphic image of Signature – applied to all pages as a watermark) 

Once the graphic images have been properly created and saved, the digital signature 
appearance preferences must be set as follows: 
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 Setting Digital Signature Appearance 

Preferences: 
 
Once the graphic signatures are created the digital signature appearance settings must be 
defined as follows: 
Bluebeam Digital Appearance 

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the 
Document tab and select Signatures>Digital ID’s: 

 

Figure 92 - Digital Appearance 

2.  Next click on your ID and click Manage Appearances: 

 

Figure 93 - Manage Appearances 

3. Next follow the figure below: 
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Figure 94 - Setting the Digital Appearance 

4. Now the digital appearance will be saved and can be used to digitally sign. 

 Watermarking Plans with Graphic Image of 

Signature 
The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a 
copy of their graphic signature as a watermark on each sheet of each discipline subset, or 
working drawing submittal(Plans and Calculations) that they are responsible for.  For 
Engineering Reports the preparer and checker of the report shall place a copy of their graphic 
signature as a watermark only on the cover of the report.   
 
Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant 
Designed) 
There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2.  The 
following shows an example of a CTDOT signature, but the procedure is the same for a 
consultant when they are placing their PE stamp in the border or on the first sheet of an 
engineering report. 
 
Watermarking Workflow: 
Option 1 

1. The watermark in Bluebeam is placed using the stamp function.  First go to the Markup 
tab and select Stamp and then choose your stamp.  If your Principal’s or PE stamp is not 
in the list follow Appendix A.  If your stamp is in the list go to step 2. 

 
2. Next place the stamp in the border on the first sheet.   
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Figure 95 - Placing Watermark 

3. Next right click on the stamp and select “Apply to all pages”.  If you are watermarking an 
engineering report you do not need to apply to all pages.   

 

Figure 96 - Placing Watermark on All Pages 

If more than one group has to watermark this subset, browse to the pages the other group is 
responsible for and delete the watermark.  Then they can come in a place their watermark on 
these sheets.   
Flatten Markups 

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF 
document.  Go to Document>Flatten Markups.  Use the default settings and click OK.   

1. After the watermarks have been placed on the subset, the watermarks must be 
“flattened” to the PDF document.  Go to Document>Flatten Markups.  Use the default 
settings and click OK.   
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 Digital Signature Fields  
Contract Plans 
Digital signature fields are form fields created using Bluebeam, and are used to house the digital 
signatures. Digital Signature form fields shall be placed within the form field place holders. The 
form field place holders are cells that are placed in the Bentley Software file on the title sheet 
and the subset cover sheets and on any Addendum or Change Order Subset.  The figure below 
shows a CTDOT designed project with the form field place holders (circled) on the title sheet and 
the discipline subset cover sheet.    
 

 

Figure 97 - Digital Signature Fields 

The figure below shows a consultant designed project’s title sheet and discipline subset cover 
sheet with their form field place holders.     

 

Figure 98 - Consultant Watermarks 

Place holders determine the location and size of the digital signature form field.  
 
Form field place holding cell library: CT_Digital_Sigs.zip  
 
The digital signature place holder and form fields shall be created on the first page of each 
discipline subset for each required digital signature. 
 
Note:  All signature form fields need to be created for both certifying and signing signatures 
before any digital signatures is applied to the document. 
 
Contractor Submittals 
Contractor submittals will not be required to have a digital signature place holder.   
 
Engineering Reports 
Engineering reports will not be required to have a digital signature place holder.   

 

 

 

https://portal.ct.gov/-/media/DOT/documents/AEC/ct_digital_sigs.zip
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The following example shows how to place the (3) digital signature form fields on the 01-
General title sheet of a CTDOT designed project.  For a discipline subset or a consultant designed 
01-General title sheet, only one digital signature form field needs to be placed.    
 

1. To place signature fields click X. 
 

2. Next place three signature fields in the appropriate location and hit save as shown 
below: 

 

Figure 99 - Placing Signature Fields 

 Applying Digital Signatures 
This section describes how to apply digital signatures for contract plans, engineering reports, 
working drawing plans, and working drawing calculations.   
 
Contract Plans 
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic 
Standard drawing subsets have unique requirements as described in the following sections.   
 
CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded 
into ProjectWise because the Principal Engineer will be looking in ProjectWise to digitally sign 
documents.   
 
Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of 
record, using a single visible certifying signature, applied to the signature form field located on 
the first page of each subset. 
 
Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of 
Record who is responsible for the most sheets in the subsets.  This engineer will apply a visible 
certifying signature in the top most form field. The next Engineer of Record shall apply their 
signing signatures in the subsequent form fields. This Engineer shall also include a reason, when 
applying their digital signatures, listing the pages they are responsible for.  
 
Digital signatures must be applied to digital signature form fields, previously.  See Section 5.5  
 
Engineering Reports 
Engineering Reports shall be digitally signed, by the Engineer of Record using a certifying.  See 
Section 5.7 for instructions on how to apply a certifying signature to an engineering report. 
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CTDOT DESIGNED PROJECTS: 
The following procedure applies to both the 01_General subset at FDP and any 01_General_A# 
subset.   
 
The project title sheet of the 01_General subset shall first be digitally signed by the lead 
discipline’s Principal Engineer, using a certifying signature.  The Principal Engineer should make 
sure that all three digital signature form fields (blue boxes in the signature block) are placed 
before signing, as these forms cannot be added after the document is digitally certified.  After 
processing has approved the 01_general subset for Advertising, the Manager, and the 
Transportation Engineering Administrator shall digitally sign the same sheet directly below the 
principal’s signature, using a signing signature while the plans are in the Manager and Engineer 
Admin. Sign state.   
 
Processing shall notify the lead designer when the 01-General subset is placed in the Manager 
and Engineer Admin. Sign state.  The lead designer shall then coordinate the digital signing by 
the Manager and Engineering Administrator of the 01_General subset.  When both signatures 
are applied to the plans, the lead designer shall then notify processing that the 01-General 
subset has been signed.     
 
See Section 5.7 Applying Digital Signature Workflows 
Note: When digitally signing the 01_General subset all signers shall leave the reason code 
blank. 
The following image shows a typical project title sheet from the 01_General subset that is 
digitally signed: 

 
 

Figure 100 - Title Sheet Digital Signatures 

 
CONSULTANT DESIGNED PROJECTS: 
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The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, 
using a certifying signature.  
 
See Section 5.7 Applying Digital Signature Workflows 
 

 

Figure 101 - Consultant Designed Title Sheet 

 
When more than one consultant works on a CTDOT digital project the project manager (prime 
consultant) shall apply a visible certifying signature to the first page of the 01_General subset.  
By applying this signature the prime consultant is accepting responsibility for the entire set of 
digital contract plans.  However the individual subsets shall be signed by the corresponding 
firms.    
Note: When applying certifying or signing signatures leave the reason code blank.  

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a CTDOT signature, but the workflows are the same.   
 
This subset does not need to be signed at FDP.  This subset must be signed when the sheet 
is filled out for an Addendum or design initiated change order, whichever comes first.   
 
The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed 
by the lead designer, using a certifying signature.   
 
1. The lead designer shall apply a certifying signature as described in Section 5.7 Applying 

Digital Signature Workflows with the following EXCEPTION; the option “No Changes 
Allowed” must be selected to eliminate unauthorized changes after certifying the 
document. See the figure below: 
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Figure 102 Certifying Dialog Box for 02_Revisions.pdf 

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same.   
 
Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the 
responsible design engineer. As shown below. 
 
See Section 5.7 Applying Digital Signature Workflows 

 

 

Figure 103 CTDOT Certified Plan Subset 

This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same.   
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Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need 
to be digitally signed with a visible certifying signature, by the responsible design engineer that 
submits the subset to ProjectWise.  For example, in the case where the Traffic unit is submitting 
a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the 
index sheets, not the Highway Principal Engineer.   
See Section 5.7 Applying Digital Signature Workflows 
 

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same for 
CTDOT designed projects.    
 
Multiple signatures per a single subset are required where two or more disciplines/firms are 
responsible for one subset. 
 
The lead designer that is responsible for most of the pages within a discipline subset shall 
digitally sign the subset using a certifying signature, and leave the reason code blank.  See 
Section 5.7 Applying Digital Signature Workflows 
Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset 
using a signing signature, and complete the reason code with a note stating which pages, 
contained in this subset, that they are responsible for.  See table 2-1 below: 
See Section 5.7 Applying Digital Signature Workflows 
Table 1 Reason Codes for Prime and Sub Consultants 

Designer Certify or 
Sign 

Responsible 
Sheet 

Numbers 

Reason Code 

Lead Designer Certify   

Sub-Designer 1 Sign 03.78 Thru 
03.88 

I am Signing for Sheet Nos. 03.78 thru 
03.88 

Sub-Designer 2 – 
etc. 

Sign 03.88 Thru 
03.98 

I am Signing for Sheet Nos. 03.88 thru 
03.98 

Working drawing submittals shall be digitally certified in accordance with Section 5.7 Visible 
Digital Signature using a Certifying signature, of this manual.   

Engineering Reports shall be digitally signed, by the applicable person using a certifying.  See 
Section 5.7 for instructions on how to apply a certifying signature to an engineering report.  If a 
report needs to be digitally signed by more than one person, the first person must apply a 
certifying signature as shown in Section 5.7 and any subsequent signature will be a signing 
signature as shown in Section 5.7. 

Load Ratings shall be digitally signed, by the applicable person using a certifying signature with 
the No Changes Allowed option selected as shown below: 
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Figure 104 Certifying Load Ratings 

 Applying Digital Signature Workflows  
 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a CTDOT signature where the document is located in 
ProjectWise, but the workflows are the same.      
 

Certifying Signature: 
1. Left click on the signature field and then update the settings as shown below.  Examples 

below are for a CTDOT designed project’s title sheet and the first sheet of an 
Engineering Report: 
 

Discipline Subsets 
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Figure 105 - Certifying Discipline Subsets 

Engineering Reports  or Documents that Require (1) Digital Signature 

 

Figure 106 - Certifying Engineering Reports 

 
2. Next for document in located in ProjectWise click ProjectWise V8i as shown below and 

then click OK.  If the document is located on your computer click My Computer list 
below: 
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Figure 107 - Certifying Signature 

 
3. Then select yes to overwrite existing file as shown below for ProjectWise or if the 

document is located on your computer overwrite the existing file or save to a new 
location: 

 

Figure 108 - Certifying Signature 

 
4. If using ProjectWise check the document back into ProjectWise.   
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Digital Signing Signature: 
Once the prime engineer applies his certifying signature the additional signing signatures can be 
applied by the sub-consultants as follows:  
 

1. Left click on the signature field and then update the settings as shown below: 
 

 

Figure 109 - Signing Signature Bluebeam 

 
2. Next for document in located in ProjectWise click ProjectWise V8i as shown below and 

then click OK.  If the document is located on your computer click My Computer list 
below: 

 

Figure 110 - Open from ProjectWise 
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3. Then select yes to overwrite existing file as shown below for ProjectWise or if the 
document is located on your computer overwrite the existing file or save to a new 
location: 

 

Figure 111 - Overwriting a File 

4. If using ProjectWise check the document back into ProjectWise.   
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 Submitting Documents to CTDOT 

This section details the procedures for submitting documents to ProjectWise.    

 FDP Submittal to Processing 
The files required to be submitted to Processing must be added to the set file stored in the 
240_Contract Development folder as shown below.  The set file creates a link to the document 
so documents can be stored in separate folders, but show up together.  When files are added to 
a set file they are not moved, a link is created.    
 
If there is not a set file in the 240_Contract Development folder in ProjectWise contact 
DOT.AECapplications@ct.gov or follow these steps to create a set file in the 240 Contract 
Development folder:   

1. Right click on the 240 folder, right click in the white area and select properties. 
2. Then select Set>New 

 

 

Figure 112 - Creating a Set File 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:DOT.AECapplications@ct.gov
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  After the file is created populate the set file as follows: 
1. Open the Set file by double clicking on it. 
2. Then browse out the folder where the documents are stored. 
3. Then drag and drop the document(s) into the set file window as shown below: 

 

Figure 113 - Adding Files to the Set File 
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 Uploading Documents 

The following shows how to upload Contract plans into the 100 Contract Plan folder in 
ProjectWise, but this procedure can be followed for uploading documents into any folder in 
ProjectWise.   

1. Once logged into ProjectWise browse out to project and folder you need to upload into.  
Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.  

 

Figure 114 - Selecting the Interface 
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2. Next select Document>Upload as shown below: 
 

 

Figure 115 - Uploading Document into ProjectWise (Thin Client) 

3. Next browse out to the document you want to upload.   

 

Figure 116 - Uploading a File to ProjectWise 
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4. After the file uploads, right click on the file and select Properties: 

 

Figure 117 - Select Properties 

5. Then assign the applicable attributes from the tables in Projectwise Attribute Table:  If 
you cannot assign attributes, the interface was not selected as detailed in step 1 or this 
section.   

 

Figure 118 - Thin Client Attributes 

https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
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The following shows how to upload Contract plans into the 100 Contract Plan folder in 
ProjectWise, but this procedure can be followed for uploading documents into any folder in 
ProjectWise.   
 

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not 
shown go to View>Toolbars and select interface. 

2. Drag and Drop files into the correct folder in the Project. 

 

Figure 119 - Uploading Into ProjectWise (Thick Client) 

3. Select the “Advanced Wizard” 
4. Click “Next” until you reach the figure below: 
5. Then assign the applicable attributes from the tables in Projectwise Attribute Table:  If 

you cannot assign attributes, the interface was not selected as detailed in step 1 or this 
section.   

 

https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Projectwise-Attribute-Tables.pdf
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Figure 120 - Attributing (Thick Client) 

6. On the Document Properties page nothing needs to be edited.   
7. On the create document page click next and the document will be uploaded into 

ProjectWise.   
8. Once the document is uploaded the user may need to click F5 (refresh) to see the file 

name update.  

 PDF Checker – Contract Plans 
The Discipline Subset PDF Checker software was developed to check that Contract Plan 
Discipline Subsets are formatted and delivered to CTDOT correctly.  This checker replaces the 
old requirements of attaching the discipline subset checklist to each subset and stamping each 
subset with the green QA/QC stamp.  These two things are no longer required.  
 
This checker is an add-on to ProjectWise Thick Client and can only be run using ProjectWise 
Thick Client.  See Section 6.2.2 for the typical workflows for using the PDF Checker.  This section 
provides details for ProjectWise Thin Client users.   
 
The following details what is checked with this software: 

(1) CAD Requirements have been completed correctly: 
a. Page Size (see Section 4.2) 
b. Searchable Text (see Section 4.2) 
c. Levels (see Section 4.2) 

(2) PDF post processing steps have been completed correctly: 
a. Page labels (see Section 4.14.2) 
b. Sheet numbers (see Section 4.14.2) 
c. Watermarks and flatten comments(see Section 5.4)  
d. Any digital signature fields (see Section 5.5) 
e. Digital Signature (see Section 5.6)       

(3) The subset was uploaded and attributed correctly in ProjectWise. 
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After the PDF checker is run, an Excel report is created detailing what is incorrect on each 
subset.  Things that are incorrect will show up red and include a note on what is incorrect.  Also 
an attribute in ProjectWise call Format Compliance will be set to PASS or FAIL when a document 
is run through the checker: 

 

Figure 121 - Format Compliance Attribute 

 
The PDF checker must be ran on all discipline subsets that are submitted to CTDOT, which 
includes the following submittal types:  FDP, DCD, DCD2, ADP, ACD, or DCO submittals.   

This is step is for consultants only, DOT staff already have the checker installed.  
1. Download the PDF checker executable from this link:  Discipline Subset PDF Checker 
2. Close ProjectWise if it is open. 
3. Run the executable. 

CTDOT Designed Projects  
The following details the typical workflow for a CTDOT designed project. 

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into 
ProjectWise in accordance with this manual. 

2. Then the PDF Checker is run on the unsigned subset(s).   By running the checker on the 
unsigned subsets, any errors can be found before the Principal digitally signs.  Note:  An 
error will be returned that a signature was not found and the ProjectWise attribute will 
show FAIL.  

3. If there are any other errors, other than the signature error, they shall be fixed.  If the 
only error in the report is the signature error, then the plans can be digitally signed by 
the principal.   

4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check 
the digital signature was applied correctly.  If there are no errors then the check is 
complete.  If there are any errors they shall be fixed and the PDF Checker rerun.     

5. The project lead should check in ProjectWise that all subsets have PASS in the Format 
Compliance attribute column. 

6. The Processing unit will be looking for the Format Compliance attribute column to be 
set to PASS before they process the subset.  

 
Consultant Designed Projects 
The following details the typical workflow for a Consultant designed project: 

1. Each consultant prepares their subset(s) and uploads their subsets into ProjectWise in 
accordance with this manual. 

https://portal.ct.gov/-/media/DOT/documents/AEC/discipline_subset_pdf_checker.zip
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2. Then the PDF Checker is run on the subset(s).  If the consultant or sub-consultant does 
not have ProjectWise Thick Client, contact your CTDOT Consultant Liaison or the lead 
consultant on the project to run the PDF Checker on those discipline subsets.   Any error 
shall be fixed and the checker rerun until the report does not have any red errors. 

3. The CTDOT Consultant Liaison or the lead consultant should check in ProjectWise that 
all subsets have PASS in the Format Compliance attribute column.    

4. The Processing unit will be looking for the Format Compliance attribute column to be 
set to PASS before they process the subset.  

This software has the capability to check one subset at a time or multiple subsets.   The 
following shows how to check multiple discipline subsets, but the procedure is the same for 
checking one subset.  

1. Log into ProjectWise. 
2. Browse out to your project and open the 100_Contract_Plans folder. 
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF 

Check.  Hold control or shift to select multiple subsets.  

 

Figure 122 - Selecting the Subsets and Running the Checker 

4. Click OK on the dialog box shown below: 
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Figure 123 - PDF Checker 

5. After the PDF Checker runs click Yes Report on the dialog box shown below.  Note:  The 
PDF Checker may take a few minutes to process depending on the size of the files it is 
checking.  

 

Figure 124 - PDF Checker Report 

6. In the report, errors will show up in red and if you hover over a red piece of text it will 
show the details of what is incorrect.  If any false errors show up in the report, please 
notify DOT.AECApplications@ct.gov  with the project and document(s) you are having 
issues with.  Example of false errors could be the page labels were applied to the subset 
but the report details they were not.   

   

 

Figure 125 - PDF Checker Report 

The Format Compliance attribute will also be set when the checker is run.  It will return a PASS 
or FAIL value as shown below: 

mailto:DOT.AECApplications@ct.gov
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Figure 126 - Format Compliance Attribute 

7. If there are no errors in the report and all document have PASS in the Format 
Compliance attribute, this process is complete.  If there are errors, the errors shall be 
fixed and the checker rerun.   

 Contract Plan and Special 

Provision Revisions (Addenda and Design 

Initiated Change Order) 

 Addenda 
Contract plans that are revised or added due to addenda shall be submitted in digitally signed 
PDF discipline subsets containing only the changed sheets.  The sheets being revised or deleted 
shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall 
be digitally signed in a digital signature place holder, that is placed in Bentley Software as 
described in Section 5 of this manual. Addendum subsets DO NOT need an index of drawings 
sheet.   Once digitally signed, the addendum subsets shall be submitted to CTDOT using 
ProjectWise, as described in Section 6 of this manual. 
 
Addenda sheets from different subsets cannot be combined and submitted as one subset, they 
must be submitted per their respected subsets.   
 
The discipline Addenda subsets shall be attributed as follows, when uploaded into ProjectWise 
(See Section 6): The addenda subset shall have the same ProjectWise label as the original final 
plan subset with the addition of (_A##) added to the end, where the ## equals the addenda 
number.  The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See 
example below: 

 
PROJECTWISE LABEL ATTRIBUTE 
 

Original Discipline Subset:  04-Traffic 
  
Addenda Discipline Subset:  04-Traffic_A01 
2nd Addenda    04-Traffic_A02 
6th Addenda    04-Traffic_A06 

 
The contract sheets (previously submitted final plans or earlier addenda plans), being revised by 
addenda shall UNOT be modified except; the Engineer of Record shall place an addenda stamp on 
the affected sheets.  This addenda stamp crosses out the entire sheet with a red X and adds the 
following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addendum 
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number. This stamp is placed over digital signatures therefore; removal of the signatures is not 
required prior to placing the addenda stamp.  For this process see Section 7.4.   
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
   
The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the 
project manager for all addenda, and submitted as described in Section 7.3.1.  A new subset 
must be updated for each addendum.   
 
A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) 
shall be placed on all added or revised sheets.  See Section 5.2 
 
Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent 
to all applicable units following Section 3.2.12. 

Bentley Software Processes 
For revised sheets the drawing numbers shall not be modified.  
 
The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be 
placed somewhere on the line of the cloud.  A like numbered triangle shall be placed in the 
revision block of the changed sheet, accompanied by a description of the revision itself. The 
revision number is specific to a particular sheet, and increases in consecutive order per revision 
and per addenda. If a sheet is changed for the first time under Addendum #2 then the sheets 
revision number is 1 since this is the first change.  If the next time it is changed again is under 
Addendum #5 the revision number becomes 2 since this is the second change to the sheet. 
 
Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a 
clear manner, do not void out the existing sheet and create a new sheet.  In these instances, 
the designer shall place a cloud just inside the border of the revised addendum sheet. 
 
Note:  When preparing an Addendum that will change quantities on a project that includes a 
"Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet."  A "Detailed Estimate 
Sheet" is never included in an addendum.  Also, the "Quantities" box shown on the General 
Plan sheet for any structure is never to be revised. 
 
Bluebeam Processes 
A note shall be placed, directly above the bottom right hand corner of the title block, on the 
replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number.   This 
note is a level in Bentley Software that needs to be turned on and edited. This note is a stamp in 
the CTDOT Miscellaneous tools in the Bluebeam tool chest that needs to be added and edited.  
If you do not have these tools in the tool chest you can find them in Appendix A of this manual.   
 
Sheet numbers for revised plans shall be as follows: 
Original Final Plan Sheet; 
 
 Original:  02.25 
 Addenda 1:  02.25.A1 
Previous Addenda Sheet; 
  

Original:  02.25.A2  
Addenda 4:  02.25.A4 

https://gbc-word-edit.officeapps.live.com/we/wordeditorframe.aspx?ui=en%2DUS&rs=en%2DUS&wopisrc=https%3A%2F%2Fctgovdot.sharepoint.com%2Fteams%2FCTDOTCompass%2F_vti_bin%2Fwopi.ashx%2Ffiles%2F93ee363021c54ce1943062d5a8bac142&wdpid=487c16e0&wdenableroaming=1&mscc=1&hid=6B6F879F-D00B-B000-6A8C-7969785845BF&wdorigin=Other&jsapi=1&jsapiver=v1&newsession=1&corrid=b75088c3-f1db-4baa-8e2d-096874db130c&usid=b75088c3-f1db-4baa-8e2d-096874db130c&sftc=1&instantedit=1&wopicomplete=1&wdredirectionreason=Unified_SingleFlush&rct=Medium&ctp=LeastProtected#_Downloading_the_Bluebeam
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If a sheet requires further revisions by a subsequent addendum, the addendum shall be 
prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam 
after addendum approval, see Section 7.4.   

Bentley Software Processes 
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one 
of two ways, as follows:  
  

1. If the new sheet does not have to be placed in a specific location within the discipline 
subset, the new sheet shall be placed last, and numbered sequentially from the last 
sheet of the discipline subset.  The total number of sheets noted on the project plans 
and discipline subsets stays the same.  The revision block on the added sheet, shall not 
be filled out. 

 
2. If the designer determines that the new sheet must go in a specific location within the 

discipline subset, the new sheet number shall be the number of the previous sheet 
followed by (-1.A#), where # is the Addendum Number.  For example, if the new sheet 
must be placed in a discipline subset right after sheet 02.57, the new sheet shall be 
numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be 
02.57-2.A1.  The total number of sheets noted on the project plans stays the same.  

 
When adding a new sheet a new drawing number is also required. As with the sheet 
number the drawing number of the new sheet shall be the drawing number of the 
previous sheet plus a decimal and the sheet count.  For example, if the new drawing 
must be placed in the project plans right after drawing number S-5, the drawing number 
shall be S-5-1. 

 
Bluebeam Processes 
A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", 
where "Y" equals the addendum number.  This note shall be located directly above the right 
hand corner of the title block.   This note is a stamp in the CTDOT Miscellaneous tools in the 
Bluebeam tool chest that needs to be added and edited.  If you do not have these tools in the 
tool chest you can find them in Appendix A of this manual.   
 
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows: 

 
Original Final Plan Sheet; 
 
 Original:  04.31 
 Addenda 3:  04.31-1.A3 
 
Previous Addenda - Added Sheet; 
 
 Original:  03.24.A1 
 Addenda 4:  03.24-1.A4 
 
Previous Addenda - Revised Sheet; 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-1.A2 

https://gbc-word-edit.officeapps.live.com/we/wordeditorframe.aspx?ui=en%2DUS&rs=en%2DUS&wopisrc=https%3A%2F%2Fctgovdot.sharepoint.com%2Fteams%2FCTDOTCompass%2F_vti_bin%2Fwopi.ashx%2Ffiles%2F93ee363021c54ce1943062d5a8bac142&wdpid=487c16e0&wdenableroaming=1&mscc=1&hid=6B6F879F-D00B-B000-6A8C-7969785845BF&wdorigin=Other&jsapi=1&jsapiver=v1&newsession=1&corrid=b75088c3-f1db-4baa-8e2d-096874db130c&usid=b75088c3-f1db-4baa-8e2d-096874db130c&sftc=1&instantedit=1&wopicomplete=1&wdredirectionreason=Unified_SingleFlush&rct=Medium&ctp=LeastProtected#_Downloading_the_Bluebeam
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Previous Addenda - Added Sheet; 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-2.A2 
 
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the 
previous sheet number plus .A#, where # equals the addenda number. 
 
Original Final Plan Sheet; 
 
 Original Last Sheet:  04.31 
 Addenda 3:   04.32.A3 

The new subset shall be submitted by an Addendum and be  prepared the same way as an FDP 
discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed, 
directly above the right hand corner of the title block, on the sheets stating “ NEW SHEET 
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number.  This note is a stamp in 
the CTDOT Miscellaneous tools in the Bluebeam tool chest that needs to be added and edited.  
If you do not have these tools in the tool chest you can find them in Appendix A of this manual.  
The label attribute on the new subset shall contain a “_A##”.   The first sheet of a new subset to 
the contract will be a subset cover sheet and contain an index of drawings.   Also the DO NOT 
update the project title sheet in the General subset to show the addition of new subsets to the 
project.   

Sheets submitted within final design plan subsets and addenda subsets shall UNOT be deleted; 
but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This 
addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED 
BY ADDENDUM NO.”Y"; where "Y" equals the addendum number.  See Section 7.4   

Contract Special provisions that are revised or added due to addenda shall be submitted digitally 
in accordance with Section 4.5 

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance 
with the following. 
 
The Addendum for a standard subset shall only include the added sheets, do not include all the 
standards for the project.  Follow Section 4.4 to prepare the standard subset, only include the 
added sheets and check off only those sheets on the index sheets.  
 
When uploading to ProjectWise, add an “A##” to the end of the label attribute.   
 
Update the 02-Revision subset to record this change.  

 Design Initiated Change Order (DCO) 
Design Initiated Change Orders (DCO) are change order requests in which the designer alters the 
original contract by: 

https://gbc-word-edit.officeapps.live.com/we/wordeditorframe.aspx?ui=en%2DUS&rs=en%2DUS&wopisrc=https%3A%2F%2Fctgovdot.sharepoint.com%2Fteams%2FCTDOTCompass%2F_vti_bin%2Fwopi.ashx%2Ffiles%2F93ee363021c54ce1943062d5a8bac142&wdpid=487c16e0&wdenableroaming=1&mscc=1&hid=6B6F879F-D00B-B000-6A8C-7969785845BF&wdorigin=Other&jsapi=1&jsapiver=v1&newsession=1&corrid=b75088c3-f1db-4baa-8e2d-096874db130c&usid=b75088c3-f1db-4baa-8e2d-096874db130c&sftc=1&instantedit=1&wopicomplete=1&wdredirectionreason=Unified_SingleFlush&rct=Medium&ctp=LeastProtected#_Downloading_the_Bluebeam
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• A revision to an existing plan sheet(s) or specification(s) 

• The addition of a new plan sheet(s) or specification(s) 

• The deletion of an existing plan sheet(s) or specification(s) 
 
The creation and management of DCO’s shall be as specified in this section. 
 
Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF 
discipline subset(s) containing only the added or changed sheets. The sheets being revised or 
deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset 
shall be digitally signed in a digital signature place holder, that is placed in Bentley Software as 
described in Section 5 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO 
subset(s) shall be submitted to the CTDOT using COMPASS.   
 
The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being 
revised by DCO shall NOT be modified except when the Engineer of record places a DCO stamp 
on the revised sheets.  This digital DCO stamp crosses out the entire sheet with a red X and adds 
the following note: “THIS SHEET REPLACED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – 
mm/dd/yy” where “Y” equals the Design Initiated Change Order number.  This stamp is placed 
over digital signatures.  
 
Warning:  When placing the stamps, removing the digital signature is not allowed. 
For this process see Section 7.4. 
 
The Index of Revision Sheet(s) located in the 02-Revisions subset shall be updated by the project 
manager for all DCOs, and submitted as described in Section 7.3 
 
A watermark of the signer’s signature; signature only for CTDOT-designed plans; or PE Stamp for 
Consultant-designed plans shall be placed on all DCO sheets.  
  
Paper copies for all change orders will be requested and sent to all applicable units following 
Section 3.2.7 

Bentley Software Processes 
The areas on the sheet that are being revised shall encircled by a cloud and a numbered triangle 
shall be placed somewhere on the line of the cloud.  A like-numbered triangle shall be placed in 
the revision block of the changed sheet, accompanied by a description of the revision itself.  The 
revision number is specific to a particular sheet and is specific to the number of times a sheet is 
changed, including addenda changes. It starts with one and increases by one for each revision or 
change to the sheet.  If a sheet is changed for the first time under DCO #5 then the sheets 
revision number is 1 since this is the first change.  If the next time it is changed again is under 
DCO #7 the revision number becomes 2 since this is the second change to the sheet. 
 
Details shown on the original sheet, but are no longer required, shall not be deleted but shall 
only be crossed out with an “X” on the revised sheet.  Engineering judgment must be used to 
produce clear and concise information for the contractor. 
 
If the number of changes to the sheet cannot be clouded in a clear and concise manner, the 
existing sheet should be voided. 
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Bluebeam Processes 
A note shall be placed directly above the right-hand corner of the title block of the replacement 
sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy,” where “Y” equals the 
Design Initiated Change Order number.  This note is a stamp in the CTDOT Miscellaneous tools in 
the Bluebeam tool chest that needs to be added and edited.  If you do not have these tools in 
the tool chest you can find them in Appendix A of this manual.   
 
Sheet numbers for revised plans shall be as follows: 

Description Sheet No. 
Original Final Plan Sheet 02.25 
DCO 1 02.25.C1 

 
Previous Addenda Sheet 02.25.A2 
DCO 4 02.25.C4 

 
Previous DCO 2 Sheet 02.25.C2 
DCO 4 02.25.C4 
  

Drawing numbers shall not be modified on revised sheets. 
 
Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp 
(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 
5. 

Bentley Software Processes 
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one 
of two ways, as follows: 

1. If the new sheet does not have to be placed in a specific location within a discipline 

subset, the new sheet shall just be added to the end and numbered sequentially from 

the previous last sheet of the discipline subset.  The total number of sheets noted on the 

project plans and discipline subsets stays the same.   

 
2. If the designer determines that the new sheet belongs in a specific location within a 

discipline subset, the new sheet number shall be the number of the sheet it most closely 

relates to followed by (-1.C#).  For example, if the new drawing should reside in the 03-

Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet 

shall be numbered 03.57-1.C#. 

 
The total number of sheets noted on the project plans stays the same.  A note shall be 
placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE 
ORDER NO. “Y” – mm/dd/yy,” where “mm/dd/yy” equals the month, day and year the 
change order request was submitted.  This note shall be located directly above the 
bottom right hand corner of the title block.  This note is a level in Bentley Software that 
needs to be turned on and edited. 
 
When adding a new sheet a new drawing number is also required.  The drawing number 
of the new sheet shall be the drawing number of the sheet it most closely relates to 
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followed by (-#).  For example, if the new drawing must be placed in the project plans 
right after drawing number HWY-10, the drawing number shall be HWY-10-1. 

Bluebeam Processes 
A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED 
CHAGNE ORDER NO. “Y” – mm/dd/yy,” where “mm/dd/yy” equals the month, day and year the 
change order request was submitted.  This note shall be located directly above the title block.  
This note is a stamp in the CTDOT Miscellaneous tools in the Bluebeam tool chest that needs to 
be added and edited.  If you do not have these tools in the tool chest you can find them in 
Appendix A of this manual.   
 
Added sheet numbers shall be as follows: 

Description Sheet No. 
Original Final Plan Sheet 04.31 
DCO 3 04.31-1.C3 

 
Previous Addenda Sheet – Added Sheet 03.24.A1 
DCO 4 03.24-1.C4 

 
Previous DCO – Revised Sheet 02.45.C1 
DCO 2 
 

02.45.C2 

Previous Addenda – Added Sheet 05.14-1A1 
DCO 2 05.14-2.C2 

 
Previous DCO – Added Sheet 02.45-1.C1 
DCO 2 02.45-2.C2 
  

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the 
previous sheet number plus C#, where # equals the Design Initiated Change Order Request 
number. 

Description Sheet No. 
Original Final Plan Sheet 04.5 
DCO 1 04.6.C4 

New subsets shall be submitted by DCO and prepared the same way as a FDP discipline subset 
except  with the addition of a C# in the sheet numbers and an note placed, directly above the 
right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED BY 
DESIGN INITATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design Initiated 
Change Order number.  This note is a stamp in the CTDOT Miscellaneous tools in the Bluebeam 
tool chest that needs to be added and edited.  If you do not have these tools in the tool chest 
you can find them in Appendix A of this manual.  first sheet of a new subset will be a subset 
cover sheet containing an index of drawings contained in that specific subset. 

Contract sheets are never deleted. Sheets submitted within final design plan subsets, addenda 
subsets, or design initiated change order subsets that are no longer needed shall NOT be 
deleted, but shall be voided by the engineer of record, with a DCO stamp. The voided stamp 
crosses out the entire sheet with a red X and adds the following note:  “VOIDED BY DESIGN 
INITATED CHANGE ORDER NO. “Y” – mm/dd/yy,” where “Y” equals the Design Initiated Change 
Order number.   

https://gbc-word-edit.officeapps.live.com/we/wordeditorframe.aspx?ui=en%2DUS&rs=en%2DUS&wopisrc=https%3A%2F%2Fctgovdot.sharepoint.com%2Fteams%2FCTDOTCompass%2F_vti_bin%2Fwopi.ashx%2Ffiles%2F93ee363021c54ce1943062d5a8bac142&wdpid=487c16e0&wdenableroaming=1&mscc=1&hid=6B6F879F-D00B-B000-6A8C-7969785845BF&wdorigin=Other&jsapi=1&jsapiver=v1&newsession=1&corrid=b75088c3-f1db-4baa-8e2d-096874db130c&usid=b75088c3-f1db-4baa-8e2d-096874db130c&sftc=1&instantedit=1&wopicomplete=1&wdredirectionreason=Unified_SingleFlush&rct=Medium&ctp=LeastProtected#_Downloading_the_Bluebeam
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Special provisions shall be created in accordance with the Department's policies and procedures 
for Contract Development. 

A DCO Memorandum from the Designer to Construction shall be prepared for all change orders.  
This memorandum shall not include any digitally signed DCO plans and / or DCO specifications.  
The digitally signed DCO plans shall be uploaded into the 100_Contract Plans folder in COMPASS 
and the DCO special provisions shall be uploaded into the 110_Contract folder in COMPASS.  The 
memorandum shall include the following: 

• A detailed description and justifications of the changes requested. 

• Identify the funding source, if known. 

• A listing of each new, revised, replaced and / or voided plan sheet(s). 

• A listing of each new, revised replaced and / or voided special provision(s). 

• A list of the changes in the estimated quantities for the project (increase, decrease).  

The list should also include any item that is new to the project or any item that is 

deleted as a result of the revised work.  Item numbers of items already in the project 

should be provided.  Item numbers for items that are not currently in the contract 

should be provided if known. 

• The estimated increase in cost or credit associated with the change order request. 

The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the 
following. 
 
The DCO for a standard subset shall only include the added sheets, do not include all the 
standards for the project.  Follow Section 4.4 to prepare the standard subset, only include the 
added sheets and check off only those sheets on the index sheets.  
 
When uploading to ProjectWise add a “C##” to the end of the label attribute.   
 
Update the 02-Revision Subset to record this change.  

 02-Revisions Subset 
The project manager is responsible for managing this subset.  The subset can be downloaded 
from these links: 

CTDOT Designed Projects - 02-Revisions Subset 
  Consultant Designed Projects -  02-Revisions_CE_Subset  
  
Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions 
Sheet(s)”.  These revision sheets are used for tracking all sheet changes due to addenda (ADP) 
and Design Initiated Change Order (DCO) with respect to the entire project.  The 02-Revisions 
subset starts out as an un-signed blank place holder in the project.  The figure below is an 
example of a blank 02-Revisions subset: 

https://portal.ct.gov/DOT/Contract-Development-and-Estimating/Contract-Development
https://portal.ct.gov/DOT/Contract-Development-and-Estimating/Contract-Development
https://portal.ct.gov/-/media/DOT/documents/AEC/02-revisions_ctdot.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/aec/02-revisions_ce.pdf


 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 117 Version 5.01 
     

 

Figure 127 - Blank 02-Revisions Subsets 

ADDENDA: 
When the project requires an Addendum, the Project Manager must record these changes on a 
NEW 02-Revisions_A## subset, where A## equals the Addendum ##.  New 02-Revisions subsets 
shall contain all previous Addendum information.  For example, Addendum 4 shall include all 
changes made from Addendums 1, 2, 3 and 4.   
 
Note: A New 02-Revisions subset is required for each addendum because there are times when 
multiple addendums are being submitted to processing for the same project.  An example of this 
is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two 
addendum revision sheets must be submitted. 
 
DESIGN INITIATED CHANGE ORDER: 
When a project requires a Design Initiated Change Order (DCO), the following process shall be 
followed: 
 
For each DCO, the Project Manager shall AMEND the 02-Revisions subset.  The 02-Revision 
subset shall always contain all previous Addendum information and the new DCO information.  
For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum 
information as well as the changes made for DCO #1. 
 
The following figures are an example of the “Index of Revisions Sheet(s)” completed up to 
Addendum #3:  
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Figure 128 - Index of Revisions Sheet 

Detail A from figure 1 shows the information typed in for a change to the contract plans.  The 
project designer inputs the Addendum or DCO number, the sheet number, the date, a 
description of the change, the person who made the change, and checks the appropriate box 
for: new sheet added, revised sheet or deleted sheet.  

 

Figure 129 - Detail A 

Detail B from figure 1 shows the title block information.   

 

Figure 130 - Detail B 
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Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project 
Manager as follows: 

1. The user will export/download the latest 02-Revisions subset out of ProjectWise to their 
local computer.   

2. With your digital signature USB key inserted within the USB, right click on the Signature 
Box and select Clear Signature as shown below, this is the first Addendum this step can 
be skipped since the subset will not have a signature on it:  

 
Figure 131 Clearing the Digital Signature 

 

3. Enter the information into form fields as described in Section 7.3.4.  

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the 
title block, where Y = the Addendum number.   

5. Add new revision sheet each time previous sheet becomes full.  Add note “NEW SHEET 
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number.  Follow Section 
7.3.3 of this document.   

6. When finished sign using a certifying signature as shown in Section 5.6.2 

7. Upload the document into ProjectWise. 

8. Attribute the subset:  Main Category = CON, Sub-Category = ADP, Label = 02-
Revisions_A## 

9. Make the document description 02-Revisions_A##. 

The following workflow shall be used by the Project Manager for recording DCOs to the 02-
Revisions subset.  In this workflow the user edits the subset in COMPASS, they do not have to 
export the document out and submit a new subset: 

1. Check out the 02-Revisions subset from COMPASS 

2. With your digital signature USB key inserted within the USB, right click on the Signature 
Box and select Clear Signature as shown below, this is the first Addendum this step can 
be skipped since the subset will not have a signature on it:  
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Figure 132 Clearing the Digital Signature 

 

3. Enter the information into form fields as described in Section 7.3.4.  

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y - 
mm/dd/yy” 

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET 
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” 

6. Resign the 02-Revision subset in accordance with Section 5.6.2 

1. Download a new “Index of Revisions sheet” from Section 7.3. 
2. Insert the new sheet into the existing 02-Revisions subset pdf.  Update the title block 

information and update the sheet accordingly.   

To fill out a form field simply click on the box and begin typing. The first column is the 
Addendum or Design Initiated Change Order. The second column is the revised or new sheet 
number. The third column is the date, followed by a brief description that is similar to the 
description on the actual sheet being revised. Finally click in the appropriate check box per row 
to describe the action taken, new sheet, revised sheet, or sheet deleted.  Note:  The Engineer is 
not required to input changes numerically by Sheet No.  If another changed sheet is added to an 
Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of 
Revisions Subset”.    

 

Figure 133 Modifying the “Index of Revisions Subset” 
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 Placing Stamps on Affected Sheets – Revised, 

or Deleted Sheets 
A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that 
are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using 
Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or 
in Markup>Stamps as shown below:    
 

 

Figure 134 - Addendum and Change Order Stamp 

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User 
Profile as shown in Appendix A.  If you do not have the stamp in the Markups>Stamp area, see 
Appendix A – Bluebeam Stamps   
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
XTable 4-1 below lists the notes that shall be used for addenda, construction order requests, and 
as built notes. These notes should be used in conjunction with the cross-out stamp.  
 
The following shows how to apply the stamp to the sheet that needs to be crossed out for an 
Addendum or Change Order.   
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1. Select the stamp from the Tool chest or Markup>Stamps and place it:z

 

Figure 135 - Addendum and Change Order Stamp 

2. After the stamp is placed a box will pop up.  Enter the applicable note from table 4-1 
below in all caps as shown below: 

 

Figure 136 - Enter Note for Addendum and Change Order Stamp 

Table 7-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts 

Addendum Notes Description of Use 

THIS SHEET REPLACED BY ADDENDUM NO. Y The revised sheet is considered to replace, in 
total, the original sheet. 

VOIDED BY ADDENDUM NO. Y Sheet is voided by Addendum. 

  

Design Initiated Change Order Notes Description of Use  

THIS SHEET REPLACED BY DESIGN INITIATED 
CHANGE ORDER NO. Y – mm/dd/yy 

Used for revisions to existing sheets. Changes 
must be noted only on the revised sheet.     

VOIDED BY DESIGN INITIATED CHANGE 

ORDER NO. Y – mm/dd/yy 

Use this for voiding of existing sheets. 

 
3. The following shows a completed stamp. 
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Figure 137 Typical Sheet Replaced by Addendum 1 

 

 

Figure 138 Typical Sheet Replaced by DCO 
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 As-Built Comments - Final Plans 

As stated in the CTDOT’s Construction Manual chapter 1-314 “As-Built Drawings and Final 
Revisions of Plans (As-Builts)”, it is the responsibility of either the Contracting Engineers 
(Consultant Inspectors) or State Forces (Office of Construction) to perform final as-built revisions 
of Contract Plans.  As-Built revisions shall be recorded in accordance with Chapter 1-314 of the 
Construction Manual, amended as follows: 

Final as-built revisions will be applied to the digitally signed PDF plans as a digital 
comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed 
over the top of the digital signature and its security, therefore, the original content of 
the PDF plans can never be altered. Because as-built comments are digital and placed 
over the top of the plans they are easily recognizable, searchable, and may be turned off 
if necessary. 

As-built comments shall be applied to the latest sheet, whether it’s the original, 
addenda, or construction order plans, located in ProjectWise within the project’s 
100_Contract Plans folder.  

If additional As-Built information has been created, (information that cannot be placed 
on the digitally signed contract plans), these sheets shall be combined by subset number 
and uploaded into the 100_Contract Plans folder in ProjectWise.  

CAD drawings may be updated, at the discretion of each design office, to reflect any 
addenda, change orders, and as-built revisions for use in the future; however the 
original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set 
for permanent records.  

 As-Built Revisions (Digital Comments) Workflow 
Two methods for applying as-built revisions to the digital PDF plans are provided in the following 
sections; 5.1.1 and 5.1.2.  
 
The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on 
their record set (paper copies) during construction. Once construction is completed these 
revisions shall then be applied as comments to the digital PDF per the workflow in Section 8.1.1. 
 
The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built 
revisions on their record set (paper copies), and shall apply them as comment to the final set of 
digital PDF plans on an intermittent bases, during construction. By using this method as-built 
information becomes available to all parties that have access to ProjectWise during the 
construction process, improving communication and transparency.  
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As-Built Workflow 

 
Step Personnel  Task 

1 Chief Inspector Notify the Contracting Engineer or Designated District Staff that 
As-Builts can be applied to the Contract Plans. 

2 Contracting Engineer 
or District Staff 

Apply As-Built revisions to the Contract Plans in accordance 
with Section 8.3 

3 Contracting Engineer 
or District Staff 

Notify all applicable personnel list in the Section 8.4.2 that the 
As-Builts have been completed for this project. 

 

 As-Built Markup of Contract Plans 

All as-built information will be placed using a few basic Bluebeam commenting tools.  These 
tools include text tools, line and arrow tools, and stamp tools (all other tools will still be 
available under the main toolbar).  These tools will be in the right-hand panel under “CTDOT As 
Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile): 

 

Figure 139 - As-Built Commenting Tool 
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 Applying As-Built Comments to Contract Plans 

All CTDOT users are required to complete the steps in Appendix A prior to applying as-built 
revisions. By completing these steps as-built revisions will be standardized across the all 
CTDOT users.   These steps only need to be completed the first time using Bluebeam or when 
the user logs into a new computer. 

• Perform the initial login steps for Bluebeam.  Initial Log Into Bluebeam 

• Download the CTDOT Bluebeam profile.  Download CTDOT Bluebeam Profile 

• The user must have a ProjectWise login/password.  Contact Julie Annino if you do 

not have a ProjectWise Username and Password. 

The contract plans are located in the 100_Contract_Plans folder of the project in ProjectWise, as 
shown below: 

 

Figure 140 - Location of the Contract Plans in ProjectWise 
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1. Login into ProjectWise, then browse to the 100_Contract_Plans folder of the project you 

are working on.   

2. To open a document with Bluebeam right click on the document, and select “Open 

With” as shown below: 

 

Figure 141 - Open With Bluebeam 

3. Select the Bluebeam icon and check “Always use this program” and select OK.  The 

document will now be checked out of ProjectWise and open with Bluebeam: 

 

Figure 142 - Open with Bluebeam 

Note:  Since we checked “Always use this program”, the next time you open a pdf in 
ProjectWise all you need to do is double click on the file. 
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4. After the As-Builts are applied to the contract plans click save in Bluebeam and then 

select “Check In” when a ProjectWise dialog box pops up.  If the document is not 

checked back into ProjectWise the As-Builts will not be uploaded to ProjectWise.   

Construction Started & Completed Dates 
The construction started and complete date stamps must be applied to the PDF title sheet, 
located in the 01_General subset, as stated below: 
   

1. Select the ”Construction Started and End Dates”: stamp from the  “CTDOT As Built 

Tools” tool box and place it at a conspicuous location on the title sheet: 

 

Figure 143 - Construction Started and Completed Date Stamp 

2. Enter Start and end and click OK as shown below: 

 

Figure 144 - Entering the Dates for the Stamp 

 
Below is an example of the placed stamp: 
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Figure 145 - Placed Stamp 

This Sheet Not Corrected Stamp 
This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail 
Estimate Sheets must never be revised; therefore, they always receive this stamp. 
 

1.  To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select 

that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand 

corner of the sheet, by clicking once. 

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to 
every sheet included in plan set, including the as-built revised sheets, and then go back and 
remove it from the sheets that were corrected.  
 

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that 

stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner 

of the first sheet in the plan set: 
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Figure 146 - Placing the "This Sheet Not Corrected Stamp" 

2. Right click on the stamp that was placed and select “Apply to All Pages”: 
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Figure 147 - Placing the Stamp on All Pages 

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the 
pdf set.   
 

NOTE:  You must go back and replace this note on the sheets that contain as-built revisions 
with the appropriate stamp.  
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This Sheet Corrected 
This stamp must be applied to all PDF sheets that contain as-built revisions.  
 

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that 

stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand 

corner of the sheet, by clicking once. 

If the majority of the sheets contain as-built revisions it is easier to apply this note to every 
sheet included in plan set, including sheets that do not contain as-built revisions, and then go 
back and replace it, with the appropriate stamp, on the sheets that were not corrected.  
 

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp 

from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the 

first sheet in the plan set: 

2. NOTE:  You must go back and replace this note on the sheets that do not contain as-
built revisions with the “THIS SHEET NOT CORRECTED” stamp.  

To place an as-built revision, simply select any of the provided tools located within the as-built 
tool box shown below and apply it to the document that is being as-built.   
 

 

Figure 148 - As-Built Tools 

In the following example, the Line tool was used to cross out the existing text and the Text Box 
tool was used to add text:  
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Figure 149 - As-Built Note Example 

Do not add a note to a comment by double clicking on the comment.  For example, if a line 
was placed the user could double click on the line and add notes to it: 

 

Figure 150 - Incorrect Way to Add Text 

 If notes are added this way they do not print.  

Digital As-Built Stamps and Notes Using ADOBE 
The following stamp files need to be downloaded to the user’s computer and placed in this 
folder:  
C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\.  This could be 
either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current 
user’s login Username.  If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous 
sentence, if version 10 is used replace with 10.   
Stamp Files 
As-Built stamps.pdf  
 
These stamps are to be placed following Section 8.3 above. 
 
As-Built notes shall be placed on the plans in accordance with Section 8.3 using the Adobe 
commenting tools in the following format: 

1. Text Font shall be Cambria 16, and the color Red. 

2. All line work shall be line width 2 and the color Red. 

 

https://portal.ct.gov/-/media/DOT/documents/AEC/as-builtstamps.pdf
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Additional As-Built Information that cannot be applied to the contract plans can be uploaded to 
ProjectWise for future use.  This information shall be uploaded to ProjectWise in accordance 
with the following: 

1. Combine the additional As-Built information into (1) PDF for each discipline subset.  
For example if the 03-Highway and the 04-Structures set had additional As-Built 
information, 2 separate PDFs would need to be uploaded to ProjectWise.   

2. After the additional As-Built information is combined into their respective files they 
will need to be uploaded and attributed into ProjectWise in accordance with the 
following: 

a. Log into ProjectWise Explorer. 
b. Make sure the Interface “CTDOT_Doc_Code” is selected. 
c. Drag and drop the PDF into the 100 Contract Plans folder in ProjectWise. 
d. Select the advanced wizard. 
e. Click next until you get to the attributes page shown below and assign the 

following attributes: 

• Discipline = CT 

• Main Category = CON 

• Sub-Category = ASB 

• Label = Subset No. and name, for example for the 03-Highway set 
type 03-Highways. 

• Description = Additional As-Built information for…. 

 

Figure 151 - Additional As-Built Information 

f. Then click next until the document uploads.   
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After the As-Builts are completed it is ready for permanent storage a final status will be applied 
to the document as shown below: 
 
Select all the files or one at a time and then right click and select Change State>Set Final Status.   

 

Figure 152 - Set Final Status 

This will lock the file so no one can delete it.  If a user needs to remove the final status contact 
DOT.AECApplications@ct.gov   

If the project limits were changed in construction, the project polygon KML file shall be updated.  
The following shows how to do this. 

1. Browse out to the 170 Row Files folder under the project in ProjectWise and double 
click on the FDP Boundary 

mailto:DOT.AECApplications@ct.gov
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Figure 153 - Project Polygons 

2. Open the file with Google Earth.  It may say KML like below. 

 

Figure 154 - Google Earth 

 
3. After the polygon opens, right click on Style 1 and select properties.  This will allow 

you to edit the polygon. 
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Figure 155 - Editing the Polygon 

4.  Then adjust the polygon as necessary by dragging the red points. 

 

Figure 156 - Adjusting the Project Limits 

5. Then click OK on the properties box. 
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Figure 157 - Adjusting the Project Polygon 

6. Then right click on Style 1 and select Save Place As 

 

Figure 158 - Saving Project Polygon 

 
7.  Name the file construction polygon and save it as a KML file:  



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 139 Version 5.01 
     

 

Figure 159 - Saving a KML 

8. Then upload this file into the 170 Row Files folder in ProjectWise and label the file 
Construction: 

 

Figure 160 - Saving Polygon to ProjectWise 
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 Notifications 

After the as-built information has been completed, the person responsible for the as-built 
revisions shall notify the appropriate Department personnel (via e-mail): 

• Lead Designer 

• Chief Inspector 

• Central Surveys 

• ROW 

• Central Construction 

• Bridge Maintenance (if a structure is on the project)  

• Mathew Calkins and Julie Annino – AEC Applications  
DOT.AECApplications@ct.gov 
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 Contractor Submittals 

 COMPASS Submittal/Transmittal Application 
This section establishes the requirements for, and procedures related to, the submittal and 
processing of Contractor Submissions using COMPASS’s Submittal/Transmittal Application (S&T 
Application). The business processes for Shop Drawings, Working Drawings, and Product Data 
(Catalog Cuts) are defined within this manual. For all other submittal types, please follow 
relevant manuals. It is the responsibility of the Engineering Project Manager to ensure that a 
Contractor Submittal List is populated by all support units.  This list is to be stored in the 
110_Contract_Documents folder in COMPASS to ensure access for all members of the project 
team, including the Contractor.  The list shall include the expected contractor submittals, such 
as but not limited to Shop Drawings, Working Drawings and Product Data. This list will eliminate 
confusion and improve contractor submittal turnaround times.  This list will be maintained and 
amended as needed throughout the duration of construction. 

 
The S&T Application is a custom-built application that enables Contractors to digitally deliver 
documents to the Department for processing. Contractors only need internet connectivity, an 
internet browser and a free Microsoft Office 365 account.  
 
High level S&T Application Functionality: 
 

• Provides free, cloud-based access for the Contractor 

• Cloud-based storage and access for the Department 

• Automatically delivers submittal documents to the appropriate CTDOT staff 

• Ball-In-Court (BIC) submittal review tracking and notification controls  

• Automatic document version control for modified or replaced documents 

• Automatic document storage in correct folders  

• Integrated with Bluebeam  
 
The S&T Application automatically tracks what processing phase the contactor submittal is in 
and who is currently responsible for reviewing the submittal. Staff are tracked using a BIC 
workflow. The processing phase is tracked using the Submittal Review Status. These tracking 
functions will be described in detail below.  
 
Once documents are delivered to the Department, the S&T Application allows Department Staff 
to establish custom BIC review processes that include one or more reviewers. Reviews that 
require multiple staff may be conducted in series or in parallel. Notifications and reminders are 
automatically sent to the appropriate staff using email. Notifications include both instructions 
and links to the submittal documents.  
 
The S&T also automatically creates versions of replaced or modified documents, providing a 
high level of quality control and making finding the latest document easy.   
 
The following fundamental set up is required for each project prior to using the S&T Application: 
 

Action Responsibility 

1. Set-up project site, including item number list Automated / AEC Applications 

2. Set-up COMPASS Project Site Permissions Engineering and Construction PMs 

3. Complete the Approval Matrix Engineering and Construction PMs 

 

https://portal.ct.gov/-/media/DOT/documents/AEC/Contractor-Submittal-List.xlsx


 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 142 Version 5.01 
     

Even though the Submittal/Transmittal Application uses emails to notify staff, staff can also 
monitor project submittal activity by directly accessing the S&T table, as information is live and 
continuously updated. This is also true for staff that have been assigned to the CC list.  

The following section describes how to get to the Submittals/Transmittals home page for your 
project. It also provides a brief description of the homepage layout and navigation functionality.   
 
Getting to the S&T Application: 
 

1. From the Project Landing page, navigate to Project Details page. 

 

Figure 161 - Project Details Button 

 
2. Navigate to the Submittals/Transmittals page 

 

Figure 162 - Submittals/Transmittals Page 

 

 

Figure 163 - S&T Application Home Page 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 143 Version 5.01 
     

Submittals are displayed in a table on the S&T Application page.  We call this list the S&T table, 
see figure above. Submittals may be searched using the search submittal field and filtered using 
the drop down filters. Sorting is also available by clicking the column headers.  
 
The Contractor delivers submittals by clicking the New Submittal button.  Project Managers click 
the Approval Matrix button to launch a user interface that allows them to predefine submittal 
distribution including CCs.  See Approval Matrix for detailed information and instructions. 
 
Submittal table data may be exported to Excel.   
 
To search, enter key words from submittal names in the search field, or select a filter option 
from the various drop-down boxes to filter, or do both.  Press the Reset Filters button to clear all 
search and filter results. 

 
 
To sort columns, select the arrow to the right of each column heading.  Columns can be sorted 
in ascending or descending order. 

 
 
To open a submittal simply click on a specific submittal name or its review status. For example, 
clicking on 0101126 Disposal of Hazardous Waste yields the following details shown in the figure 
below.  Notice the submittal acts like an envelope for any attached document. Various 
attributes and the BIC workflow are also visible. For detailed information regarding the BIC 
workflow, see How to Process a Contractor Submittal. 
 

 

Figure 164 - Submittal Status Review   
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The following five Review Statuses/Submittal Phases are used to track submittals.   
 

1. Process Assignment – Applying Custom BIC Workflow  
2. In Review – Execution of BIC Review Workflow 
3. Revise and Resubmit – Further Action Needed by the Contactor 
4. Complete – No Further action needed – Submittal Fully Processed  
5. Draft – Saved Work - Started but need to finish  

 
Review Statuses for each submittal are displayed on the S&T table under the column heading 
“REVIEW STATUS.”  The fields in this column automatically display and update as the submittal 
owner and any additional reviewers complete their reviews.  Review Statuses are not to be 
confused with the Department’s disposition regarding a specific submittal document.  
 

 

Figure 165 - S&T Table 

 

 

Figure 166 - S&T Table 

The above two figures show an example of an S&T table. You will notice that each review status 
is associated with a person(s) that are responsible for some action. Meredith is responsible for 
establishing the BIC review workflow during the “Process Assignment” phase. Daniel Hoffman is 
assigned as the first reviewer of six per the custom BIC workflow during the “In Review” phase. 
When the Review Status reaches complete the number count becomes blank.  

The Approval Matrix is a project-specific matrix that is completed by the PMs to front load 
Contractor submittal distribution information into COMPASS. It is a component used by the S&T 
application to automatically route contractor submittals the appropriate Department employee. 
 
The Approval Matrix eliminates the need to include submittal delivery information within 
specifications and simplifies the Submittal process for the Contractor. Contractors no longer 
need to manage distribution data.  
 
IMPORTANT - The Approval Matrix must be set up prior to the Department receiving 
submissions. 
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The Engineering Project Manager and Construction Project Manager are jointly responsible for 
preloading the Approval Matrix. They must assign one person to each submittal type listed in 
the Matrix. The person they assign to each submittal type is called the submittal owner, who is 
responsible for receiving and processing any submission with that submittal type.  
 
The PMs are also responsible for defining who shall be CC’d on each submittal type. Staff added 
to the CC list have no required action to complete the review.  Individuals who are added to a 
submittal type CC list are not granted any special privileges or access rights.  They will however, 
receive an email notification each time the following actions take place on a given submittal 
type: 

• New submittal created (Process Assignment) 

• Submittal marked as Revise and Resubmit 

• File(s) replaced in response to a Revise and Resubmit (Process Assignment) 

• Submittal marked Complete 

 

Figure 167 - Approval Matrix 

The submittal owner is the CTDOT/Consultant employee responsible for assigning any reviewers 
(optional), initiating a Bluebeam Studio Session (optional), setting due dates in conformance 
with any contractual obligations, and responding to the Contractor with the Department’s 
Disposition. 
  
Submittal owners are assigned to a specific submittal type in the Approval Matrix. Depending on 
the submittal type, some owners will be Construction staff and some will be Engineering staff. 
 
Because submittal owners are responsible for establishing the BIC custom review workflow, they 
must possess a strong understanding of the business processes associated with their submittal 
type. They must thoroughly understand who performs each step and how much time shall be 
allotted. They must actively check on progress and ensure the submittal review is completed 
and returned within the contractual timeframe.  
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 Setting up the S&T Application 
This section provides directions on how to provide access to project staff, how to complete the 
Approval Matrix, and how to invite the Contractor.  

All individuals who need to access a project site – including CTDOT staff, consultants and 
contractors – must first be granted project-specific access using COMPASS Project Site 
Permissions.  The Engineering and Construction PMs, or those they delegate, are jointly 
responsible for setting up the site permissions at the beginning of a project and maintaining 
them throughout the duration of the project. 

After establishing site permissions, the Engineering and Construction PMs are jointly responsible 
for setting up the Approval Matrix.  To access the Approval Matrix: 
 

1. Navigate to the project in COMPASS.  From the Project Landing page, navigate to Project 

Details. 

 

Figure 168 - Project Details 

 
2. Navigate to the Submittals/Transmittals page. 

 

Figure 169 – Submittals/Transmittals tab 

 
3. Open the Approval Matrix by selecting the Approval Matrix button, located next to the 

New Submittal button. 

 

 

Figure 170 - Approval Matrix Button 
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4. Click in one of the field boxes for a Submittal Type. 

5. Start typing the person’s name in the box under the “To” column and select the correct 

name when it appears.  For consultants who have a ct.gov email address, select the 

user’s company email address, not their ct.gov account.  

6. Repeat for other submittal types. 

7. Click Save before closing the dialog box.  

 

 
 

 

Figure 171 - Update Approval Matrix 

 
In addition to assigning the required submittal owners, PMs may also add staff to the optional 
CC list for each submittal type.  IMPORTANT - In order for staff to receive submittal notifications 
through the use of the CC list the PM must not only add them to the Approval Matrix but must 
first grant them access to the project in COMPASS, as described in COMPASS Project Site 
Permissions. 
 
To add a user to the CC list:  
 

1. First use the same instructions listed directly above to navigate to the Approval Matrix.  
2. Click on the box under the CC column and start typing a name.  Select the name.  Click 

the Save button at the bottom or top of the dialog box.  
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Figure 172 - CC List 

The CTDOT Construction Project Manager (Project Engineer or Chief Inspector) is responsible for 
inviting the Contractor to join the project in COMPASS. Contractors need to be sent a separate 
invitation for each project. 
 
To invite a Contractor to a specific project in COMPASS, follow the steps described in Setting up 
Site Permissions Groups.  Invite the Contractor to the xxxx-xxxx Contractors permissions group.  
The Contractor should accept the invitation following the instructions provided in Accepting an 
Invitation (External Users). 

 How to Process a Contractor Submittal 
Once the Contractor delivers a submittal, the submittal Owner is then responsible for 
establishing and starting the Department’s BIC internal review workflow.  Submittal Owners 
establish who needs to review the Submittal, initiate a Bluebeam Studio Session (optional), set 
due dates in conformance with any contractual obligations, and respond to the Contractor with 
the Department’s Disposition.  

The three types of Contractor submittals identified below are covered in this manual. Although 
they are covered in this manual they are each being precisely defined in your project Contract 
specifications. The following ‘short hand’ descriptions are provided for instructional purposes 
but are not the controlling definitions.  
 
Shop Drawings supplement the information in the contract documents (e.g., plans and 
specifications) and include details, diagrams, etc.  
 
Working Drawings portray the design of an engineered feature required by the Contract that 
was not designed by the Department’s Designer. Working Drawings and supporting information 
are prepared and stamped by a Professional Engineer serving as the Contractor’s designer.  
 
Product Data (Catalog Cut) is product information developed and made available by 
manufacturers, such as product specifications, diagrams, installation instructions, etc. 
 
IMPORTANT - Although, contractors submit other types of submittals to the Department for 
review, only the workflows for the three submittal types are covered by this manual. Please see 
other office manuals and directives as necessary.  

This section summarizes key points related to processing Shop & Working Drawings and Product 
Data Contractor submissions, with a focus on Department responsibilities and coordination. 
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This summary is an overview of the Contractor submittal and internal review processes and is 
intended to be an instructional overview. It is important to understand that the contract 
documents (i.e., including special provisions), not this summary, control the actual requirements 
between the Contractor and the Department, and should be referenced for all project decisions.  
 
Timely, coordinated and effective communication is essential to the successful and equitable 
completion of the Contract. Generally, the Department is required to respond to a Contractor 
submittal within 30 calendar days of its receipt, with 20 additional days allowed to process any 
necessary resubmissions. Special provisions may alter this typical timeline.  
 
Shop Drawings/Product Data along with supporting information shall be submitted by the 
Contractor to the Department and shall be processed by the Department’s submittal owner 
using COMPASS.  
 
Once received it is the owner’s responsibility to ensure that the shop drawing is reviewed, that 
appropriate comments have been made and the Department’s disposition is clearly defined by 
stamping each shop drawing sheet and, at a minimum, the cover sheet of any multi-page 
support documents with the appropriate Department (digital) Action stamp.  

 
Working Drawings along with any supporting information, transmittal, calculations, and 
certificates of insurance, shall be submitted by the Contractor to the Department and shall be 
processed by the Department’s submittal owner using COMPASS. 

 
Once received, it is the Construction District’s responsibility to ensure that the working drawing 
is reviewed, that appropriate comments have been made and the Department’s disposition is 
clearly defined by stamping each working drawing sheet and, at a minimum, the cover sheet of 
any multi-page support documents with the appropriate Departments’ (digital) Action stamp.  

 
It the discretion of the District to decide if they need assistance from the Office of Engineering 
during the review process. Typically, the District will ask the Design Engineer(s) to perform a 
review on Working Drawing submissions involving structures and complex engineering. All 
requests for additional reviews shall be completed in COMPASS. See the Construction Manual 
for guidance for additional reviewers.   

 
When requested by the Construction District, the Department’s Designer(s) from the 
appropriate discipline(s) (e.g., Bridge, Highway Design, and Traffic Engineering) shall review the 
Working Drawing documents, and stamp (with a Review stamp) each Working Drawing sheet 
and, at a minimum, the cover sheet of any multi-page supporting documents.  

 
Each time a reviewer applies a, “Reviewed with Comments” stamp they must also provide a 
comment note that clearly describes the reviewer’s recommended disposition, i.e. exceptions as 
noted, revise and resubmit, or reject.  

  
The Construction District should evaluate the Designer’s comments and recommendations and 
meet with the Designer and/or Contractor to resolve any conflicts. 

 
After considering the Department’s Designer’s review comments and other pertinent 
information, the Construction District will make appropriate adjustments to the comments and 
clearly define the Department’s disposition by stamping each Working Drawing sheet and the 
cover of associated support documents with the appropriate action stamp. 

 
All communications between the Contractor and Construction District and between the 
Construction District and Department Designer shall take place in COMPASS. 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 150 Version 5.01 
     

 
The submittal type the Contractor selects determines which submittal Owner will receive the 
submittal and what internal business process review will be implemented.  Some submittals will 
be processed by Construction, some by Engineering, and some by both. COMPASS’s flexibility 
allows submittal Owners to establish a variety of review workflows. Review workflows for all 
submittal types must adhere to all standard business processes as defined in the Contract, 
issued as directives and defined in office manuals.   
 
IMPORTANT - In order for employees to participate in a review they must first be given access 
to the project in accordance with section 2.6 COMPASS Project Site Permissions. 
 
Contractor Submittals are tracked using the following Review Statuses:   

1. Process Assignment  
2. In Review 
3. Revise and Resubmit 
4. Complete 
5. Draft 

When the Contractor creates a new submittal in COMPASS, the initial review status is “Process 
Assignment.”   
 
In this phase the submittal Owner first reviews the submittal for completeness.  If complete, 
submittal owners establish the BIC review workflow by adding the correct staff; setting due 
dates; setting the review order; and, launching a Bluebeam Studio Session, if needed.  Once the 
submittal Owner presses the Start button the review status changes from Process Assignment to 
“In Review.” 
 
Submittals may be reviewed by a single reviewer (the Submittal Owner only) or by multiple staff, 
including the submittal Owner. Either option always requires the owner to be the last reviewer. 
Being the last reviewer allows the Owner to complete the workflow. 
 
If any upper management need to be part of the review, simply add them during this phase in 
the correct review spot based on the submittal type needs.   

Is the Submittal Complete? – Initial Assessment  
The submittal Owner will perform an initial cursory assessment of the submittal before 
beginning the review cycle.  The initial assessment shall validate if the correct documents are 
attached, the documents are complete, are signed, are in the correct file format, etc.   

Complete Submittals 
If the submittal Owner deems the assessment satisfactory, the submittal Owner will establish 
the review process to be used for the specific submittal documents from the following list 
provided below.  If the assessment is deemed unsatisfactory, see Incomplete Submittals.  
 
One of the following review options may be used:  

1. Single Reviewer – The submittal Owner is the only person to review the submittal 
documents. 

2. Single Reviewer – The submittal Owner performs an expedited review by pressing the 
Bypass Approval & Complete button.  This is relevant for submittals that only require 
acknowledgement of receipt and will not need to undergo a Revise and Resubmit 
process.   
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3. Multiple Reviewers – The submittal Owner will review the submittal documents along 
with additional reviewers, including any reviewers that need to approve the submittal.  

Single Reviewer 
1. The Submittal Owner will open the submittal by clicking the submittal name or review 

status in the S&T table. 
  

 

Figure 173 - S&T Table 

2. Enter the appropriate due date by clicking on the calendar. 
3. Start a Bluebeam Studio Session if needed. 
4. Press the Start button at the bottom of the Submittal Process Assignment window.   

 

 

Figure 174 - Process Assignment 

5. Once the Start button is clicked, the submittal owner will receive an email notification 
and the submittal review status will automatically advance to “In Review” in the S&T 
table.   

Single Reviewer – Expedited Approval  
An expedited approval option is available to an individual reviewer if all of the following 
conditions are met: 

• No other reviewers are needed 

• No Bluebeam Studio Session or document mark-ups are needed 

• The submittal can be accepted and completed as-is with no need for a Revise and 

Resubmit process. 

If such conditions are met, from the Submittal Process Assignment page, the submittal Owner 
may push the Bypass Approval & Complete button. 
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When the Bypass Approval & Complete button is selected, the Review Status automatically 
updates to Complete and the appropriate notification is sent to the Contractor. 

Multiple Reviewers  
A submittal Owner will take the following actions when setting up a review workflow with 
multiple reviewers: 

Start Bluebeam Studio Session 
Submittal owners may choose to set up a Bluebeam Studio Session when requesting additional 
staff to perform a review.  If multiple reviewers are required, it is strongly recommended that a 
Bluebeam Studio Session be used to facilitate a collaborative review.  See Starting a Bluebeam 
Studio Session for details. 

Add Submittal Reviewers 
The following steps show the Submittal Owner how to add additional reviewers and how to 
perform a collaborative review on submittal documents:   
 

1. Click on the submittal name in the S&T table to open the Submittal Process Assignment 
dialog box. 

2. Click the Add Reviewer button.  In the NAME field, type the user’s name you wish to 
add. A list of potential reviewers will automatically generate. 

3. Click on the name you want to select. Repeat as required. 
4. IMPORTANT:  In order for added reviewers to participate they must first be given access 

to the project in accordance with COMPASS Project Site Permissions. 
 

 

Figure 175 - Assigning Reviewers 

Set Reviewer’s Due Dates  
The Submittal Owner is responsible for assigning Due Dates to all added reviewers (including 
oneself).  Selected dates must ensure the submittal review process is complete within the 
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required timeframes as set by the contract documents.  Due Date(s) are displayed in the S&T 
table along with warning icons that warn staff of approaching deadlines (e.g., Due within 7 days, 
Urgent, Past Due, etc.)  

Establish Order of Review  
COMPASS’s flexibility allows Submittal Owners to establish a variety of review workflows.  This is 
accomplished by providing Submittal Owners the ability to add additional reviewers and to 
customize the review order accordingly.  Submittal Owners are responsible for establishing the 
workflows for each Contractor Submittal.  The review workflow established by the submittal 
Owner must adhere to all standard business processes as defined in the Contract, issued as 
directives and defined in office manuals. 
 
The Submittal Owner can assign reviewers to review the Submittal documents in series or in 
parallel, and in any order.  To assign reviewers in parallel, set the users’ Order of Review to the 
same number.  To assign reviewers in series, set the order of review as desired.  Any 
combination of review order can be established. 
 
Reviewers may be removed by the Owner by clicking on the trash can icon to the right side of 
the Order of Review column.  By default, the Submittal Owner is always the final reviewer.   
 

 

Figure 176 - Order of Submittal Reviewer(s) 

Once all elements of the review workflow are established, the submittal Owner will press the 
Start button.  At this point the first assigned reviewer(s) will receive an email notification, the 
BIC column will update in the S&T table, and the review status will update in the S&T table to In 
Review. 

Incomplete Submittals 
If the Submittal Owner deems a submittal incomplete or unacceptable because not all the 
required documents were attached, documents are incomplete, or are in the incorrect format 
the Owner will send the submittal back to the Contractor before beginning a review session.   
 
In such a case, the Owner should push the Revise and Resubmit button and should not hit the 
Start button (see figure below).  A submittal only truly begins its content review when the 
submittal owner clicks the Start button. When a submittal is sent back as incomplete, the 
submittal has not been entered into the review phase; the review process and any associated 
timeframe requirements have not begun. 
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Reasons for returning an incomplete submittal before beginning a review session may include, 
but are not limited to:   

• Required digital signatures / contractual obligations are missing 

• Document Submittal form incorrectly filled out (e.g., incorrect Submittal Type or Item 

Number is selected) 

• Document Submittal Type incorrectly selected, causing the submittal to route to the 

incorrect approving party.  Note:  An individual who incorrectly receives a submittal 

should respond to the Submitter / Contractor promptly with instructions to select the 

correct Submittal Type when resubmitting.  

 
 

It is the submittal owner’s responsibility to explicitly define to the Contractor why the submittal 
was deemed incomplete. The Revise and Resubmit button launches the comment box below.  

 

 

Figure 177 - Revise and Resubmit 

 
Below is a sample email notification back to the Submitter / Contractor.  Comments typed in the 
Resubmit Comments window will populate in the email notification.  
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Figure 178 - Incomplete Submittal 

In this phase submittals are reviewed, approved and tracked using the BIC workflow. In order to 
maintain traceability and a high level of quality control all reviews must be completed within 
COMPASS. Reviewers must complete their review within their allotted time. 
 
Each reviewer is responsible for applying the appropriate stamps and comments in accordance 
with Department Directives and manuals. It is the submittal owner’s responsibility to resolve all 
internal comments/disputes and prepare the final documents for the Contractor with the 
appropriate mark-ups and stamps.   
 
Tracking who has completed their review is done in COMPASS. In order to provide this 
information to the Project Managers each reviewer must perform the following steps when they 
have completed their review: 
 

1. Navigate to the submittal through the COMPASS S&T table. 

 

Figure 179 - Review Complete 

2. The Submittal Status Review window will open.  The current reviewer’s name will be 

highlighted in blue in the Submittal Reviewer(s) table.  The eye icon identifies ball-in 

court. 
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Figure 180 - Ball In Court Reviewer 

3. Click the gray Complete button to finish the review and advance to the next reviewer.  

The button will turn green and COMPASS will automatically advance to the next person 

in the BIC/assigned reviewer(s). 

 

Performing a Digital Review  
The Bureau of Engineering and Construction has standardized the use of Bluebeam for all PDF 
workflows.  As such, this manual only provides instructions for using Bluebeam for PDF review 
and commenting. 
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PDF reviews will be completed using Bluebeam (Single Reviewer) or a Bluebeam Studio Session 
(Multiple Reviewers). Reviewers routed/invited to a Studio Session must place all comments 
within the session. 
 
IMPORTANT - All comments must be digital and must be applied directly onto the submittal 
documents. The Contractor shall be able to review and clearly understand the Department’s 
comments and disposition directly from the submittal documents. Prior to commenting you 
must set up Bluebeam by importing the CTDOT Bluebeam Profile, See Appendix A. Once 
completed you are ready to comment. It is the submittal owner’s responsibility to resolve all 
internal comments/disputes and prepare the final documents for the Contractor. 
 
Document links provided in a Contractor Submission automatically route you to the document in 
one of two ways. If the document is in a Bluebeam Studio Session the document link will 
automatically route you to the Studio Session.  
 
If the document is not in a Studio Session the link will simply open the document (non-Studio 
Session). To open the document as a single reviewer without a Studio Session you must first 
integrate your Bluebeam desktop client with O365. To set-up this integration, follow the 
instructions provided in Checking Out Documents to Bluebeam. 
 
Integrating Bluebeam with O365 is a recommended when: 

• The Owner is the sole reviewer and a Bluebeam Studio Session is not needed. 

• Before returning a submittal to the Contractor, the Owner needs to scrub or modify 

review comments applied during a Bluebeam Studio Session. 

  Digital Review using Bluebeam: 
1. Access the S&T Application page  
2. Click on the submittal name to open the submittal and view the documents. The 

Submittal Status Review dialog box will open.   
3. Click on any document name link to open that document 

a. If the document is set to a Bluebeam Studio Session the document link will 
automatically route you to the Studio Session. 

i. The icon shown below indicates that a document is linked to a 
Bluebeam Studio Session.  

b. If the document is not linked to a Studio Session you will still use regular 
Bluebeam to open. See first link below.  

 

 

Figure 181 - Working in Bluebeam Studio 

Once a Bluebeam Studio Session starts for a given document, when reviewers (including the 
submittal Owner) click on the document link, they will automatically be routed to the associated 
Bluebeam Studio Session.  Reviewers are not required to have a Bluebeam Studio account in 
order to participate in a Session.  Submittal Owners are required to have a Bluebeam Studio 
Prime Account in order to start a Bluebeam Studio Session.   
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Figure 182 - Logging into Bluebeam Studio 

If the below message pops up, click Open URL: Bluebeam Protocol.   

 

Figure 183 - Open URL Bluebeam Protocol 

In the Bluebeam Studio Session, select the document to be reviewed.   

 

Figure 184 - Studio Document 

Review, stamp, comment or insert attachments as needed.  The digital review process should be 
conducted in a manner consistent with current business practices and as described below. 

Commenting 
IMPORTANT - All comments and stamps must be digital and must be applied directly onto the 
submittal documents. Prior to commenting you must import the CTDOT Bluebeam Profile, See 
Appendix A. Once completed you are ready to comment. The user shall also ensure that 
standard Department settings are made. Consultant stamps can be found in Appendix D. 
 
Reviewers may print the digital review documents to paper and mark them up, however, when 
done, all paper markups must be transferred from paper to the digital documents.  See 
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Reviewing.  If a unit cannot print their own paper copies they should contact MaryAnn Cass by 
emailing Jackie.Rivera@ct.gov. In the email include the project number and attached documents 
that need to be printed, and include the address of where they are to be mailed.  
 
All comments associated with a review must be applied to the digital documents, such as 
telephone or email comments. 
 
The ultimate goal is to provide clarity and to eliminate confusion.  Be sure to use engineering 
judgment to determine the most appropriate location for placing comments in a document.  
 
General comments may be placed on the first sheet of the document using the note markup 
tool in Bluebeam. This process is detailed in Reviewing. 
 
If a reviewer refuses to participate in the digital review please contact AEC Applications.  

Best Practice – Applying Comments 
There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, 
cloud, rectangle, etc.).  
 
Text/notes can be attached to each type. Text tools already have a note attached; all you need 
to do is start typing. 
 
Non-text tools also have a note attached to them, but you need to double click on it to launch 
the attached note box. The text note box must be closed after the comment is made by clicking 
on the X in the top right corner of the note. The example below shows a note being attached to 
the cloud tool the correct way:  

 

Figure 185 - Correct Way to Add Text to a Non Text Commenting Tool 

Review Stamps 
Review stamps are used for intra-Department (including Department consultant Designers) 
coordination. They are applied by the reviewer to communicate information to the submittal 
Owner and the Department. 
 
An example of use is that each Department Designer(s) must apply a review stamp when 
requested by a Construction District to review Working Drawings.   
 
Review stamps have the following meanings: 
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• Reviewed, No Comments means the Department’s Designer has reviewed the submittal 
and takes no exception.   

• Reviewed with Comments means the Department’s Designer has reviewed the 
submittal and has provided comments. When used on Working Drawings the reviewer 
shall provide a Bluebeam note that identifies the reviewer’s recommended disposition, 
i.e. Exceptions as Noted, Revise and Resubmit or Reject.  

Action Stamps 
The Department uses action stamps (and if appropriate, comments) to notify the Contractor of 
the Department’s disposition. 
 
Action stamps must be placed on each sheet of all working drawing, shop drawing and Product 
Data submittals. They shall also be placed on the cover of any other supporting, multi-page PDF 
documents such as computations.    
 
The precise meanings of action stamps are defined by the contact control of work specifications.  
The following are paraphrased definitions: 
 

 
 

• No Exceptions Noted means the Department’s reviewer has not observed anything in 
the submittal different from what is called for by the Contract requirements and the 
Contractor may proceed, provided that any manufacturer’s warranty called for by the 
Contract can be fulfilled. 
 

• Exceptions as Noted means the considerations or changes noted by the Department’s 
reviewer are required and, after reviewing required changes, the Contractor notifies the 
Department’s reviewer if the changes violate a Contract provision or lessen any 
warranties. The Contractor may proceed with the work covered in in the submittal. 
 

• Revise and Resubmit means the Department’s reviewer has identified and noted 
statements or features that appear different from what the Contract requires. The 
Contractor is required to revise the submittal(s), based on the reviewer’s comments, 
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and resubmit for another review. The Department may take such additional time 
(typically 20 days) to review resubmissions. 

 

• Rejected means the Department’s reviewer has identified and noted one or more 
statements or features that are different from what the Contract requires. The 
Contractor is required to revise the submittal, based on the reviewer’s comments, and 
resubmit for another review. The Department may take such additional time (typically 
20 days) to review resubmissions. 

 

Applying Review Stamps 

Submittal Review Stamp 
1. For CTDOT employees the submittal review stamp is located in the tool chest in 

Bluebeam and should be placed on an open area of the drawing.  For Consultants 

Appendix D must be followed before their stamp is located in the tool chest.   

2. To place the stamp, left click on the stamp in the tool chest and then place it.  All shop 

drawing sheets must be stamped with the action stamp.  Product data sheets only need 

to have the first sheet stamped. 

 

Figure 186 - Placing Submittal Stamp 

3. Next select the appropriate option from the java script window and click OK.   
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Figure 187 - Submittal Review Stamp 

 
4. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging 

a corner as shown below: 

 

Figure 188 - Submittal Review Stamp 

The stamp is now resized as shown below: 
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Figure 189 - Resized Stamp 

 
5. After the review is completed, close the file and click yes to save. 

 

Figure 190 - Saving the Shop Drawing 

6. Repeat the review process for the each drawing/document in the submittal. 
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7. Close Bluebeam when complete.  If the document is in a Bluebeam Studio Session, the 

stamps will save automatically.  If the document is being modified by using the check-

out to SharePoint feature, ensure the document is properly checked back in to 

COMPASS. 

Designer’s Review Stamp 
The designer shall place a Designer’s Review stamp on the working drawing submittal.  The 

action stamp will be placed by District Construction.   

1. To place the Reviewed stamp, left click on the stamp in the tool chest and then place it.  

All working drawing plan sheets shall be stamped with the reviewed stamp.  Calculations 

and supporting documents only need to have the first sheet stamped with the reviewed 

stamp. 

 

Figure 191 - Reviewed Stamp 

2. Then select the appropriate option. 

 

Figure 192 - Reviewed Stamp 
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3. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging 

a corner as shown below:

 

Figure 193 - Resizing the Stamp 

The stamp is now resized as shown below: 

 

Figure 194 - Resized Stamp 
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4. Close Bluebeam when complete.  If the document is in a Bluebeam Studio Session, the 

stamps will save automatically.  If the document is being modified by using the check-

out to SharePoint feature, ensure the document is properly checked back in to 

COMPASS. 

District Construction Review  
After the designer has reviewed the working drawing submittal, District Construction should do 
the following: 

1. Review the designer’s comments and update the comments on the 
drawings/documents as necessary.  District has the final say on what comments the 
Contractor should be able to see.  

2. Stamp each working drawing sheet with the action stamp; stamp the first page of any 
calculations or supporting documents with the action stamp. 

3. Prepare the documents to provide CTDOT’s response back to the Contractor.     
4. Open the file from COMPASS. 
5. To place the action stamp, left click on the stamp in the tool chest and then place it.  

Each plan sheet in a working drawing submittal shall be stamped.  For calculations and 

supporting documents in a working drawing submittal, only the first sheet of those files 

needs to be stamped.  

 

Figure 195 - Placing Submittal Stamp 

6. Next select the appropriate option from the java script window and click OK.   
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Figure 196 - Submittal Review Stamp 

7. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging 

a corner as shown below: 

 

Figure 197 - Submittal Review Stamp 

 
The stamp is now resized as shown below: 
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Figure 198 - Resized Stamp 

 
8. Close Bluebeam when complete.  If the document is in a Bluebeam Studio Session, the 

stamps will save automatically.  If the document is being modified by using the check-

out to SharePoint feature, ensure the document is properly checked back in to 

COMPASS. 

9. Repeat the review process for the each document in the submittal. 

Closing a Bluebeam Studio Session 
When reviewers are complete with a Bluebeam Studio Session review, the Bluebeam window 
can be closed.  Submittal owners will finalize the Studio Session at the appropriate time.   
Submittal owners are to finalize a Bluebeam Studio Session at the appropriate time.  Note:  
Owners should NEVER press the Finalize button from within Bluebeam.  COMPASS Studio 
Sessions should be finalized via COMPASS.  See Bluebeam Studio Session Finalization Process 
for details.  

Completing the Review – Advancing the Submittal 
Once the review is complete there are two options available to move forward.  
 

1. Further action is required by the Contractor 
a. One or more pages of the submittal documents have received a Revise and 

Resubmit Action Stamp or Rejected Action Stamp.  
b. During this process, the submittal Owner should provide supplemental 

comments in the comment pop-up window. These comments should 
correspond with the actual comments applied to the documents during the 
review process.    

  
Once the reviewers have all completed the review and it has been identified that further action 
is required by the Contractor the Owner must click the Revise and Resubmit button. This will 
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change the review status displayed in the S&T table from “In Review” to “Revise and Resubmit.” 
It is the submittal owner’s responsibility to resolve all internal comments, disputes and prepare 
the final documents for the Contractor with only final mark-ups and appropriate stamps.   
 

2. No further action is required by the Contractor  
a. All Action Stamps are either No Exceptions, or Exceptions as Noted 

 
Once the reviewers have all completed the review and it has been identified that no further 
action is required by the Contractor, the submittal owner shall click the Complete button. 
This will change the review status from, “In Review” to “Complete.” 

If a submittal enters into the “Revise and Resubmit” review status, the Contractor will be 
notified via email and the BIC displayed in the S&T table will update accordingly. This is the 
phase where the Contractor makes all the necessary adjustments and resubmits to the 
Department. 
 
Further action may include, but is not limited to, revising a document, adding a document or 
deleting a document.    
 
The Contractor is responsible for reviewing all comments and addressing as needed. For 
documents that need amending, the Contractor shall resubmit the document(s) in COMPASS by 
replacing the existing document with a new conformed document. COMPASS has automated 
Version History, so when the Contractor replaces the document COMPASS automatically creates 
a new version. Versions are stored within the document and are saved in the same location.  
 
Conformed files shall include; all unchanged sheets that received No Exceptions as Noted or 
Exceptions as Noted Action Stamps, and any revised sheets that need to be reviewed. 
 
See Revising and Replacing a File for details. 

A submittal enters the “Complete” phase when the Owner clicks the Complete button.  
The Submittal Owner must click the complete button to finalize the processing of submittal 
documents. The Complete review status indicates that all documents have been processed and 
that no further action is necessary.  A submittal cannot be complete if the Action Stamps Revise 
and Resubmit or Rejected are used.  
 
The Department’s disposition shall be clearly marked by Action Stamps placed on each sheet of 
all working drawing, shop drawing and product data submittals. It shall also be placed on the 
cover of any other supporting multipage PDF documents, such as computations.   
  
The Contractor is responsible for opening and reviewing the final submittal documents to 
determine the Department’s disposition.  The Department’s disposition is not shown as a status 
in the Submittal / Transmittal tool; it shall be communicated using action stamps in accordance 
with this manual and current business processes.   
 
Once a submittal is marked Complete, the action cannot be undone and no further action can 
take place in the submittal workflow.    
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Figure 199 - Complete Review Workflow 

The submittal Owner, Reviewers and Contractor have the option to save their work as a draft 
without advancing the workflow.  In the Process Assignment and Document Submittal windows, 
if the Save button is selected the user’s work will be saved as a draft.  In the 
Submittals/Transmittals table, the Review Status will show as Draft.  The Ball-In-Court will 
remain with the user who selected save.  
 

 

Figure 200 - Save as Draft 

If the submittal Owner incorrectly assigns a reviewer, the assignee should click the Send Back to 
Owner button to return the submittal to the Owner.  A comment should be included explaining 
the reason for sending back the submittal.  Any individual who believes a submittal to have 
been incorrectly assigned is responsible for sending back the document immediately to avoid 
any delays to the processing period. 

 

Figure 201 - Send Back to Owner 

When using COMPASS, submittal Owners and Reviewers may choose to respond to the 
Submitter / Contractor with a letter or memo.  Such a response can be transmitted via 
COMPASS using Bluebeam Revu’s Attachment Tool. 
 
To attach a file inside of a COMPASS document: 
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1. Open the submittal document from COMPASS using a Bluebeam Studio Session or by 

Checking Out Documents to Bluebeam. 

2. Once the document is opened in Bluebeam Revu, go to Tools → File Attachment. 

3. An Open Dialog box appears. 

 

Figure 202 - Bluebeam Attachment Tool 

4. Browse to and select the desired file to send to the Contractor.  Then click Open.  Note:  

Attachments are made individually, so only one file can be selected at a time.  If multiple 

files need to be attached to a submittal document, then a separate attachment can be 

created for each file. 

5. Click on the submittal PDF to place the Attachment icon, a paper clip.  Attachment icons 

can be moved after they have been placed.  Click and drag the icon to move it.  The 

name of the attachment file is revealed when hovered over with a mouse. 

 

Figure 203 - Bluebeam Attachment Icon 

6. When finished inserting attachment(s), finalize the Bluebeam Studio Session or check-in 

the PDF per the applicable instructions for Using Bluebeam to Review Submittals. 

7. If no further action is required by the Contractor, press Complete.  If the Contractor has 

further action or correspondence, press Revise and Resubmit.  The Contractor will be 

able to view and download the original submittal with the response attachment.  This 

response attachment will also automatically save in the Internal Documents version 

controlled folder in COMPASS.  Note:  If using the Attachment Tool, the submittal 

Owner should include a note to the Contractor in the Comments box, notifying the 

recipient that an attachment containing additional information is embedded in the 

document. 

If the review has identified a document(s) that the Contractor must revise and resubmit, the 
Submittal Owner shall respond to the Contractor in COMPASS by clicking the Revise and 
Resubmit button located on the Submittal status review dialog box. COMPASS will automatically 
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notify the Contactor that reviewed documents are ready for consumption and that some portion 
of the original submittal needs to be amended and replaced.  
 
If no portion of the Submittal needs to be revised and resubmitted then the Submittal Owner 
may click the Complete Button, this will automatically notify the Contractor.   

Members of the project Site Owners permission group have the ability to delete a submittal.  
When this function is exercised, all elements of the submittal are deleted, including: 

• Line item in the S&T table 

• Back-up document(s) in the Internal Documents folder 

• Comments and comment log 

Submittals can be deleted when they are in the following workflow stages: 

• Process Assignment 

• In Review 

• Send Back 

Submittals cannot be deleted if they are the Revise and Resubmit or Complete workflow status.   
To delete a submittal: 

1. Select the submittal from the S&T table. 

2. If the submittal is in Process Assignment or Send Back status, select the Delete Submittal 

button located in the lower left-hand corner of the page.  If the submittal is In Review, 

select Edit to see the Delete Submittal option.  

 
 

3. A Delete Submittal confirmation window will appear.  Select Delete to confirm the 

deletion.  Select Cancel to abort the process.  Once the Delete button is selected all 

documents and data for the submittal will be permanently deleted.  This process 

cannot be undone once the Delete button is selected. 
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 Bluebeam 

Bluebeam has built-in integration with SharePoint.  Since COMPASS is a SharePoint site, this 
integration can be used in COMPASS for a single-reviewer who prefers not to start a new 
Bluebeam Studio Session or who needs to scrub a document before it is sent to the Submitter / 
Contractor.  This functionality is a recommended option when: 

• The Owner is the sole reviewer and prefers not to launch a Bluebeam Studio 

Session. 

• Before returning a submittal to the Submitter / Contractor, the Owner needs to 

scrub or modify review comments applied during a Bluebeam Studio Session. 

This process only works when using Internet Explorer as a browser.  The process outlined below 
applies specifically to Bluebeam 2018.  The checking out process should not be attempted while 
a Bluebeam Studio Session is open. 

Set-up Bluebeam Administrator Settings 
To set-up the Bluebeam / SharePoint integration: 

1. From the Start menu, open Bluebeam Administrator 2018.  (See Appendix E:  Bluebeam 

2016 Integration for instructions applicable to Bluebeam 2016.) 

2. On the Plugins tab, click Internet Explorer - Revu 2018 and Checkout SharePoint Files 

on Open.  Press Apply.  Press OK to close the window. 
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Checking Out Documents  
After setting up the Bluebeam Administrator 2018 settings, perform the following steps to 
check-out a COMPASS document and open it directly in Bluebeam without starting a Studio 
Session: 

1. Using Internet Explorer, navigate to the correct submittal in the Submittals/Transmittals 

table. 

2. From the S&T table or Internal Documents folder, select the preferred PDF submittal 

document. 

3. The document will open in Bluebeam.  The SharePoint check-out symbol will appear on 

the document tab.  The user can then edit, mark-up or scrub the document as needed.  

Previous versions of the document are preserved by COMPASS’s Version History 

feature. 

 
4. When complete, press Save in Bluebeam. 

5. Close the document by closing the individual Bluebeam tab or closing the entire 

Bluebeam program.   

6. The Close SharePoint Document window will appear.  Either the Check In or Release 

Checkout button must be pressed to return the document to COMPASS. 

• Press Check In to save any mark-ups or edits and return the document to 

COMPASS. 

• Press Release Checkout if no changes or edits need to be saved to the 

document.  This option does not save any changes or make a new version. 
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Note:  Comments inputted in this window will not be provided to the Submitter / 
Contractor.  Comments intended for the Submitter / Contractor must be added to the 
PDF document itself or inputted in the COMPASS Comment Pop-Up Windows. 
 

 
 

7. Bluebeam will communicate with SharePoint based on the option selected.  If the Check 

In button was selected, a new version saves in COMPASS.  The previous version(s) are 

preserved through COMPASS’s Version History feature. 

 
8. Once the submittal Owner’s review is complete, the submittal Owner needs to take final 

action to communicate with the Submitter / Contractor.  If no further is action required 

by the Submitter / Contractor, the Owner should press Complete in COMPASS to end 

the submittal workflow and a notification email will be sent automatically.  If further 

action is required, the Owner should press Revise and Resubmit and provide comments 

to the Submitter / Contractor. 

Multiple Users Checking Out to SharePoint 
Only one user can check a file out to SharePoint at a time.  If a document is checked out and 
another individual attempts to check out the same document concurrently, Bluebeam will open 
and provide the following message: 

 
To identify the user who has a document checked out via the SharePoint feature, users can 
navigate to the file in the Internal Documents folder.  For Contractor Submittals this location is 
Internal Documents → 120_Contractor_Submittals (PDF).  The name of the user who has a 
document checked out will be listed in document’s row under the Checked Out To column: 
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Bluebeam Studio Sessions allow multiple individuals to collaboratively review, comment, and 
place stamps on submittal documents, all in real time.   
 
Bluebeam has been integrated into COMPASS, therefore submittal owners can start a Bluebeam 
Studio Session directly in COMPASS. In order to initiate a Bluebeam Studio Session, the 
submittal owner must have a Bluebeam Studio account.  To acquire an account please contact 
AEC Applications.  
 
It is the submittal Owner’s responsibility to start and close a Bluebeam Studio Session. However, 
if the submittal Owner is unavailable, others users in the project Site Owners Group may also 
start and close a Session.  A Studio Session can be started during the Process Assignment or In 
Review workflow status. 
 

• Process Assignment 

On the Submittal Process Assignment page (before starting a review processes) the 

Owner can click on the Start Bluebeam Studio Session button located under the 

preferred document.  Clicking the file name prior to launching a Bluebeam Studio 

Session will open the document in the user’s default PDF viewer.  If a Studio Session 

is started the same document link will automatically route reviewers to the 

Bluebeam Studio Session. Once the Studio Session is closed the link will revert back 

to opening with the user’s default PDF viewer.  

 

 

Figure 204 - Start Studio Session 

• In Review 

To start a Bluebeam Studio Session when a submittal is In Review: 

1. Open the submittal by clicking its name. 

2. In the Submittal Status Review dialog box click the Edit button. 
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Figure 205 - Edit Button 

3. Select the Start Bluebeam Studio Session button for the relevant document(s). 

A separate Bluebeam Studio Session must be started for each individual submittal document, if 
needed.   

 

Figure 206 - Start Multiple Studio Sessions 

The submittal Owner is responsible for finalizing all Bluebeam Studio Sessions at the appropriate 
time.  When the submittal Owner determines that a Bluebeam Studio Session is complete, the 
Owner should push the Finalize Bluebeam Studio Session button in COMPASS.  This button 
needs to be pushed for each individual document opened in a Bluebeam Studio Session.  If the 
submittal Owner is unavailable, any person in the site Owners group can finalize the Session via 
the Edit page.  When a Bluebeam Studio Session is finalized, the new document version is 
automatically saved in COMPASS.  Previous versions are preserved through the COMPASS 
Version History feature.  IMPORTANT:  Users should not finalize the Bluebeam Studio Session 
directly within Bluebeam.  The Studio Session should be finalized via COMPASS as described in 
this section.  For more details see Bluebeam Studio Sessions. 
 

 

During a Bluebeam Studio Session, comments may be added to the submittal documents that 
are confidential to CTDOT personnel or Consultants and not appropriate to send to the 
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Submitter / Contractor.  After a Bluebeam Studio Session is finalized, the Owner is responsible 
for reviewing the document and determining whether any mark-ups need to be removed before 
responding to the Submitter / Contractor.  If necessary, the Owner may open Bluebeam without 
starting a new Studio Session by Checking Out Documents to Bluebeam.  This technique can be 
used to reconcile comments and scrub the document as needed before it is returned to the 
Submitter / Contractor.   
 
Once all Bluebeam Studio Sessions for a given submittal are complete, the Owner needs to take 
final action to communicate with the Submitter / Contractor.  If no further is action required by 
the Submitter / Contractor, the Owner should press Complete in COMPASS to end the submittal 
workflow; a notification email will be sent to the Submitter / Contractor automatically.  If 
further action is required, the Owner should press Revise and Resubmit and provide comments 
to the Submitter / Contractor.  These two processes cannot proceed if any Bluebeam Studio 
Sessions are still open.  In such a case, COMPASS will block the process and provide a 
notification message:  “A Bluebeam Studio Session is still open.  Please make sure the 
documents are ready for review by the Submitter / Contractor and close the session before 
proceeding.”     

 Revising and Replacing a File 
When a submittal is returned to the Contractor as Revise and Resubmit, the Contractor is 
responsible for opening the document, reviewing all email comments and mark-ups, and 
responding according to current business processes as described in this manual. 

To open a file, navigate to the appropriate submittal from the Submittals / Transmittals table. 
Select the hyperlink in either the Submittal or Review Status column.  The Review Status will be 
listed as Revise and Resubmit; the Ball-In-Court will list the Submitter / Contractor’s user name.   
 

 
 
When the hyperlink is selected, the Document Submittal window will appear.  This window will 
appear similar to the original window used to create a New Submittal.  The two key differences 
are that the submittal document(s) will appear and there will be a Replace File link under each 
document listed.  To view the submittal document(s), select the file name.   
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If the document is a PDF, it will appear in a PDF viewer.  From the PDF viewer, the document can 
be downloaded and saved to the preferred location (e.g., desktop, server, drive, etc.)  Examples 
of how to save from the PDF viewer are shown below.  The exact appearance and function vary 
by device and browser type. 
 

 

 

Once the comments provided via email and/or in the document mark-ups are reviewed, the 
Submitter / Contractor is responsible for revising the submittal document(s).  The Submitter / 
Contractor should not revise any portion of any documents that have been accepted by the 
Department. 

If the Owner returns a shop or working drawing submittal with different dispositions stamped 
on each sheet, the Submitter / Contractor shall revise individual sheets as needed.  Consistent 
with current business processes, the Submitter / Contractor shall only make modifications to 
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sheets stamped Revise and Resubmit or Rejected; the Submitter / Contractor shall not make any 
modifications to sheets that have been accepted by the Department.  When the replacement 
document is ready to submit, the Submitter / Contractor shall combine the approved sheets and 
replacement sheets in the appropriate order in one file.   
 
To combine approved and replacement sheets using Bluebeam Revu, open the document that 
was downloaded from COMPASS.  Then go to Document → Replace Pages, or press CTRL + 
SHIFT + Y.   
 

 
 
An Open From dialog window will appear.  Navigate to and select the file that contains the 
replacement pages.   
 

 
 
If the replacement pages are contained in separate files, the above process can be repeated 
until the new document is compiled.  Note:  Documents that have been certified or digitally 
signed cannot have pages replaced. 

When the replacement document is prepared, the Submitter / Contractor should: 
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1. Navigate to the appropriate submittal page and click the Replace File button.  Note:  The 

Submitter / Contractor should not respond to a Revise and Resubmit by attaching a 

new document in the Attach File(s) window:   

 
 

2. A document file window will appear.  Select the correct document to upload, then press 

the Open button.  The replacement document does not have to match the original file 

name; it can have any name necessary based on the Submitter / Contractor’s naming 

conventions (e.g., Rev. 1, etc.).    

 
 

3. The File Ready to Replace prompt appears.  The file name in COMPASS remains the 

same, regardless of the name of the replacement file itself. 
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4. If more than one file in a given submittal is to be replaced, press Replace File under each 

document and repeat the process described above.  Ensure that the correct 

replacement file is uploaded to replace the corresponding original document in 

COMPASS.  

 
5. Press Submit to complete the R&R process.  COMPASS automatically saves the 

replacement file in the original document’s Version History.  The Ball In Court will return 

to the submittal Owner.   

 

 Comments 
The COMPASS Document Submittal / Transmittal Application contains two mechanisms for 
providing comments.   

The comment log is accessible to all individuals in the project Site Owners or Site Members 
groups and can be used for any submittal-related communication.  The log can be accessed 
through any of the Submittal / Transmittal windows (e.g., Submittal Status Review, Submittal 
Process Assignment, Send Back, Complete, etc.)  Click the Comments/Log tab to view all 
comments provided on a given submittal and write new comments.  After a new comment is 
typed, press Post to log it.  All comments are automatically date and time stamped and identify 
the entrant.  The comment log is searchable, and a record of the log saves in each COMPASS 
project page. 
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Optional comment windows pop-up when the Ball-In-Court is returning to the Submitter / 
Contractor or when the Send Back button is pushed.  The Owner or Reviewer completing a given 
process can use the comment field to communicate with the recipient.  Once the comment is 
typed in the pop-up, press Submit to log it.  These comments will populate in the email 
notification sent to the recipient and be saved in the Comment Log to maintain a record of 
project communication. 
 

 

 Document Storage 
The Internal Documents section is a SharePoint library attached to each project.  To access the 
Internal Documents library, navigate to the Project Dashboard, Details or 
Submittals/Transmittals page of the selected project.   
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By default, all Contractor submittals are saved to the Internal Documents library, in the file 
named 120_Contractor_Submittals (PDF). 
 

 

All users included in the project Site Owners Group and Site Members Group can view the 
document folders and document versions.  Users in the Site Contractors Group are blocked from 
viewing the document folders. 

COMPASS includes automated Version History.  Every version of each individual document is 
automatically saved in COMPASS.  This includes the original document as submitted, versions 
saved from Bluebeam Studio Sessions, versions saved from checking out to SharePoint and 
replacement files submitted in response to a Revise and Resubmit. 
To access all document versions of a Submitter / Contractor’s submittal: 
 

1. Navigate to the project site. 

2. Go to the Project Dashboard, Project Details or Submittals/Transmittals page. 

3. Select the Internal Documents library on the left-hand side of the page. 
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4. Select folder 120_Contractor_Submittals (PDF) 

 
 

5. Navigate to the document.  Columns can be sorted by Name, Modified (date) or 

Modified By.  Click the ellipses (three dots) to show the drop-down menu associated 

with the preferred document, then click Version history.   
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6. The document Version history shows in a new window.  All versions of the document 

are listed with their associated version number, date and author.  Click on any version’s 

hyperlink to view the version.  When a file has been saved back from a finalized 

Bluebeam Studio Session, it presents as Modified By CTDOT Admin. 
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 Digital Review and Commenting 

(Non-COMPASS Workflows) 

This section details the digital review process using Bluebeam’s collaborative online review tool 
called “Studio”.  The procedures outlined below describe how to:  1) Create a review session, 2) 
Invite people to a session, 3) Join a session, 4)  Comment in a session, 5)  Close the session, and 
6) Respond to comments made in the session. Also, directions for locking the documents after 
the review process to create a read-only final record copy to be stored for future use are also 
provided. 
 
The following link in to a Bluebeam Resources website.  On this website are videos for the Digital 
Review process: Bluebeam Resources  These videos show an overview, but specific details are 
found in this document  

 Introduction 
A digital review is when a document is reviewed in its native digital format or as a digital copy of 
the original paper document.  Any required markups are placed directly on the document using 
a computer with software designed for managing digital reviews.  The documents can also be 
printed from the review session and the paper copy marked up; however, those markups must 
get transferred back to the digital copy.   
Advantages of a Digital Review Compared to Conventional Paper Review 

1. Higher Transparency – Increased Collaboration. 
2. Digital markups are searchable and sortable, by comment, author, etc. 
3. Real time collaboration review process improves turnaround time and quality of the 

review. 
4. Real time feedback allows easier handling of large amounts of data. 
5. Reduces the time required to compile and resolve comments.  
6. Eliminates document mailing time.  
7. Reduces document printing. 
8. Eliminates shipping cost. 
9. Easily store a permanent digital record on the cloud. 
10. Overall reduction in review time. 

 
Types of Reviews: 
This manual may be used as a guide to perform a digital document review on any digital 
document. Below is a list of examples of the types of documents that may be reviewed: 

• Preliminary Design Plans 

• Structure Type Studies 

• Semi-Final Plans 

• Final Plans for Review 

• Special provisions 

• Engineering Reports 
Review Process: 
To help participants of a digital review more easily track the digital review process it has been 
split up into six Phases as listed below: 

• Phase 1 – Preparation of the Digital Documents  

• Phase 2 – Set Up Digital Review 

• Phase 3 – Invite Attendees to Review 

• Phase 4 – Digital Review 

• Phase 5 – Ending the Digital Review 

https://www.ct.gov/dot/cwp/view.asp?a=3194&Q=575834
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• Phase 6 – Resolve Comments 
Each phase and its required steps will be discussed later in detail. 
Digital Comments: 
In this review process, all comments must be applied to the documents in the review session.  
Reviewers have the ability to print the digital review documents to paper and mark them up, 
however, when done, all must be transferred from paper to the digital documents, see Section 
10.7.3.  If a unit cannot print their own paper copies they should contact MaryAnn Cass by email 
Jackie.Rivera@ct.gov.  In the email include the project number and list documents that need to 
be printed, and include the address of where they are to be mailed.  In the case of preliminary 
contract plan reviews, the original digital documents, with comments, will become the final 
record.   
 
All comments associated with a design submission should be applied to the digital documents.  
Telephone of email comments must be applied to the correct digital document by the staff 
member who received them.  Be sure to use engineering judgment to determine the most 
appropriate location for the comments in the document.  General project comments can be 
placed on the first sheet of the document using the note markup tool in Bluebeam. This process 
is detailed in Section 10.7.3.  If any outside entities (railroads or utilities) will not participate in 
the digital review, their comments with your responses should be attached to the final record 
copy in accordance with Section 10.7.3.  It is not necessary to transpose these comments 
individually as all comments can be attached at one time.    
 
FOI Requests 
Contract Document Digital Reviews - After a digital review session has been completed and all 
the comments have been resolved, a read-only copy of the review documents with the 
comments and resolutions will be stored in the 310_Milestone_Submissions folder under the 
project.   

 Prerequisites 
1. CTDOT has standardized its digital review process using the document format PDF, and 

the software Bluebeam.   This software was chosen for the following reasons: 
a. Includes a collaborative live review feature (STUDIO) with real time feedback, 

enabling all reviewers to comment on the same document at the same time out 
on the cloud.     

b. A license for Bluebeam is more cost effective than competitive software like 
Adobe Acrobat.  Thus it is much less expensive to purchase and maintain.  

c. Only the Organizer of the review is required to have a licensed copy of 
Bluebeam. All other attendees can participate in the digital review using 
Bluebeam’s free version, Bluebeam VU. 

d. Bluebeam is integrated with ProjectWise. This simplifies the delivery of the 
original review documents as well as saves the final reviewed copies and their 
comments. 

2. The following table lists the software required to organize and/or participate in a CTDOT 
digital review.  Note:  It is recommended that the latest version of the software be used.  

Role Software 
Organizer – Manages review Bluebeam  Extreme or Revu Standard  and ProjectWise Explorer 

Author – Produces documents ProjectWise Explorer  

Reviewer – Reviews documents Bluebeam  Extreme or Revu Standard or Bluebeam VU* 
*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review).  
When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of 
Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the 
invitation.  Note:  An IT administrator may have to install this software on the computer.  

mailto:Jackie.Rivera@ct.gov
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3. All CTDOT digital review participants are required to complete the steps provided in 
Appendix A prior to organizing or joining a review session.  Completing these steps will 
standardize the Bluebeam format across all CTDOT digital reviews.     

 Digital Review Workflow 

 

Figure 207 

All CTDOT digital review participants are required to complete the steps provided in Appendix 
A prior to organizing or joining a review session.  Completing these steps will standardize the 
Bluebeam format across all CTDOT digital reviews.     
 
Roles 
Organizer – The organizer sets up and coordinates the review session.  For in-house projects this 
would be the project lead and for consultant jobs this will be the Consultant Liaison.  
Author – Group that produces a document(s) for the review. 
Reviewer – Group that participates in the review session to review documents.   
 

Step Role Task Section  

Phase 1 – Preparation and Delivery of the Digital Documents 
1.1 Organizer Coordinate the organization and preparation of the review 

documents.  Request all Authors to upload their review 
documents into ProjectWise. 

Section 10.4 

1.2 Author Prepare and upload review documents into ProjectWise.  
Notify the Organizer that this step has been completed.   

Section 10.4 

1.3 Organizer Check that all review documents have been prepared and 
uploaded correctly into ProjectWise. 

Section 10.4 

Phase 2 – Set up Digital Review 
2.1 Organizer Start a Bluebeam review session and then change the state 

of the review documents in ProjectWise to “Reviewing”. 
Section 10.5 

Phase 3 – Invitation to Review  
3.1 Organizer Create a Digital Review memo, which includes a link to the 

digital review session, and send it to all Reviewers. 
Section 10.6 

Phase 4 – Digital Review 

4.1 Reviewer Join the review session by clicking on the link provided in the 
review memo.  Become familiar with the review session 
layout.   

Section 10.7.1 
and Section 
10.7.2 

4.2 Reviewer Set Status to “Reviewing” Section 10.7.3 

4.3 Reviewer  Review the documents in the Bluebeam review session and 
place comments on documents as necessary.   Documents 
can be printed, marked up, and then comments transferred 

Section 10.7.3 
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the PDFs.  If the documents cannot be printed out, send a 
request to engineering records.  

4.4 Reviewer When finished reviewing, in Bluebeam, Set Status to 
“Finished”  

Section 10.7.3 

4.5 Reviewer Send a Review Comment Memo to the Review Organizer Section 10.7.3 

Phase 5– Closing the Digital Review 

5.1 Organizer Close the Bluebeam review session and check the 
documents back into ProjectWise. 

Section 10.8 

Phase 6 – Resolve Comments 
6.1 Organizer Notify the Authors that they can review the markups on 

their review documents in ProjectWise.  Provide them with a 
link to the folder in ProjectWise.  

Section 10.9.1 

6.2 Author Open the specific document(s) from ProjectWise.   Section 10.9.2 

6.3 Author For each comment on your document, type a final 
resolution.   

Section 10.9.2 

6.4 Author After all resolutions are applied to comments, Notify the 
Organizer that you applied your resolutions.   

 

6.5 Organizer Change the state of the review documents to “Review 
Complete” to make all review documents read only after the 
resolutions have been applied.    

Section 10.10 

6.6 Organizer Send out a Completion of Review Session Memo to all the 
personnel associated with the review session that the all 
comments have been resolved on the documents located in 
ProjectWise.   

Section 10.10 

 Phase 1 – Digital Document Preparation 

Below are the guidelines by which the review documents should be organized: 

Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans - Must be in discipline subsets.  The review Organizer is responsible for assigning 
each Author a subset number in accordance with Section 4.1 Note:  CTDOT Standard 
Subsets cannot be added to a review session because they are combined in a PDF 
Package (Portfolio).  

2. Special provisions – Each discipline shall combine all of their special provisions into one 
(1) PDF document.  Each discipline’s special provisions will remain separate throughout 
the review session; they will not be combined with the other discipline’s special 
provisions.      

3. Other Documents – Shall be individual PDF documents. 
4. All Authors must upload their documents into the 310_Milestone_Submissions folder 

under the project in ProjectWise.  
Other Reviews 

1. The only requirement for the organization of other types of reviews is that the 
documents must be in PDF format.   

Authors shall prepare their digital documents in accordance with the following guidelines: 
Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans: 
a. Must be in PDF format 
b. Plans must be in discipline subsets 
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c. Plans must be sized 34” x 22” 
d. Do not need watermarks, sheet numbers or to be digitally signed. 

2. Special provisions: 
a. Each discipline shall combine all of their special provisions for review into one 

(1) PDF document. 
b. Sized 8.5” x 11” 

3. Other Documents: 
a. Must be in PDF Format 

Other Reviews 

1. Documents: 
a. Must be in PDF Format 

Authors shall upload their digital documents into ProjectWise in accordance with the following: 
For Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Launch ProjectWise and log in. 
2. Browse out to the project this review is for and open up the 

310_Milestone_Submissions folder and the specific review folder:  If the three 
subfolders are not in the project contact Mathew.Calkins@ct.gov  

 

Figure 208 - Projectwise Project 

3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a 
time into ProjectWise as shown below:   

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface.  Then 
you will be able to select the correct Interface.  

mailto:Mathew.Calkins@ct.gov
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Figure 209 - Uploading Documents into ProjectWise 

4. Select Advanced Wizard 

 

Figure 210 - Advanced Wizard 

5. Click next until the attributes screen appears as shown below.  Enter the correct 
attributes and then click next until the document uploads.   
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Figure 211 - Attributing a Document 

For Other Reviews 

1. Launch ProjectWise and log in. 
2. Browse to the folder where the digital documents are to be stored. 
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a 

time into ProjectWise as shown below:   

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface.  Then 
you will be able to select the correct Interface.  

 

 

Figure 212 - Uploading Documents into ProjectWise 

4. Select Advanced Wizard 
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Figure 213 - Advanced Wizard 

5. Click Next until the attribute screen appears shown below. Enter the correct attributes 
for the review documents and then click next until the document uploads.   Make sure a 
good label and description are entered.   

 

Figure 214 - Uploading Documents 

6. Notify the Organizer that the documents have been uploaded into ProjectWise. 

 Phase 2 – Set Up Digital Review 
The Organizer shall set up the review session in accordance with the following:  Note: The 
example below is for initiating a Semi-Final review but can be followed for other types of 
reviews.     

1. Launch ProjectWise Explorer from the shortcut on your desktop or the start menu.   
2. Browse out to the project’s 310_Milestone Submissions folder. (For other reviews 

browse out to the folder in ProjectWise where the documents are located.  Note:  The 
document does not need to be in ProjectWise to use Bluebeam’s Studio feature.)  
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Figure 215 - Preliminary Design Documents Folder 

 
3. Next select all the documents that are to be included in the studio session, right click, 

and select Start Studio Session: 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 196 Version 5.01 
     

 

Figure 216 - Start Studio Session 

4. Using the naming guidelines from the table below, type in the applicable review session 
name in the box entitled “Session Name”. 

Review Review Name 

Preliminary Design (30%) Project #XXXX-XXXX PD Review 

Structure Type Study Project #XXXX-XXXX Structure Type Study Review 

Semi-Final (60%) Project #XXXX-XXXX SF Review 

Final Plans for Review (90%) Project #XXXX-XXXX FPFR Review 

Other Include Project number if necessary and give a good description 
of the review 

 
Also, as shown in the figure below, make sure that all the options are checked.  Note:  Setting 
the Session Expires date is optional.  If set, this date can always be changed after the session is 
created.  
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Figure 217 – Initiating a Review Session  

5. In the next dialog box click copy invitation as shown below.  The invitation will be copied 
to the clipboard of the computer and then can be pasted into an email or memo.   

 

 

Figure 218 - Adding Email Address to Studio Session 

Next paste the invitation into a blank Word Document or email.  The following is an invitation 
that has been pasted into an email.  Note how the session URL appears in blue. Then you can 
copy the URL from the blank document or email into a formal memo.  
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Figure 219 - Session URL 

6. After the session has been created go back to ProjectWise, Select all the documents that 
are included in the session. 

 

Figure 220 - Select Documents to be Included in Bluebeam Review Session 

7. Then change the state of the documents to “REVIEWING” as shown below: 
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Figure 221 - Changing the State to Reviewing 

Then click OK next on the box that pops up.  The documents will now be in the 
Reviewing state. 

 

Figure 222 - State of Documents 

 Phase 3 – Invitation to Review Session 
The Organizer shall invite Reviewers to the review session in accordance with the following: 
For Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 
 
The invitation to the digital review will be a PDF version of a review memorandum that includes 
the following:   

1. A table of all documents that are in the review session.  
2. Links to relevant documents that are not included in the review session but still need to 

be referenced.  These documents shall be located in ProjectWise and ProjectWise links 
shall be included. (Not shown in the example below) 

3. A link to this manual (Digital Project Development Manual) 
4. A link to the Review session.  To do this, paste the invitation that was copied when you 

created the review session.     

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the 
Principal, Supervisor and TE3 level of the reviewing unit where applicable.  It is the Organizer’s 
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responsibility to compile a complete distribution list so the review invitation gets sent to the 
applicable personnel.   Below is an example of a memorandum for a preliminary design review: 
 

 

Figure 223 - Sample Review Memo 

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to 
the end of the review session.   
 
For Other Reviews 
Invitations for less formal reviews may not require a memo.  It is recommended that an email be 
sent which includes the links to this manual and the review session. 

 Phase 4 – Digital Review 

To join a review session, either click on the link provided in the review memorandum for a 
preliminary design review, or for less formal reviews, click on the link in the email.  Below is an 
example of an email for a preliminary design review (semi-final).  Remember the link to the 
review session is included in the memo that was emailed to all the reviewers.   

1. Open the email from the Organizer and open the review memorandum. 
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Figure 224 - Review Memorandum 

2. Click on the link to the Review Session. 

 

Figure 225 - Link to the Review Session 
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3. Click Allow on the box that pops up in Internet Explorer.  Ignore the text written in the 
webpage as shown below:   

 

Figure 226 - Accessing the Review Session 

4. Bluebeam will now launch.  If this is the first time in a review session, a Studio Account 
must be created.  To do so click on Create Account and then enter in a State email 
address and a password.  In the Name box type in the First Initial then Last name and 
unit.  See below for an example.    

 

 

Figure 227 - Creating a Studio Account 

  

Figure 228 - Studio Session Account 
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If this is not the first time in a review session, enter the studio login information as shown 
below:  If you forgot your password click lost password and an email will be sent to you.   

 

Figure 229 - Review Session 

5. If this is your first time into a review session you must import the CTDOT Bluebeam 
Profile, See Appendix A  

Below is the typical layout in the review session.  On the right tab, there are the tool chest for 
commenting, the attendees of the session, and the documents in the session.  On the bottom, 
there are the list of comments.   

 

Figure 230 - Review Session Layout 

All comments that are made get saved instantly to the Bluebeam review session; these do not 
need to be manually saved.  Each user can only delete their own comments and can leave and 
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rejoin as many times as they want as long as the review session has not been closed.  The review 
session will be closed by the Organizer in accordance with the date on the review memo.  

This section shows the procedures for reviewing and commenting on documents in a digital 
review.  Reviewers may print digital review documents to paper by going to File>Print and mark 
them up; however, they must transfer these comments onto the digital review documents in 
accordance with this section.  If a unit cannot print their own paper copies they should contact 
MaryAnn Cass by email Jackie.Rivera@ct.gov .  In the email include the project number and list 
documents that need to be printed, and included the address of where they are to be mailed.      
 
In the case of preliminary contract plan reviews, the original digital documents, with comments, 
will become the final record.   
 
All comments associated with a design submission should be applied to the digital documents, 
including any email or phone call comments.  These types of comments must be applied, by the 
staff member who received the email or phone call, to the correct digital document, use 
engineering judgment to determine the most appropriate location.   
 
General Project wide comments can be placed on the first sheet of the document using the note 
markup tool in Bluebeam as shown below:  Using the note tool you can copy and paste text 
from any source such as an email or a Word document.  This allows larger project wide 
comments to be applied to the plans.    

 

Figure 231 - Note Markup Tool 

mailto:Jackie.Rivera@ct.gov
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Note about Commenting in a Review Session and Supervisor Approvals  
In most cases, the unit that reviews a document has an internal approval process whereby the 
supervisor finalizes the comments from staff members.  The workflow described in this Chapter 
does not specify or dictate an approval process within each unit; rather, it outlines the review 
procedures once the review comments have been compiled from each unit.    Therefore, it is 
important that only the reviewing unit’s final comments be added to the review session.  Once 
the session ends, the comments made in a review session will be considered final.    
 
The following shows a few options for a supervisor approval procedure, but the digital review 
process is flexible for any procedure a reviewing unit develops.  The only restriction is the final 
comments must be placed on the digital documents located in the review session before the 
reviews session ends:   
 

1. A lower level employee can join the session and comment on the documents in the 
review session.  Then the supervisor can join the session and filter out their 
subordinates comments for their review.  If there is an issue with a comment the 
supervisor will have to direct the lower level employee to fix that comment. If there are 
not any issues with the lower level employee’s comments then nothing has to be fixed.  
After the supervisor review, a lower level employee will join the session and fix the 
applicable comments.  In section 10.1 of this manual there is a list of advantages to 
using this digital review process.  With this option, all of these advantages are realized.         
 

2. A lower level employee can join the review session and save a copy of the review 
documents to their computer.  Then they can markup the documents offline and have 
their supervisor approve those comments.  After the supervisor approves the 
comments, those comments can then be imported into the documents in the review 
session. In section 10.1 of this manual there are a number of advantages to this digital 
review process.  With this option, advantages 3 and 4 are eliminated due to the 
comments made offline.     
 

3. A lower level employee can join the session and print the documents in that review 
session.  Then they can markup the prints and have their supervisor approve the 
comments.  After the approval, a lower level employee can transfer the comments to 
the digital documents in the review session.  In section 10.1 of this manual there is a list 
of advantages to this digital review process.  With this option, advantages 3 and 4 are 
eliminated due to the comments made offline.     

 
Notes about Outside Entities that will not Participate in a Digital Review 
If an outside entity such as a railroad or utility company will not participate in a digital review it 
is still important to add their comments to the final record document in ProjectWise.  It is 
encouraged to have these entities participate in the digital review and AEC Applications is 
available to provide support and technical assistance in these efforts.   
 
The following details how the comments from a non-participating entity and your responses to 
those comments shall be attached to the final record document in ProjectWise: 

1. Create a PDF document that includes the non-participating outside entity’s comments 
and your responses to those comments.   

2. Then add the pages from that document to the end of the final record document in 
ProjectWise in accordance with section 10.9.1.    
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Reviewer 

1. First set your review status to Reviewing by clicking on the drop down shown below: 

Note: If you leave the session and return your status will stay as Reviewing.   

  

Figure 232 - Set Status to Reviewing 

2. Next select a document to review from the studio session tab.  The document will open 
up and can be reviewed.  
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Figure 233 - Selecting a Document to Comment On 

3. Select a commenting tool from the tool chest and mark up the plans.  If you do not have 
the CTDOT Review Tools show below, follow Appendix A  to have them imported in the 
Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to 
them in Bluebeam.   
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Figure 234 - Bluebeam Commenting Tools 

Custom tools can also be created.  Contact DOT.AECApplications@ct.gov for custom tool 
development.  
 
MUST READ BEFORE PLACING COMMENTS 
The following shows best practice for applying text notes in a review session.       
 
There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, 
cloud, rectangle, etc.).  Each type can have a note attached to them.  The text tools already have 
a note when you type text, but the non-text tools can also have a note attached to them.  To 
attach a text note to a non-text tool place the comment and then double click on that markup.  
Then you can type in your note.  The text note box must be closed after the comment is made 
by clicking on the X in the top right corner of the note.  The example below shows a note being 
attached to the cloud tool the correct way:   

mailto:DOT.AECApplications@ct.gov
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Figure 235 – Correct Way to Add Text to a Non Text Commenting Tool 

General Project wide comments can be placed on the first sheet of the document using the note 
markup tool located in the tool chest. Text can be copied and pasted into the note tool as 
necessary.  

4. After you have completed your set your status to Finished. 

Note: You can still enter the session if your status is set to Finished.  You can also change your 
status back to Reviewing if necessary.  This status is for the Organizer so they know which 
Reviewers have completed their reviews.   

 

Figure 236 - Set Review Status 

5. Create a review comment report of your comments.  First filter out the comments so 
only your comments are displayed as shown below: 
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Figure 237 - Filtering Comments 

6. Now that the comments are filtered by your name create a comment report as shown 
below: 

 

Figure 238 - Creating a Comment Report 

Next type in a title for the comment report that includes Project No, What review it is plus the 
word “Comments”, and what document this comment report is for.  See below for an example: 
 

Project ####-#### Semi Final Review Comments 03-Highways 
 

Make sure all the settings are set as shown below and click OK: 
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Figure 239 - Comment Report 

7. The comment report will now be created and opened in Bluebeam, leave the comment 
report open in Bluebeam.  We will be copying this report into the comment report 
memo. 

8. Next save the following review comment memo to your computer: Review Comment 

Memo. 
9. Open the memo and fill in the correct information. 
10. Then copy all the pages from the comment report as shown below: 

https://portal.ct.gov/-/media/DOT/documents/AEC/review_comment_memo.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/review_comment_memo.pdf
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Figure 240 - Copying the Comment Report Memo 

11. Then paste the pages into the memo as shown below: 

 

Figure 241 - Pasting the Comment Report Pages 

12. Save the memo and process this memo as your unit requires. 
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 Phase 5 – Closing the Digital Review 
The Organizer will be responsible for closing the review.  The review session will be closed per 
the date on the review memorandum.   

1. Log into ProjectWise and browse out to the review documents folder.   
2. Then select the documents that are in the session that is to be closed, right click on the 

documents, select Change State>Next:  If this step is not performed the session cannot 
be closed.  This will place the documents in the CLOSE REVIEW state.   

 

Figure 242 - CLOSE Review State 

3. Then open up Bluebeam and join your session. 
4. Then Click Finish to close a Bluebeam Review Session as shown below: 

 

Figure 243 - Terminating a Session 
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5. Make sure all the reviewers in the list below are selected (they will be by default) and 
the Save (Overwrite Existing) button is checked and click OK. 

 

Figure 244 - Terminating a Session 

6. Click OK in the figure below. 

 

 

Figure 245 - Overwriting Existing Documents 

7. Close Bluebeam Revu and check in each document to ProjectWise.  Note: A check in box 
will pop up for each document in the review session.   

 

Figure 246 - Checking a Document Into ProjectWise 

8. Notify the Document Authors that the session has been closed so they can resolve the 
comments on their documents. 

 Phase 6 – Resolve Comments 
This section shows how the comments from the review session will be resolved by the 
Document Authors.  After the comments have been resolved in the PDF documents located in 
ProjectWise the Document Author shall notify the Organizer that they have finished applying 
their resolutions to the documents.   
 
Note:  Comments cannot be resolved until the review session has been finished.  The Review 
Organizer will notify the Document Authors when the session has been finished.  If the 
document authors go into the documents located in ProjectWise before the session is finished 
there will be no comments on the documents.   
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All comments on the review documents shall be resolved by the Document Author directly on 
the digital PDF review documents using Bluebeam.  The following shows the steps for resolving 
comments. 

1. Open your document(s) from ProjectWise.   
2. Next select a comment in the comment list and right click.  The select Reply.   

 

Figure 247 - Comment Resolutions 

3. In the box that pops up, type in a final resolution in the following format: 

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.   

Resolution – Type in resolution...No Change to Plans 
 
The resolutions applied to the plans shall be the final resolution decided by the Document 
Author’s unit.  There shall only be one resolution for each comment.   
 
Below is an example of a resolution: 
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Figure 248 - Typing in a Resolution 

Below is an example of how the resolutions will look in the comment list. 

 

Figure 249 – Resolutions 

4. Next attach a PDF document that includes any non-participating entities comments with 
your responses to the review document.  This should be done by adding that PDF 
document to the end of the review document as shown below: 
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Figure 250 - Attaching Comments 

5. Browse out to the PDF document you want to add and then select to insert after the last 
page: 
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Figure 251 - Adding Comments 

6. When all the resolutions have been applied, make sure to save the documents and 
check them back into ProjectWise.  

7. Notify the Review Organizer that you have completed your resolutions.   
8. Send out Completion of Review Memo to all the personnel associated with the review 

session indicating that the review session is over and all comments have been resolved 
on the documents in ProjectWise.  Link to: Completion of Design Review Memo 

 Locking the Review Documents after the 

Review 
The Organizer shall change the state of the documents to make them document read-only after 
the resolutions have been applied to the review documents.   
 
To make the documents read-only, change the state of the documents in ProjectWise to 
“Review Completed” as shown below: 

1. Select the document(s) and change the state of the documents to “Review Completed” 
as shown below: 

https://portal.ct.gov/-/media/DOT/documents/AEC/completion_of_design_review_memo.pdf
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Figure 252 - Changing the State to Review 

 

 

Figure 253 - Review Complete State 

2. Then right click on all the documents again and select Change State > Set Final Status.  
This will lock the documents.   
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Figure 254 - Setting Final Status 
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 Design Phase Project Scheduling  

An Engineering working group evaluated several scheduling software options to support the 
mission statement. Microsoft Project 2010 was selected because it offers the following features 
and advantages: 

• Accommodates any number of milestones and tasks (i.e., easily scalable), 

• Graphically displays series and parallel tasks, 

• Provides baseline and tracking Gantt charts, 

• Displays the critical path, 

• Ability to link notes and documents, and 

• Interfaces with Outlook, Excel, SharePoint and other Microsoft products. 
 

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following 
minimum requirements: 

1. Includes all the activities identified by the Minimum Requirement Schedule 
Template; more detailed templates and project-specific schedules are encouraged,   

2. Baseline schedule,   
3. Task Indicator columns are used to link applicable instructional and reference 

documents, 
4. Explanations for changes in task durations are added as task notes,  
5. Tracking View/Gantt chart functions are used, 
6. Task-level progress is tracked regularly,  
7. Files are stored in COMPASS as indicated by the Digital Project Development 

Manual, and 

8. Microsoft Project files are maintained and current, with projected schedules in 

accord with the obligation plan. 

Base templates were developed by a committee that included Engineering Management and 
Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs 
are as follows: 

• Bridge Design – Kevin Blasi and David Gruttadauria 

• Consultant Bridge Design – Derick Lessard and Marc Byrnes 

• Highway Design – Scott Bushee, Jordan Pike, and Vitalij Staroverov 

• Consultant Design State Roads – Nilesh Patel and Meredith Andrews 

• Traffic Projects Design – Barry Schilling and Michael Chachakis  

• Traffic Studies & Safety – Erika Lindeberg,  Daniel Veronesi and Colin Baummer 

• Facilities Design – Eric Feldblum and Jesse Benson 
 
The SMEs are responsible for developing and maintaining division specific project templates and 
corresponding task libraries in ProjectWise. They shall be the first point of contact regarding 
discipline specific template and guidance document inquiries and maintenance.  
 
For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling 
Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov ) or John Dudzinski 
(john.dudzinski@ct.gov) 
 
 
 
 
 
 

mailto:Bruce.Bourgoin@ct.gov
mailto:john.dudzinski@ct.gov
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The table below details the minimum tasks included in the template: 

Table 2 - List of Minimum Tasks 

Task Name  

Project XXXX-XXXX  

Project Initiation  

• Prepare and Submit PPI  

• Prepare and Approve RPM   

• Secure Funding/Authorization   

Preliminary Design  

• Survey   

• NEPA/CEPA  

• Develop PD through Design Approval  

• Design Approval  

Final Design  

• Prepare Semi-Final Design Submission  

• Prepare Final Design Submission  

ROW Coordination  

• Prepare and Submit Final Accepted Property Maps  

• Acquire Properties  

Permit Acquisition Process  

• Permit A  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

• Permit B  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

• Permit C  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

FDP  

DCD  

ADV 
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 MS Project Schedules in COMPASS 
All Microsoft Project schedules managed in-house are now stored in COMPASS rather than 
ProjectWise.  
 
AEC Applications is coordinating with individual Project Managers (PMs) to migrate all active, 
existing MS Project schedules from ProjectWise to COMPASS.  For questions on the migration 
process, contact Chris Smith in AEC Applications. 

Project Managers and any individuals who will be actively maintaining an MS Project schedule 
must have a Microsoft Project Professional desktop application license and a Microsoft Project 
Online Professional license.  Individuals who will be viewing schedules or implementing minor 
edits in COMPASS require the Microsoft Project Online Essentials license only.   

In order to interact directly with schedules stored in COMPASS via the MS Project Professional 
Desktop Application, set-up the configuration as follows: 

1. Open the Microsoft Project Professional desktop application. 

2. Click the File tab at the top of the screen. 

3. Press Info → Manage Accounts 

 

Figure 255 - Configuring MS Project 

4. Click Add. 
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5. In the Account Properties window, enter the information provided below, then click OK. 

 

Figure 256 - Configuring MS Project 

The following steps show how to set-up a Microsoft Project file. 
1. Open ProjectWise Explorer by clicking a shortcut or going to Start and searching for 

ProjectWise Explorer.  

2. Double-click on CTDOT and sign in to ProjectWise. 

 

Figure 257 - Logging into ProjectWise 
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3. Browse to Documents → 04.00 Engineering Libraries → Scheduling Directive.  Select the 

applicable Scheduling Documents folder.  The minimum requirement schedule template 

is stored in the AEC Scheduling Documents (Minimum Req) folder. 

 

Figure 258 - Schedule Template 

4. Right click on the desired schedule and select Export, then select Send to Folder, and 

click next.   Then save the file locally and prepare MS Project schedule. 

 

Figure 259 - Schedule Template 
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5. Next open the project file. 
6. Then click on the File menu, select Info, select the Project Information dropdown and 

then Advanced Properties as shown below: 
 

 

Figure 260 - Setting Advanced Project Properties 

 
7. In the dialogue box that pops up, fill out the information as shown below: 

 

Figure 261 - Project Information 

8. Next set the project start date by selecting the File menu > select Info, then select the 
date as shown below: 
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Figure 262 - Setting the Start Date 

9. When the new MS Project schedule is ready to be added to COMPASS, upload it to the 
appropriate Internal Documents → 140_Project_Administration folder in COMPASS.   

 

Figure 263 - Saving the MS Project File to COMPASS 
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Figure 264 - Uploading MS Project File to COMPASS 

Once the schedule is prepared and saved in the 140_folder, contact Chris Smith in AEC 
Applications to have the file linked to the COMPASS pages. 

Editing and Opening a MS Project from Desktop Application 
Schedules stored in COMPASS can be opened to view or edit via the MS Project Professional 
Desktop Application: 

1. Open the Microsoft Project Professional desktop application. 

2. Select the COMPASS profile; click OK.  

 

Figure 265 - Opening an MS Project Schedule 

3. Select Open Other Projects. 

4. Under Project Web App, select COMPASS. 
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Figure 266 - Opening an MS Project Schedule 

 
5. Click Browse and select the desired project schedule from the list.  Note:  If the Project 

schedule is not listed, click “Show me the list of all projects.” 

 

Figure 267 - Show me List of Schedules 

6. Then click Open. 

7. After the edits are completed, save the file. 

8. Then publish the MS Project file back to COMPASS by clicking on File → Info. 

9. Then Click the Publish button. 

 

Figure 268 - Publish MS Project File to COMPASS 

Editing and Opening an MS Project Schedule from a 
COMPASS Project Site 
To open a schedule via COMPASS, navigate to that project’s COMPASS site and click on the MS 
Project Schedule button on the landing page or on the Project details page. 
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Figure 269 - Opening an MS Project file from COMPASS 

 

Figure 270 - Opening an MS Project file from COMPASS 

To edit the schedule in the Microsoft Project desktop application, navigate to the task tab, click 
the down arrow on the Edit button, and select In Microsoft Project.  The schedule will then open 
in the Microsoft Project desktop application. 

 

Figure 271 - Open MS Project File 

Opening and Editing an MS Project Schedule in the O365 
Web App 
The following shows how to open an MS Project schedule in the Office 365 (O365) Web App 
(PWA).    

1. Log-in to COMPASS and navigate to the project site.  
2. From the project page. 
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3. Then select the MS Project button to access the schedule via the PWA.   
4. Click the edit button in the project group on the project tab or the task tab.  

Incorporate edits as needed. 

 

Figure 272 - Editing the MS Project Schedule in the Web App 

5. Once edits are complete, click the close button on the Project tab.   

 

Figure 273 - Closing the MS Project Schedule 

6. Then click Check it in and press OK. 

 

Figure 274 - Checking IN an MS Project 

7. Press close on the Project tab. 

8. Theon the Task Tab click Publish.  This saves and publishes the changes. 
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Figure 275 - Publishing MS Project 

Open MS Project from COMPASS PWA Site 
Users can also manage MS Project schedules directly through the Project Web App (PWA), 
rather than navigating through specific project site.  This can be particularly useful for users who 
are maintaining schedules for multiple projects. 
To open an MS Project file directly via the PWA site: 

1. Sign in to Office 365. 

2. Click on the Project application button. 

 

Figure 276 - MS Project App 
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3. Locate and select the relevant schedule by project number in the Project Name column.   

 

Figure 277 - MS Project List 

4. To view and edit the MS Project schedule, ensure that the “Schedule” tab is selected. 

 

Figure 278 - Project Schedule 
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To edit an MS Project Schedule baseline (0-5), the user must be assigned as the “Owner” of the 
schedule.  AEC assigns the correct Project Manager when a schedule is added to COMPASS.  The 
current owner has the ability to reassign ownership if needed.  If the current schedule owner is 
unable to perform this task, contact Chris Smith in AEC Applications. 
To reassign ownership of an MS Project schedule in COMPASS, the current owner can: 

1. Open the relevant MS Project schedule as described in Section 11.1.4. 

2. Enter the Edit Project Details page. 

 

Figure 279 - Reassigning Ownership of an MS Project File 

3. Next to the Owner field, click Browse.  Select the new schedule owner, then press OK. 

 

Figure 280 - Selecting New Owner 
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4. Click close and check-in the MS Project schedule. 

 

Figure 281 - Closing MS Project Schedule 

 Basic MS Project Function 
This section presents the following schedule basic terminology and functions:  

• Scheduling Terminology  

• Task Relationships (Predecessors and Successors) 

• Adding , Renaming, Indenting and Deleting a Task 

• Adding/Adjusting Durations 

• Lead and Lag Times 

• Adding Hyperlinks 

• Combining Multiple Projects 

The most common scheduling view is the Gantt chart view, which illustrates a project schedule 
using task names, durations, start and finish dates on the left, and bar charts presenting these 
dates and durations to the right.  
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Figure 282 - Basic Terms 

Task Indicator Column - Present task Notes and Hyperlinks.  
Milestone - A major schedule date, such as an FDP. 
Parent Task - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the 
Child Tasks. 
Critical Path - Shown in Red, signifies the task relationships that control major milestone dates. 
Non-Critical Task - Shown in Blue, signifies sub-tasks that do not control major milestone dates. 
 

Predecessor is a task which has a start or finish date that affects the start or finish of another 

task.  

Successor is a task which has a start or finish date that is affected by another task.  

There are different ways of defining task relationships, these are  

• Finish-to-Start: This is the default dependency in Microsoft Project in which the successor 

cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by 

FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.  

 

Figure 283 - Finish to Start relation 

• Start-to-Start: The successor cannot begin until the predecessor begins. The successor task 

can start at any time after predecessor begins. Start-to-Start relationship is designated by 

SS. 

 

Figure 284 - Finish to Finish relation 
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• Finish-to-Finish: the successor cannot be completed until the predecessor is completed. 

The successor can be completed at any time after the predecessor is completed. Finish-to-

Finish task relation is denoted by FF. 

 

Figure 285 - Start to Finish relation 

• Start-to-Finish: the successor cannot be completed until the predecessor begins. The 

successor can be completed at any time after the predecessor has started. The Start-to-

Finish task relation is denoted by SF. 

 

Figure 286 - Start to Finish relation 

The schedule should have a Predecessors column where task relationships can be defined. To 

define a task relation, enter the Task ID and the Task Relationship in the associated task’s 

Predecessor Cell. For example, in the Figure below the PPI is a predecessor and the RPM is a 

successor task. The PPI must Finish before the RPM can Start. This relationship is denoted in the 

RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the 

Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is 

a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is 

not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.  

 
 

Figure 287 - Linking tasks 

 

 

 

 

 

 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 238 Version 5.01 
     

If the Predecessors column is not shown in the template, double click in the “Add New Column” 

cell and start typing “predecessor,” and from the short list click on Predecessors to add it to the 

current columns. If Add New Column is not shown right click on any column label and select 

Insert Column and then start typing in Predecessors, as presented below:  

 

Figure 288 - Add new column 

 

Figure 289 - Adding predecessor column 

Adding a Task  
To add a task, right click on the task which will follow the new task and select Insert Task.  For 

example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select 

Insert Task, as shown below: 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 239 Version 5.01 
     

 

Figure 290 - Adding a Task 

Renaming a Task 
Tasks can be renamed by double clicking on the task to be edited.  In the pop up window under 
General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)      
  

 

Figure 291 - Renaming a task 

Outdenting & Indenting 
Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left 

of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of 

the preceding, outdented ‘Parent’ task. Parent task durations are populated by their 

accumulative child task durations, therefore, parent task durations should not be manually 

entered. To set your task as a child or “sub-task”, select the row you would like to modify and 

click the Indent Button in the main toolbar area shown: 
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Figure 292 - Outdent and indent 

Deleting a Task 
A user may delete, enter zero, or enter any small duration for a task if it is irrelevant.  By 
entering zero for the duration the MS Project will view the task as a milestone, if a report is 
generated the report will present all zero duration tasks as milestones. This may confuse report 
reviewers.  A small duration may push back critical milestone dates. It is therefore 
recommended that project managers manually delete and revise predecessor and successor 
relations, as described below. To delete a task right click on it and select delete task. (Do Not 
Delete the Base Template Tasks in Bold) 

 

Figure 293 - Deleting a task 

When a schedule is started the user should remove tasks that do not relate and estimate all 

other pertinent task durations. It is critical to note if the task being deleted is a predecessor. 

You can determine this by following the lines stemming from a task in the Gantt chart. If a task is 

erroneous and must be deleted, but is also a predecessor for other tasks that should not be 

deleted, the successor task must be corrected.  Failing to update a new predecessor will likely 

disrupt task connectivity.  

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be 

deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the 
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ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be 

the new predecessor. See the task relationship and Gantt chart prior to task deletion: 

 

Figure 294 – Before task deletion table 

 

 

Figure 295 – Before task deletion Gantt chart 

 
See Task relationship and Gantt chart after task deletion: 

 

Figure 296 – Post task deletion and predecessor update table 
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Figure 297 - Post task deletion and predecessor update Gantt chart 

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS 
Project automatically reconfigures the schedule to show the new critical path. The critical path is 
shown in red and highlights the task relationships that determine a projects finish date.    

All tasks require duration estimates that may vary as projects progress. To set a duration click 
the Duration Cell to the right of the task and enter the task’s estimated period and the 
applicable unit, as presented below:  

• Mons: for months 

• Wks :  for weeks 

• Days :  for days 

• Hrs:    for hours  

• Mins: for minutes   
 

 

Figure 298 - Adding durations 

 
If the duration unit is already entered, then the duration value may directly entered, without 
including the unit. Do not modify durations for parent tasks. Parent tasks are signified by 
having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations 
are automatically calculated by their subtask durations.  
 
If a parent duration is manually entered, select the parent task and re-select Auto Schedule. 
This will recalculate the appropriate parent duration, based on its child tasks. See below: 
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Figure 299 - Auto Schedule 

In defining a task relation, a task may have to be delayed or started early.    

• The Lead time will tend to push your duration and a plus sign is used. 

• The Lag time will tend to shorten your duration and a minus sign is used. 

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a 
plus or minus, and the amount of delay or early start. 
 

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks 

 
Figure 300 - Task relation 

 

This can also be set by right clicking on a task and selecting Information.  Then go to the 

Predecessors tab as shown below, and enter the predecessor ID or Task Name, the relationship 

type and then a positive duration for a lead time or a negative duration for a lag time in the Lag 

column.  
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Figure 301 - Task relation in Project Information 

Adding Task Notes 

As stated in the Directive: “Explanations for changes in task durations are added as task notes.” 
Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the 
baseline. The note should be placed in the respective task’s indicator column. The note should 
state: 

• The date of the entry, 

• The person writing the note, 

• Justification for the task duration adjustment and 

• Recommended: Recipient Notification. 

The Recipient Notification list is left up to the Project Managers discretion. The purpose is to 
outline a step where project team members who may be interested or are directly impacted by 
a duration change, are notified. Once a note is drafted and the duration is adjusted, it is 
recommended that a notification email be sent to the relevant recipients and that the 
correspondence is saved to the subject project’s 140_Project Administration folder in 
ProjectWise. The recipients may typically include:  

• AEC’s Project Management Unit –Bruce.Bourgoin@ct.gov  or John.Dudzinski@ct.gov  

• Finance, such as the Office of Capitol Planning. 

• Design Engineers within the Project Manager’s division.  

• The group involved with the duration change or the group affected by the change, if 
applicable. For example, if the 6 month estimated duration for a project survey needs to 
be pushed back, the respective survey supervisor who is involved with the task should 
be included as a recipient in the notification email.  

The purpose of the recipient list is to improve communication between units and to harvest 
project data. Meaning, AEC will collect a repository of duration change notes in order to 
continuously reevaluate and improve schedule templates.  
 
To add a note right click on a task and select Notes… as shown below: 
 

mailto:–Bruce.Bourgoin@ct.gov
mailto:John.Dudzinski@ct.gov
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Figure 302 - Adding Notes 

Then type/insert your notes in the popup window.  

The other option to access the notes window is to double click on the task and in the Task 

Information window and click on the Notes tab. 

Adding Hyperlinks to a Task 

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and 
reference documents.” For all templates, hyperlinks shall be used to link a task to a division 
specific Schedule Task Library folder located in the Scheduling Directive folder. Contact your 
SME or AEC Applications for ProjectWise folder and template document management.  
 
For example, a Permit Task should provide a link to a corresponding ProjectWise folder that 
contains the permit’s regulatory document, suggested points of contact or experts, pre-written 
memorandums, etc... These documents must be added, actively maintained and updated. 
Division SME’s and AEC shall be the active maintainers of the division library modifications. 
When a document is incorrect or has been superseded it is critical that users report this to a 
unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users 
go through their SMEs to hyperlink documents, but the procedure is explained below.  
To add a Hyperlink, right click on the task that you want to add a link to and select Hyperlink  

 
Figure 303 - Adding Hyperlink 

 

Then in the following window, insert web address\navigate to a file.  
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Figure 304 - Add link/browse to a file 

 

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link  

 
Figure 305 - Removing a link 

 

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator 
column.  

It is critical that project managers can combine project schedules to better manage several 
schedules from the same file. MS Project provides this ability through the Subproject combine 
function. As outlined in Section 8, schedules must be stored in the project container: 
140_Project Administration folder. However, to use the combine function, MS Project schedules 
must be exported from the ProjectWise folder to a local server drive, such as the X-Drive. 
Schedules located in a local network can then be combined using the subproject tool. Exporting 
is only recommended when a user wants to use the combine tool. 
 
The following steps show how to combine Microsoft Project files: 

1. Browse to the ProjectWise Project container’s 140_Project Administration folder.  
Right click the Project Schedule and select Export, as shown below: 
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Figure 306 - Schedule Export 

 
2. Highlight Export and Click Next as shown below: 

 

 

Figure 307 - Export Option 

3. Browse to the network folder where you will keep the schedule file image. This 
network file will likely be in the division specific X-Drive>all_data-folder. 

 

NOTE: DO NOT DELETE THE EXPORTED FILE 
 
The floppy disk means that the file has been exported so the schedule is now read only. A user 
can still access the Project file by double clicking it and opening the file as Read Only. 
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Figure 308 - Exported File 

 
4. Create a new “Master” MS Project file that will be used as the container for the 

combined Subprojects. This Master Schedule file can be stored in the local network 
drive (such as the X-Drive) or on ProjectWise. Browse to the local network schedule 
(the one stored in the X-Drive) and click Insert as shown below: 
 

 

Figure 309 - Subproject 

The schedule has been inserted into the Master Schedule, where it can be actively updated and 
maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s 
outline symbol. 

 

 

Figure 310 - Added Subprojects 
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A user can view the most updated schedule via the ProjectWise file by right clicking the schedule 
file and selecting Update Server Copy as shown below: 

 

 

Figure 311 - Update server copy 

 
5. This step updates the ProjectWise schedule from the local network image file that is 

maintained by the user’s Master schedule. This allows any person to view the most-
up-to-date project schedule directly from ProjectWise.  

6. To Import a project schedule back into ProjectWise the user must right click on the 
ProjectWise schedule and click Import. As shown below: 

 

 

Figure 312- Import 

 
7.  If you look back to the local server where the project image file had been saved, 

you will notice that it is no longer there, this is because the file has been imported 
back into ProjectWise.  Now the file can once again be managed directly from 
ProjectWise. If a user wishes to maintain their schedule continuously from their 
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master schedule, they should avoid importing the schedule. Once a file is imported 
the user must re-export and re-add the schedule to their master schedule.   

 Tracking the Project 

Each project file must have a baseline set at the start of Preliminary Design.  The baseline is 
essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of 
the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not 
be re-baselined unless there is a major scope change.  Re-baselining requires Engineering 
Administrator approval.  
 

1. To set the baseline, under the Project tab select set baseline and select Set 

Baseline from the dropdown as shown below 

 

Figure 313 - Set Baseline Dropdown 

2. In the dialog box that pops ups, keep the default values and click OK. 

 

Figure 314 - Setting a baseline 

Re-Baselining          
If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be 

set in accordance with the following: 

1. Go to Projects > Set Baseline > Set Baseline. 

2. Then select Set Interim plan, select Baseline from the copy drop down button, then 

select Baseline 10 for the Into dropdown list.  
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Figure 315 - Re-Baselining 

3. Next, go to Project > Set Baseline> set Baseline. 

4. Then in the dialog box that pops up just click OK to save a new Baseline.  

 

Figure 316 - Re-Baselining 

5. When a pop up window asks you if you want to overwrite click yes 

 

Figure 317 - Re-Baselining 

6. After the project has been re-baselined add a note to the top left Identifier cell 

located in the Project No. row. The note should include the details outlined in the 

Adding Notes and Hyperlinks to a Task section. The recipient list should include all 

parties affected by the base-line adjustment.  
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Figure 318 - Re-Baselining Note 

 
After the project has been re-baselined change the view to a Tracking Gantt view.   

1. In the left dark grey bar shown below, right click and select Tracking Gantt.   

 

Figure 319 - Changing to a Tracking Gantt 

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the 

one on top is the actual duration.   If there is a slip in a task schedule it will be shown as an 

offset. 
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Figure 320 – Tracking Gantt view 

2. Next to change the table of tasks to the tracking mode, click on the left upper corner 

cell to select the entire schedule, then right click and select tracking. 

 

Figure 321 - Changing to tracking table 

The table of tasks will now be in the tracking mode, 

3. Then click save. 

The project manager will be required to record the project progress by keeping an up to date 
record of the % complete for each task in the project.   This shall be recorded in 25% increments.   
 
The following shows how to record the progress of a task: 

1. Click on a task. 
2. Then in the task menu select the appropriate % complete as shown below: 
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Figure 322 - task update tools 

Important Note:  When the task is completed, do not select 100% complete.  You will need 

to type in the actual finish date for that task.  If 100% complete is selected, Microsoft Project will 

calculate the actual finish date instead of recording the physical date the task was completed.  

In the tracking Gantt, the task will show the percent complete of the task as shown below:  

 

Figure 323 - Updated task view 

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the 

following figure. 
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Figure 324 - Tracking View 
 

 Generating Reports and Summaries 
Microsoft Project provides different forms of reports and visual summaries.  MS Project has 
three reporting options: 

1. Standard Reports 

2. Custom Reports 

3. Visual Reports 

 

Standard Reports 
Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs, 

assignments and workload.  

  Under Overview the following is reported: 

• Project Summary 

• Top-Level Tasks 

• Critical Tasks 

• Milestones  

• Working days 
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Under Current the following is reported: 

• Un started Tasks 

• Tasks Starting Soon 

• Tasks In-Progress 

•  Completed Tasks 

• Should have Started Tasks 

• Slipping Tasks 

              Under Cost the following is reported: 

• Cash Flow 

• Budget 

• Overbudget Tasks 

• Overbudget Resources 

• Earned Value 

            Under Assignments the following is reported: 

• Who does what 

• Who does what when 

• To-do List 

• Over allocated Resources  

•  

        Under Workload the following is reported: 

• Task usage 

• Resource Usage 

 

To access these report options go to Project > Reports  

 

Figure 325 - Report options 
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Custom Reports 

A custom report has the ability to customize the report based on templates in the following 

categories: 

• Task 

• Resource  

• Monthly Calendar 

• Crosstab 

 To access custom report tool, go to Project > Reports > and double click on Custom 

 

Figure 326 - Custom Reports 

Then the report to be edited is first selected from the list of available custom report.  Next, click 

the Edit button. The dialog will show the current report’s setting and all the available report 

settings. 

 

Figure 327 - Customizing a report template 

Other than the Definitions tab you may utilize details and sort tabs for further customization. 
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Visual Reports 

Unlike the standard/customized reports which are text based, visual reports present the report 

graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio 

pivot-diagrams. 

To access go to Projects tab > Visual Reports 

 

Figure 328 - Visual Reports 
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 Electronic Engineering Data 

(EED) 

 Introduction 

The intent of this section is to provide standards and guidelines to promote consistent, uniform, 
and useable deliverables for CTDOT construction projects.  It is not the intent of this section to 
add unnecessary additional responsibilities to the designer, but rather to have the projects 
delivered in a consistent manner following best practices and industry standards used in the 
today's CAD environment. 

Electronic Engineering Data (EED) refers to the Computer Aided Design (CAD) files and the 
Digital Civil Engineering data files (from applications like OpenRoads and InRoads) that were 
used to create the pdf contact plans. These files include: 

• Geospatially correct 2D project location polygon 

• 2D and 3D geospatially located CAD files 

o Bentley Software (DGN) Design Models 

• InRoads Data 

o Coordinate geometry - Horizontal and Vertical alignments (ALG) files 

o Roadway Surfaces - InRoads digital terrain models (DTM) files  

• OpenRoads Infrastructure Consensus Models (ICM) & i-Models 

o Coordinate geometry  

o Digital Terrain Models 

o Storm Drainage, Structure and Pipe Data – Subsurface Utility Engineering (SUE)  

In the future, EED may contain additional information such as asset data (signs, signals, 
guiderail, etc.). 
 
In conjunction with an emerging project delivery method or technology initiative, the 
Department may provide bidders and contractors with: 
 

• CAD files of the Base Technical Concepts in conjunction with alternative 
contracting methods (e.g., Design-Build, Construction Manager/General Contractor 
and Construction Manager at Risk). 

The requirements for EED will be implemented in three phases.  A phased structure was 
developed to facilitate the transition of the Department into the 2D/3D modeling arena.  This 
guide has been divided to detail the files submittal types for all phases.  The following sections 
outline the data requirements based on the Project type for each phase of implementation. 

Phase 1 
Phase 1 will focus on the practice of submitting proposed Bentley Software 2D CAD, InRoads 
geometry files and a 2D project location polygon.  These files are to be free of any extraneous 
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data and match the contract plans.   All projects designed using InRoads SS2 will follow the data 

requirement in Section 12.4.   

Phase 1A 
 

❖ Note:  The original Phase 2 requirements have been replaced by Phase 1A goals.  
Phase 1 requirements remain in place. 

 
Phase 1A will add the goals of submitting curb to curb 3D roadway top surfaces using the 

Department’s current modeling software, InRoads SS2. These 3D surfaces will not be required 

submissions; the designers are encouraged to develop the models which can be utilized not only 

during the construction phase but the design phase as well.  These projects are designed in-

house on the internal network or by consultants on an external network.  All projects designed 

using InRoads SS2 should follow the data requirements in Section 12.5.  If there are design 

submissions in this phase they should have the 2D models to be complete from curb to curb for 

the entire project, along with the Phase 1 requirements.   

Phase 3 
Phase 3 will change the data delivery files type using OpenRoads technology (OpenRoads 
Designer and beyond). In the upcoming years all new roadway projects designed at CTDOT will 
require the use of OpenRoads Technology.  All projects designed using this technology will 
follow the data requirement in Section 12.6.  For these future projects 3D models will include 
finished (or “top”) design surface and any subgrade excavation surfaces within the grading limits 
for the entire project.  Phase 3 will also include Phase 1 requirements. 

 
Nationally the civil industry is quickly recognizing business improvements and lower costs by 
changing field operations to incorporate the use of EED.  One of these practices is the utilization 
of 2D/3D modeling for the development of model based digital design data.  
The concept of model centric design, and the generation of digital design data for use in 
construction, involves the following key steps:  

1. Collection and development of geospatially located survey data for an accurate 

existing conditions model to be used for design, and also to be delivered for use 

in bidding on the project.  

2. Utilization of the survey model in design, with design software capable of 3D 

model output.  

3. Proposed output from design of critical digital deliverables for use in bidding, 

construction and inspection purposes on the project.  

4. Utilization of digital deliverables in constructing the project in an automated 

fashion.  

5. Field collection of as-constructed and inspection measurements and 

observations using modern positioning technology, relative to the engineered 

model data.  

6. Archiving and preservation of digital model data for future use, including asset 

management.  
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FHWA has promoted the adoption of this technology through their Every Day Counts 2 and 3 
initiatives. According to FHWA, “Three-dimensional (3D) modeling in transportation 
construction is a mature technology that serves as the building block for the modern-day 
digital jobsite. The technology allows for faster, more accurate and more efficient planning 
and construction.” 
For more information on please visit the U.S. Department of Transportation, Federal Highway 
Administration, EDC2 Website titled 3D Engineered Models website at: 
 

https://www.fhwa.dot.gov/construction/3d/about.cfm  
 

Digital 3D models of a highway project can convey a greater level of design intent than a 2D 

model; therefore, design projects should be developed in 3D when it is practical to do so. 

Essentially, if the designer is using surfaces (existing and proposed) to develop contract plans, 

then a 3D model shall be delivered.  The following are guidelines to help determine projects in 

which 3D models may be beneficial: 

• Cross sections will be included in the final plan set. 

• Reconstruction is proposed within the project limits.  If the reconstruction is only a 

component of the overall project (e.g., mill and overlay scope of work with a section of 

reconstruction) only the reconstruction area should be designed in 3D unless an 

accurate surface was obtained of the entire project. 

• Major roadway rehabilitation (structural enhancements that both extend the service life 

of an existing pavement and/or improve its load-carrying capability).  

• Complex storm water and drainage in order to check for clearances under roadway 

subbase and clash detection (i.e. utility conflicts). 

• Intersections 

• Subsurface utility information that is field located. 

 Project Types and Phases 
This section defines the types of projects that EED will be delivered, along with the contract 
plans, at FDP.  To determine what requirements are to be delivered in each phase, classify the 
type of project from Table 3 – EED Project Types and then use Table 4 – Project Deliverables to 
identify the deliverables.  
 

Project Type 1 – No Earth Work 
2D Projects 

Project Type 2 – Site Earth 
Work 

3D Site Projects 

Project Type 3 – 
Roadway Earth Work 
3D Roadway Projects 

Bridge Deck/Superstructure 
Replacement 

Bicycle/Pedestrian Facility 
(Multiuse Trails) 

Grade Crossing - Major 
Improvement 

Bridge 
Restoration/Rehabilitation 

Bridge Replacement 
W/Realignment Of Approaches 

Intersection 
Improvement - Minor 

Bridge 
Substructure/Superstructure 
Repairs 

Drainage - Major Intersection Realignment 

Concrete Barrier Rail Facility Construction (Site 
Work) 

New Interchange 

Drainage - Minor  Hazardous Waste Removal Operational Lane 

https://www.fhwa.dot.gov/construction/3d/about.cfm
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Facility Rehabilitation Retaining Walls/Slope 
Stabilization 

Realignment 

Fixed Objects Modification Wetland 
Replacement/Restoration 

Widening - Major (4r 
Projects) 

Grade Crossing - Minor 
Improvement 

 Widening (3r Projects) - 
Minor 

Guiderail Improvements  

Illumination 

Intelligent Trans Systems 

Landscaping 

Maintenance 

Noise Barriers 

Resurfacing By Contract 

Roadside Safety Improvements 

Traffic - Paint & Epoxy 
Pavement Markings 

Traffic - Signal Installation 

Traffic - Signal System 
Improvement 

Traffic - Signing 

Transit 

Utility Projects 

   

Table 3 – EED Project Types 

 

    
Project Type 1                   
No Earth Work  

Project Type 2                    
Site Earth Work 

Project Type 3                   
Roadway Earth Work 

    

Phase 
1 

Phase 
1A 

Phase 
3 

Phase 
1 

Phase 
1A 

Phase 
3 

Phase 
1 

Phase 
1A 

Phase 
3 

C
A

D
 F

ile
s 

Proposed Bentley 
Software File 

R R R R R R R R R 

Existing Ground 
Bentley Software File 

D D D D D D R R R 

Project Polygon R R R R R R R R R 

In
R

o
ad

s 
Fi

le
s Geometry ALG File D D   D D D R R   

Top Surface Curb to 
Curb  DTM File 

        G     G   

Existing Surface DTM 
File 

       R     R   

O
p

en
R

o
ad

s 
Fi

le
s 

 Geometry Data                                D     D     R 

Top Surface Data 
Terrain 

          R     R 
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Subsurface Data 
Terrain 

          R     R 

OpenRoads Terrain           R     R 

Existing Surface Data 
Terrain 

          D     R 

Storm Drainage Data 
SUE 

          D     R 

Table 4 – EED Project Deliverables 

R = Required    
D = Discretionary (Required if used during design) 
G = Phase 1A Goals (Submission is at the discretion of the designer) 

 Contract Plans and EED Conflicts 
In all cases the EED will be issued as “For Information Only” purposes and the contract plans 
shall govern.   An EED Notice to Contractor will be issued with each contract informing the 
potential users of this information as such. 

 Phase 1 Requirements 
Note: Also see Section 12.8 EED Phase 1 Quick Start 
 
Phase 1 will require the delivery of Bentley Software 2D CAD models, InRoads alignments and 
existing ground surfaces.  CTDOT uses Bentley software products for all their computer aided 
design needs, with Bentley Software (.dgn format) being the foundation to all computer 
modeling. Therefore it is critical that Bentley Software EED files be submitted to the CTDOT and 
conforms to the criteria outlined in this section. 

 

Figure 329 - Phase 1 EED Deliverables 

http://www.ct.gov/dot/cwp/view.asp
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3D Ground Model(s) (.dgn) 
• All elements shall be placed using CTDOT’s customized Bentley Software Task Manager 

or be generated by InRoads Survey Tools. This will ensure that all CAD graphics have 
the correct attributes (color, weight, line style, level). 

• Must be compatible with CTDOT’s current SELECTSeries DDE. 

• Elements must be placed in real world modified state plane coordinates (see Section 
3.0 of CTDOT’s Location Survey Manual, June 1997)  and be geospatially correct 

• Only one design model per dgn file; no drawing or sheet models are to be used 

All elements representing existing topography features shall be drawn according to the current 
CTDOT Survey standards; CTDOT’s Location Survey Manual, June 1997. These Bentley Software 
file(s) shall contain a single 3D design model including both 3D and 2D elements of the existing 
survey.   2D elements included but are not limited to ROW lines and control lines.   3D element 
includes tangible elements such as edges of pavement, shoulders, curbs, gutters, sidewalks and 
retaining walls.   

Existing Survey Surface File (.dtm) 

Existing Digital Terrain Models represent existing ground conditions at the time that surveying 
data was collected. This original ground DTM represents the undisturbed ground surface prior 
to construction.  There may be several existing DTM’s depending on the length of the project 
and the number of project site locations.  The existing surface dtm will adhere to the 
specifications outlined in CTDOT’s Location Survey Manual, June 1997.   

See Section 12.5.4 for more information. 

CTDOT uses Bentley software products for all their computer aided design needs, with Bentley 
Software (.dgn format) being the foundation to all computer modeling. Therefore it is critical 
that Bentley Software EED files be submitted to the CTDOT and conforms to the following 
criteria: 

• All elements shall be placed using CTDOT’s customized Bentley Software Task Manager 

or be generated by InRoads using the CTDOT preference files (CT_civil.XIN). This will 

ensure that all CAD graphics have the correct attributes (color, weight, line style, level) 

and follow CTDOT's CAD standards. 

• Must be compatible with CTDOT’s current SELECTSeries DDE. 

• Elements must be placed in real world modified state plane coordinates and be 

geospatially correct 

• If a 3D model is developed during design, it should be exported to a 2D model.  Any 2D 

files generated from a 3D file must be in direct correlation to the 3D parent file. 

• Only one design model per dgn file; no drawing or sheet models are to be used 

Proposed Master Highway Models 
This 2D Design Model DGN will include geometric line work such as centerlines, and proposed 
right of way lines.  This file will also include right of way dimensions, roadway dimensions and 
centerline annotation.  All features that are to be quantified shall be included in this file (i.e. 
guide rail, fences, etc.).    
 

https://www.ct.gov/dot/cwp/view.asp?a=3194&q=483668
https://portal.ct.gov/-/media/DOT/documents/dcsurvey/LocationManualpdf.pdf?la=en
http://www.ct.gov/dot/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
http://www.ct.gov/dot/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
https://portal.ct.gov/-/media/DOT/documents/dcsurvey/LocationManualpdf.pdf?la=en
https://www.ct.gov/dot/cwp/view.asp?a=3194&q=483668
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Level of Detail 

Patterned Riprap Channels  

Patterned Riprap Slopes 

Patterned Pavement Removal 

Patterned Milling  

Erosion control Matting for Channels 

Erosion control Matting for Slopes  

Processed Aggregate  

Pavement for Railing  

Sodding  

Turf Establishment 

Planting Details (may be in a separate model) 

Project Polygon 

Figure 330 LOD Prosed Master Highway Model for Areas 

 

Level of Detail 

Sedimentation Control Fences  

Cut limit  

Fill limit  

Fence 

Front face of landscape wall 

Single PCBC 

Double PCPC 

Temporary PCBC 

Cut Pavement 

Parking lot  

Driveway 

ROW – graphical representation of an InRoads alignment. 

Centerline and Baseline – graphical representation of an InRoads alignment. 

Guide Rail –The end anchor should be placed in the correct location.  The 
smart line is to be offset from EOR so it can be graphically seen (Connecticut 
Standard Details for placement will supersede plan placement).   

Figure 331 - LOD Proposed Master Highway Model for 2D Smartlines 

Proposed Master Structure/Bridge Models 
The lead structural designer shall submit to the CTDOT a single 2D design model, per site and 
project, in a single 2D DGN file for every project that contains a new footing (including new box 
culverts). Each 2D design model shall include all components associated to the particular site 
and project. 
The single 2D DGN file and its corresponding model shall conform to the following formats and 
include the following components: 
 

• All components must be referenced into a single model 

• Elements shall be placed using CTDOT’s customized Bentley Software Task Manager.  

• Components modeled in Bentley Software shall be Feature Model Elements.  

• All elements shall be geospatially correct. 

• All elements shall be placed at 1:1 scale. 
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The master structural model shall include but not be limited to the following components: 
 

Level of Detail  

Structure excavation earth and rock 

Pervious structure back fill 

Granular fill 

Figure 332 - LOD Structure Elements Earth 

Proposed Master Environmental Compliance Models 
The master environmental compliance model shall include a single DGN file with one 2D design 
model per file, per location, per project.  All features that are to be quantified shall be included 
in this model.   

Proposed Master Traffic Models 
The master traffic model shall include one 2D design model per site.  This model shall include all 
items that are to be quantified.   

Proposed Master Miscellaneous Models 
These models could be (but not limited to staging plans and or other disciplines not listed above 
that have items to quantify. 

 
❖ Note:  This is the only EED file that is required before FDP.    

 
A Project Polygon (geo-spatial boundary) shall be submitted at the completion of Design 
Approval.  This will replace a cursory project polygon created at design development by the 
project sponsor.  Any changes to that boundary during final design or construction warrant a 
resubmission of the Project Polygon after Design Approval, at DCD or Construction Completion.   
 
See section 13 for more information.   

If used, an InRoads (.alg) file shall be submitted per discipline.  Submit only final alignments.  Do 
not include preliminary or alternates information). The .ALG files shall: 

• All centerline and baseline horizontals with a maximum of one vertical geometry 

alignment per horizontal alignment (including structures).  

•  All geometry contained in these file shall have names representative of the designed 

alignments and features found in the plans (Centerline = Route_84_ Eastbound).  

• All coordinate geometry information must be provided in the native InRoads (*.alg) 

format. 

•  Engineering discretion shall be used in determining which geometry elements shall be 

displayed in the master highway model.  

•  Alignments shall follow the specifications outlined in CTDOT’s Location Survey Manual, 

June 1997.  

 

https://portal.ct.gov/-/media/DOT/documents/dcsurvey/LocationManualpdf.pdf?la=en
https://portal.ct.gov/-/media/DOT/documents/dcsurvey/LocationManualpdf.pdf?la=en
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Level of Detail 

Horizontal alignments for all roadway centerlines/baselines 

Type 2 Projects only - Vertical alignments for all roadway centerlines/baselines 

Horizontal alignments for all proposed ROW 

Special alignments used for drainage purposes, skewed driveways or stage construction 

Alignments used for design features such as edge of roads, sidewalks & retaining walls 

Structure centerlines of bearings 

Structure centerlines of girders 

Figure 333 - LOD ALG Files 

 Phase 1A Goals 

 

Figure 334 - Phase 1A EED Deliverables 

See Section 12.4.1 

See Section 12.4.2 

See Section 12.4.3 

A Digital Terrain Model (DTM) is a three-dimensional topographic model which mathematically 
and graphically represents the existing and proposed surfaces. It consists of a triangulated 
surface with features.  A feature is a named set of points in a Digital Terrain Model (DTM). There 
are five feature types which define the structure of the feature and controls how it affects the 
triangulated model. Each of these feature types has a feature style or styles, which controls how 
they are displayed. 

• Random - “spot” points which have no direct relationship with other points  

• Breakline - groups of points with a direct linear relationship  

• Exterior -  Surface boundary extent; closed and only one per surface  

• Interior - defines undefined areas; closed and no limit to number  

• Contour - groups of points with a direct linear relationship and same elevation 
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Any DTM used to generate final contract plans must be submitted.  For Phase 1 Type 2 projects 
this will include all surfaces curb to curb for the entire project.  These projects would also be the 
type which in most situations will require the inclusion of Item 9.80 Construction Staking.  Files 
must meet the following criteria to be submitted with the EDD for CTDOT projects: 

• InRoads uses DTM data to produce contours, display the existing and proposed ground 

lines in profile and cross section grids, and in the calculation of cut and fill quantities. 

Supplied surface files must be in the native InRoads .dtm format.    

• Project model deliverables shall include at a minimum, two proposed DTMs and an 

existing DTM.   One proposed surface shall be a finished grade DTM, and the other shall 

be a top of subgrade DTM.  It is important to note that the subgrade data is available 

with the top surface DTM but when the top surface gets exported using LAND XML for 

use with AMG technology the subgrade data gets automatically dropped.  For this 

reason a separate subgrade surface needs to be delivered. 

Level of Detail 

3D design has no overlaps of breaklines or visual inconsistencies of features. 

Surface features are continuous over their entire length, not broken into multiple pieces. 

2D contract plans match the surface models. 

No vertical faces are present (all vertical surfaces are to be offset a minimum of 1/12 in – 1/8 in 
to be accepted into the AMG software). 

Accuracy clash detection, spot check x, y and z coordinates. 

In critical areas (i.e. intersections), contours should be displayed at construction equipment 
tolerance intervals (typically 1” or less) to insure smooth surfaces for automated machine 
control/guidance purposes. 

Figure 335 - LOD DTM Files 

Existing 
Existing Digital Terrain Models represent existing ground conditions at the time that surveying 
data was collected. This original ground DTM represents the undisturbed ground surface prior to 
construction.  There may be several existing DTM’s depending on the length of the project and 
the number of project site locations.   

Design 
Proposed Digital Terrain Models represent the project design as generated by InRoads using the 
horizontal alignments, vertical alignments, templates, roadway definitions and surfaced editing 
tools.  
 
A top surface for each corridor will need to be created representing at minimum the proposed 
finished grade curb to curb as part of the design data deliverables.  All proposed DTM surfaces 
shall be defined by a breakline density interval (frequency of cutting templates) of no more than 
five feet, and at every event location.  In tightly constrained or critical drainage areas, or on the 
outside of sharp horizontal curves, the break line interval may need to be reduced to two feet or 
less.   

Substratum 
All files created to represent the approximate Substratum surfaces will also need to be supplied.  
Substratum surfaces are used to represent assumed existing subsurface layers, such as rock, 
sand, clay etc.  
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Subgrade (Structure) 
If underground structures are involved multiple subgrade surfaces will need to be generated to 

include all bottoms of footings, granular fill, box culverts, piers, walls, abutments, sign supports 

and bottom of excavation.   

Proposed Master Storm Drainage Models 
The Storm Drainage Model DGN file will be either 3D using InRoads Storm and Sanitary or 2D 
using StormCAD.  The master Storm Drainage Models shall include but not be limited to the 
following: 

 

Level of Detail  

Pipes – Double line representing the inside Diameter at invert elevations 

Culvert ends – 2D cell placed at invert elevations 

Endwalls, Riprap Splash Pads and Scour Holes – 2D shape at invert elevation 

Catch Basins – 2D cell placed at top of grate elevation 

Paved Apron– 2D shape at grate elevation 

Manhole – 2D cell placed at top of frame elevation 

Figure 336 - LOD Storm Drainage Using Storm and Sanitary 

Level of Detail 

Pipes – Double line representing the inside Diameter at elevation 0 

Culvert ends – 2D cell placed at elevation 0 

Endwalls, Riprap Splash Pads and Scour Holes – 2D shape at elevation 0 

Catch Basins & Structures – 2D cell placed at elevation 0 

Paved Apron– 2D shape at elevation 0 

Manhole – 2D cell placed at top of elevation 0 

Figure 337 - LOD Storm Drainage Using StormCAD 

 Phase 3 Requirements 

Phase 3 will consist of delivering a full 3D model of the entire project, slope limit to slope limit.  

This will be accomplished using Bentley’s OpenRoads Designer (ORD).  This software allows the 

designer to create a 3D model much more easily than the current production software, InRoads 

Select Series 2. 

The deliverables for Phase 3 will just be the Bentley Software dgn file itself.  All of the 

engineering data is written to the dgn including the coordinate geometry, surfaces, and CAD line 

work.  The dgn is simply saved as an i-Model which can be consumed by the GPS field 

equipment directly with no conversions necessary. 

Bentley is currently developing the production version.  After the release of ORD and testing, 

CTDOT will be adopting ORD as the production software sometime later this year. 

Existing Survey Ground File 
Details coming soon 
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Proposed Master Design Files 
Details coming soon 

Coordinate Geometry Files 
Details coming soon 

Integrated Civil Models 
Details coming soon 

 Submission Procedures 

All required EED documents shall be delivered: 

• At FDP 

• At award of Contract (includes all addenda)  

• After design initiated change orders, that the lead design deems necessary to supply to 
the contractor. 

The EED delivery manifest must be delivered to the CTDOT with every EED submittal. A blank 
copy can be found by clicking on the following link: EED File Manifest.  This form will include 
general project information; the datum used for the ground survey; file names and specific 
information about each EED file being submitted.  The contact information for the lead designer 
and lead surveyor must also be provided.   

Each discipline will upload their EED files in a zip folder into the 01.0 - Projects - Active\XXXX-
XXXX\240_Contract_Development\ folder where XXXX-XXXX is the project number.  For 
uploading documents to ProjectWise see Section 6.   

The Notice to Contractor (EED Notice to Contractor) must be filled out by the lead designer with 

the correct project number in the last line of the notice.  This NTC informs the Office of 

Construction and the contractors that the EED will be available, along with the contract plans, at 

advertisement.  The NTC also states that all EED files are for information only.  This will be 

submitted along with the specifications at FDP. 

For uploading documents to ProjectWise see Section 6.  

AEC will convert Bentley Software CAD files (dgn) into a dxf format, InRoads alignment files (alg) 
into xml, and InRoads surface files (dtm) into xml.  These conversions are necessary to be 
utilized in the GPS field equipment and automated machine guidance/control equipment.   It 
will be AECs responsibility to zip all files, both native and converted, and upload to the 
100_Contract_Plans (PDF) folder in ProjectWise.  Contracts will be notified so that the EED zip 
file can be posted along with the contract plans, specifications, and estimates on the State’s 
contracting portal at advertisement. 

http://www.ct.gov/dot/lib/dot/documents/aec/eed/eed_file_manifest.pdf
http://www.ct.gov/dot/lib/dot/documents/dcontractdev/ownedspecs/english/0.055_ntc_eed_electronic_engineering_data.doc
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The converted data is being provided by CTDOT to insure that inspectors and contractors are 
utilizing the same set of data. 

Changes to the EED that require edits to the CAD models, surfaces or alignments shall be 

submitted along with submission of the revised contract plans.   

For uploading documents to ProjectWise see Section 6.  
 
A new zip file will be created containing the renamed updated files and uploaded to 

ProjectWise.  AEC will then be notified that the amended files are complete. 

 EED Phase 1 Quick Start  
Note: EED is due with the FDP plans at FDP.  The only exception is the project polygon.  This is 
required to be submitted at Design Approval, DCD, and when any Change Order that affects 
project polygon.  See section 13 for more information on project polygon locations.  
 

1. Ensure that the Bentley Software Design Models meet the requirements of Section 12.4.2 for 

your discipline.  3D CAD models will be exported to 2D CAD models. 

a. All graphical elements are at the correct geospatial location and are on the correct level. 

b. Models are free of all cross sections, profiles, construction lines for design purposes. 

c. Models are free of annotation that should reside in the cut sheets. 

d. Models have clean reference attachments, only needed reference files & no redundant 

references. 

e. Models are a 2D design model, not a sheet or drawing model 

f. Files contain only one model 

2. Ensure that the InRoads Coordinate Geometry file(s) meets the requirements of Section 12.4.3. 

a. Only final alignments included (do not include preliminary or alternates information). 

b. Alignments names and descriptions are intuitive.  

c. Each horizontal alignment has only one child vertical alignment. 

3. At FDP: 

a. Check that the EED Checklist criteria is met. 

b. Fill out EED File Manifest for all files (native data only).  

c. Upload the Bentley Software dgn and InRoads alg (if applicable) in a zip folder into the 

ProjectWise folder    01.0\Projects - Active\XXXX-XXXX\240_Contract_Development\ where 

XXXX-XXXX is the project number.  For uploading documents to ProjectWise see Section 6.  

4. Send a link to AEC Applications at ronald.tellier@ct.gov that the files are ready.   

https://portal.ct.gov/-/media/DOT/documents/AEC/EED/EEDFileManifestpdf.pdf
mailto:ronald.tellier@ct.gov
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 EED Checklist 
Check List   

Bentley Software Design Models 

☐ All graphical elements are at the correct geospatial location. 

☐ All graphical elements are placed on the correct CT DOT Level. 

☐ Files are free of all cross sections, profiles, construction lines for design purposes. 

☐ Files are free of annotation that should reside in the cut sheets.  

☐ 
Files have clean reference attachments, only needed reference files & no redundant 
references. 

☐ All 3D files have lines and elements at the proper elevation (no spikes). 

☐ Files are a 2D or 3D design model, not a sheet or drawing model 

☐ Files contain only one model 

Coordinate Geometry  

☐ 
Only final alignments are included (preliminary and alternate information has been 
removed). 

☐ Alignments names and descriptions are intuitive.  

☐ Each horizontal alignment has only one child vertical alignment.  

Surface Models 

☐ 
Visualized breakline features and they appear to be consistent and match the 2D Bentley 
Software file. 

☐ 
Visualized breakline features, no vertical faces are present; breaklines appear to be 
horizontally offset. 

☐ 
Visualized both the contours and triangles in a 3D file. Looked at it from the top and front, 
side, and isometric view. No irregular dips, spikes or voids in the surface are apparent.    

☐ 
Triangles were viewed on top of the proposed design file. The triangles do not cross 
obvious breaklines such as centerlines, edges of pavement, edges of shoulders, etc. 

☐ 
Contours were viewed to ensure the low points line up with the proposed drainage 
structures and structure flowlines match the proposed surface.  

☐ 
If automated machine control/ guidance will be used during construction, at intersections 
or other critical areas, contours should be viewed at a 0.1 foot interval to ensure the 
model is accurate enough for automated machine control/ guidance use. 
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 Electronic Data Definitions 

3D Model – Models includes all engineering data which is geospatially positioned and graphically 
displayed on project related datums and are used to describe the existing conditions or 
proposed design of a capital project.  This can include multiple DTM surfaces and related 
Graphics Information.  The “Model” is what is generally what is referred to as the deliverable for 
projects which anticipate using AMG. 

Automated Construction and Inspection – Automated Construction & Inspection include all 
technologies used for the construction and inspection of capital projects, and require the input 
of reliable EED to operate effectively.  Examples of this may include Automated Machine 
Guidance, Automated Stakeout & Inspection, and Intelligent Compaction operations. 

Automated Machine Guidance (AMG) – AMG uses computers and survey technology on 
construction equipment to automate the calculation and interpolation between a proposed 
digital terrain surface (or a control alignment with templates) and survey geospatial positioning.  
This interpolation provides visual horizontal and vertical guidance to the operator of the 
construction equipment.  AMG is also referred to as Machine Control or Automated Machine 
Operations.   

Automated Stakeout & Inspection – Use of computers and survey technology to automate the 
calculation and interpolation between a proposed digital terrain surface (or a control alignment 
with templates) and survey geospatial positioning.  This interpolation provides horizontal and 
vertical guidance to the operator of the equipment, for the stakeout of proposed work or 
positional verification or measurement of completed work. 

CAD Model (design) – Master Design CAD dgn file. The model usually consists of one dgn file (for 
large projects there may be more than one) that contains all of the proposed design work. There 
are separate models for each discipline that is doing design for the project (Highways, Traffic, 
Bridge, etc.) This model is referenced into the individual cut sheets and clipped to the correct 
size.  

CAD Model (existing) - Master existing CAD dgn file. The model usually consists of one dgn file 
(for large projects there may be more than one) that contains all of the existing survey.  This 
model will also contain other information such as the datum used and control tie box 
information. 

CAD files – refers to any CAD files that are not defined as a CAD model (see above).  Examples of 
these files would be the title sheet, miscellaneous details, detailed estimate sheet, plan sheets, 
etc.  Plan sheets would have CAD models referenced into them but would not contain any 
design work in the file itself.  

Digital Terrain Model (DTM) – A DTM is a digital map representation of a three dimensional 
topographic surface.  (Also referred to as Digital Elevation Model DEM, or a Triangulated 
Irregular Network TIN).  DTMs are visualized electronically by draping a surface over 
triangulated points which are generally determined along breaklines where changes occur in the 
slope of the surface.  The points are defined geospatially by coordinates and elevation values.  In 
the civil engineering industry, DTMs can represent existing natural terrain of the earth’s surface, 
or proposed terrain intended to represent a completed surface.  DTMs can portray triangulated 
and/or non-triangulated features, shapes and solids. 

Documents & Publications – Includes reports, manuals, contract proposals, specifications or 
other publications which record or document decisions, standards, policies, procedures or other 
legal requirements related to capital projects.   

Electronic Engineering Data (EED) – Includes all types of design project related engineering data 
which is used for the defining, developing, designing, documenting, spatially locating, 
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constructing, and historical recording on a CTDOT Project.  This includes Documents and 
Publications, Geospatial Data, Digital Terrain Models, and Graphics Information. 

Elements – Elements are points or lines which are described geospatially in two or three 
dimensions. 

Features – Features consist of points and lines which may be connected to form geospatial 
objects, and can be used to form the ground surface displayed in a DTM.  Features can be either 
3D triangulated (including elevations) or 2D non-triangulated (without elevation).  Features 
store attribute information about the symbology, level, and text. 

Finished Grade DTM – FG DTM shall include the entire proposed project surface area which will 
be disturbed by construction operations out to all limits of work.  The FG DTM shall be a true 
representation of the entire finished surface that the Designer intends to be built.  The outer 
limits of a project’s DTM shall include all disturbed/modified terrain surfaces that require 
excavation or fill of greater than 6” from the existing ground surface over a 1,000 sqft area. 

Geospatial Data – This information identifies the geographic position and characteristics of 
natural or proposed constructed elements, features and boundaries and how they are 
positioned related to the earth’s surface. 

Graphics Information – Graphical representations of project information portrayed either by 
raster or vector images.  Files include graphical representations of points, lines or shapes, text 
annotation, and images.  CAD files are generally in Bentley Software DGN formats, and include 
all associated reference files. Graphics are generally published in PDF format. 

GPS – Global positioning system, the Global Positioning System (GPS) is a space-based satellite 
navigation system that provides location and time information in all weather, anywhere on or 
near the Earth, where there is an unobstructed line of sight to four or more GPS satellites. It is 
maintained by the United States government and is freely accessible to anyone with a GPS 
receiver. 

GPS Rover – GPS device that collects the data in the field.  Typically consists of a receiver 
(antenna), a fixed rod and a data collector.  The receiver can also be mounted to a vehicle. 

LOD – Level of detail. 

RTK – Real Time Kinematics, Real Time Kinematic (RTK) satellite navigation is a technique used in 
land survey and in hydrographic survey based on the use of carrier phase measurements of the 
GPS, GLONASS and/or Galileo signals where a single reference station provides the real-time 
corrections, providing up to centimeter-level accuracy.  

RTN – Real Time Network is similar to RTK yet it uses a network of base stations located on 
maintenance garages, the internet, satellites and host server software. Though fairly new to the 
U.S., these types of networks have been very successful in Europe and Asia where networks 
span entire countries where utilization is spreading beyond surveying to mapping, utilities, 
emergency response, agriculture, forestry, public safety, transportation, machine control for 
construction, environmental, and scientific research. 

RTS – Robotic Total Station.  This equipment utilizes the same software as the GPS rovers but 
does not rely on satellites for locations.  RTS equipment localizes to a project area by calibrating 

using control points set by traditional survey techniques.   
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 Benefits 
Construction operations which may produce the greatest productivity gains by the use of EED 

are for material excavation or placement.  Construction items which optimize the efficiency and 

accuracy of AMG are earth excavation, fill and subbase courses.  These items are all volume 

measured and their quantities can directly be calculated from the terrain models for the existing 

surface, the finished grade surface, and the top of subgrade surface.   

Other construction installations which would benefit most from providing EED for stakeout and 

inspection verification are bridge substructures, public and private utilities, curbing, sidewalks, 

commercial driveways, signs, lighting & signal posts, and pile driving.  Bridge superstructure and 

substructure layout could be modernized to provide contractors with 2D or 3D spatial 

descriptions (features) of all structural elements and critical control lines.  This information 

could be used by AMG for the excavation of the footings, backfills up to finished grades, by pile 

drivers to position proposed pile locations, by carpenters to automate the layout and building of 

concrete forms, by steel workers to automate the positioning of steel supports and for installing 

of reinforcement, and by DOT Inspectors to verify the correct spatial locations.  

Projects which do not contain 3D DTMs can also benefit from using supplied EED.  Sign or 

guiderail replacements, or pavement striping contracts could benefit from locations derived by 

GIS approximated or GPS field measured 2D coordinates for positional locations.  Using 

geospatially described locations (coordinates) or station-offsets provided by alignment files 

instead of record plan scaled stations and offsets will provide more clearly defined designer 

intent as to the location of the items. 

General: 

• Greater ease of design implementation at time of construction.  

• Enhanced quality of constructed facilities.  

• Greatly reduces the need for construction staking which in turn reduces survey costs 

• Contractor and agency labor savings when measuring and documenting as-built 

quantities and pay-quantity management.  

Design:  

• Increased accuracy and data intelligence going into design.  

• Enhanced visualization capabilities during the design process.  

• Identify clashes and constructability issues prior to construction.  

• Greater accuracy for quantity computations  

Construction:  

• Points or alignments of features can be used by Contractors to locate items in the field 

by using Total Stations or GPS/RTK survey equipment (available in CT).   

• Breaklines, features and other alignments included with digital terrain models (DTMs) 

are used by Contractors for Automated Machine Guidance (AMG) operations.  Use of 

GPS for AMG allows for the most efficient operation of earthwork machinery, less 

operator time is required for construction, idle time and rework.    

• Uniform compaction 

• Check constructability 

• Track stage construction 

• Improved Safety for the inspectors and contractor personnel 

• Equipment resource savings 
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- Machine idle time can be reduced when there is less waiting for excavation and 

embankment staking and clarifications. 

- Finish grading iterations are lessened or nullified because of GPS accuracy, 

therefore resulting in a reduction of machine hours.  

• Earthwork construction tasks are shortened because:  

- Contractors can mobilize to the site and begin work without waiting for 

surveyors to position grade stakes for the initial lifts.  

- Checking grades and rechecking spot locations immediately versus calling and 

scheduling a survey crew.  

- Time saved in layout and grade checking can be devoted to machine movement 

and cycle time efficiency.  

- Reduction in rework - Jobsite grade and location errors are more easily spotted 

and corrected with GPS technology than with reliance upon 2 dimensional 

drawings and surveyor‘s grade stakes.  

- Construction field managers can make decisions more quickly and accurately 

because position and grade information is provided in real time.  

Construction Inspection:  

• Accurate quantity take off for pay-items (point locations, areas, volumes) 

• Pay-items are easily tracked 

• A single person can locate and document exact x,y,z positions providing real-time 

verification of an item being inspected or a point location being disputed.  

• Reduction of conflict resolution time. 

• Electronic as-built data can be produced and easily incorporated on the electronic 

contract plans either during construction (“live” as-builts) or post construction. 
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 Project Location (Geo-Spatial 

Boundary or Route ID and Mileage) 

A Project Polygon (geo-spatial boundary) shall be submitted to ProjectWise at project 
milestones of DA (Design Approval) and DCD (Design Completion Date) by the lead designer and 
at Construction Completion by the Inspector.  The Design Approval submission will replace a 
cursory project polygon created at project development by the project sponsor.  The DCD 
submission will replace the Design Approval submission at DCD.  The construction Completion 
submission is required if the DCD polygon does not reflect the project’s completed limits.  The 
inspector shall obtain the DCD polygon and modify the limits to represent as-built conditions if 
required at construction completion.  
 
The Project Polygons will be used in the Department’s Project Web-GIS feature layer to identify 
spatial location, each section of State and Local Roads contained within the boundary for FHWA 
FMIS reporting, and future CIM (Civil Integrated Management) of roadway assets.  The Project 
Polygon will also aid in the ROW (Right of Way) Web-GIS mapping process.  The Design Approval 
Polygon shall not be public facing on any CTDOT Web-GIS mapping.    

 Project Polygon Requirements 
Capital Projects that include Location Survey 
Note:  If a project has multiple sites, a project polygon file shall be created for each site.   
Project Polygon Milestone Deliveries: 

• DA (Design Approval): 

o The Project Polygon shall include the entire project extents per site and include 

all existing and proposed ROW boundaries and portions of local affected roads.  

The polygon shall be drawn up to and following the ROW lines, then it shall 

cross the roads at the project limits.  The following figure shows a Design 

Approval Polygon.  Note:  The Polygon does not include slope limits. 

 

Figure 338 - Design Approval Project Polygon 
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• DCD (Design Completion Date): 

o The Project Polygon shall include the entire project extents per site and include 

all ROW boundaries and portions of local affected roads. The polygon shall be 

drawn up to and following the right of way lines.  When Rights and/or Defined 

Easements extend beyond the ROW, these lines shall be followed.  The polygon 

shall cross the roads at the project limits.  

 

Figure 339 - DCD Project Polygon 

 

• Construction Completion: 

o The inspector shall obtain the DCD polygon and modify the limits to represent 

as-built conditions if required at construction completion.  See Section 8.3.7 for 

more detail. 

Capital Projects without Location Survey 
This type of project could involve, but not limited to the following:  

• Guard rail replacement 

• Rumble Strips 

• Barrier replacement 

• Pavement rehabilitation 

• Illumination  

• Signing 

The project limits will be identified By Route ID and Mileage.  AEC Applications will get the route 
and mileage from the project’s Design Report.  Note:  An option to get authoritative mileages for 
the Design Report can be to reference in a WMS (web mapping service) into Bentley Software.  
See section 13.4 for instructions.     
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 Creating a Project Polygon for Projects with 

Location Survey 
The following steps explain how to create and submit the Project Polygon file(s).  If the project 
consists of multiple “sites,” a separate file shall be created for each polygon. 

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be 
referenced.  This can usually be found within the ground survey file title block.  If there 
is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.   

2. In House CTDOT Users:  Create a new Bentley Software design file using the 
2D_Poly_83FT seed file located in the W: Drive.  See folder address below: 
 
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\  
 

Note: If your project is NAD 27 FT still use the 83FT seed.   
 

 
Figure 340 – CTDOT CAD resource folders 

 
Consultant Users:  Download the seed files using this link: 2D_Poly_83FT Seed File 

3. Reference the Highway Design file into the newly created file using true scale off and 
1:1 

 
Figure 341 – Bentley Software reference file settings 

https://portal.ct.gov/-/media/DOT/documents/AEC/2d_poly_83ft.zip


 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 280 Version 5.01 
     

4. Verify that the tentative coordinates of this file match the referenced design (using 
stationing, grids, etc.).  If your project is in NAD 83FT the coordinates should match and 
you can proceed to step 5.  If they do not match check that the scale of the reference is 
1:1.   

 
If the coordinates still do not match, the project is probably in NAD 27 FT and the 
reference files will have to be moved so the coordinates are correct.  To move the 
reference file do the following: 

a. Select Reference File. 
b. Select Move Reference: 

 

Figure 342 - Move Reference 

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box   
key in XY=0,0 and click Enter. 

 

Figure 343 - Key In 
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d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the 
Key-In Box key in DL=400124.9,500038.9. 

 

Figure 344 - Move to Key In 

Now the tentative coordinates of this file should match the referenced design (using stationing, 
grids, etc.).   
 

5. Set the Bentley Software active level to “TOOL_Prelim_Proj_Polygon” for the Project 
Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”) 

6. Then place a closed polygon(s) using the shape tool or the smart line tool.  
7. Then turn on the fill on the polygon.  
8. After the polygon has been placed, turn off all reference displays and fit the polygon to 

the view. 
9. Verify that the polygon is spatially correct by exporting the Bentley Software file as a 

kml file to Google Earth.   
Do this by choosing: File> Export> Google Earth.   

10. Google Earth should then automatically open and zoom to the Project Polygon(s) 
vicinity. 
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 Project Polygon File(s) Submission 
The Project Polygon file(s) shall then be uploaded into ProjectWise in accordance with the 
following: 
Note:  If a project has multiple sites, a project polygon file shall be created for each site.   

1. Log into ProjectWise 
2. Browse to your project’s 170_ROW and GIS Files folder.  If this folder does not exist 

under the project email DOT.AECApplications@ct.gov  
3. Select the Interface, “CTDOT_Doc_Code.”  If the interface box is not shown, select: 

View>Toolbars and select interface 
4. Drag and drop the file into ProjectWise and use the Advanced Wizard. 
5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and 

assign the attributes. 
6. Click Next until the file uploads.  
7. After the files have been uploaded into ProjectWise email 

DOT.AECApplications@ct.gov   

 

Figure 345 – ProjectWise project polygon folder example 

 
 
 
 
 
 
 
 
 
 

mailto:DOT.AECApplications@ct.gov
mailto:DOT.AECApplications@ct.gov
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 Project Route ID and Mileage for Projects 

without Location Survey 
The following steps show how to get the route ID and Mileage for a project from within.   

1. In House CTDOT Users:  Create a new Bentley Software design file using the 
2D_Poly_83FT seed file located in the W: Drive.  See folder address below: 
 
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\  

 

 
Figure 346 – CTDOT CAD resource folders 

 
Consultant Users:  Download the seed files using this link: 2D_Poly_83FT Seed File 
 

2. Next go the raster manager and navigate to File>Attach>WMS 

 

Figure 347 - Attaching the WMS 

 
 
 
 
 
 

https://portal.ct.gov/-/media/DOT/documents/AEC/2d_poly_83ft.zip
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3. The attach file dialogue should appear.  In-House Designers Browse to W:\XWMS and 

select the Interstate Milepoints and the Non-Interstate Milepoints layer.  Note this will 
have to be done one at a time.   Then click Attach in the Raster Attachment Options 
Dialogue.   Consultant Designers the WMS files can be found here: XWMS Files 
 

 

Figure 348 - Attaching WMS 

 

Figure 349 - Attaching WMS 

http://www.ct.gov/dot/lib/dot/documents/aec/xwms.zip
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4. You will need to zoom in to see the Route Numbers and Milepoints.   

 

Figure 350 - Route and Mileage 
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  Project Information Management 

– Under Development 

This section details how project locations, project assets, project asset work codes, and other 
project information is managed throughout the life cycle of the project.  The project location 
and the assignment of assets to a project are managed in ATLAS.  The project asset work codes 
and other project information is in managed in the Composite Project Database (CPD).   
 
The first section goes over the Proposed Project Information process (PPI), which includes 
locating the proposed project, filling out the PPI form, and how a proposed project container in 
ProjectWise is created.   
 
The second section goes over how to manage the project location and project information after 
the proposed project receives is recommended project number.   

 Digital Proposed Project Information Process 

The following details how to locate a proposed project and select the applicable assets on the 
project using ATLAS.   

1. Go to the ATLAS webpage - https://atlas.dot.ct.gov  
2. Then at the top right of the screen click Login and enter your email and password.  If 

this is your first time logging in, select “Click here to sign up”.   
 

 

Figure 351 - Logging into ATLAS 

 
3. Next navigate to the area on the map where the proposed project is located.   

 
 
 
 
 
 
 
 
 

https://atlas.dot.ct.gov/
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4. Then click on Asset Maintenance and select Add/Edit Construction Project Work Area. 

 

Figure 352 - Locating a Proposed Project 

5. Then in the Town dropdown, select Use Work Area and click next.    
 

 

Figure 353 - Locating a Proposed Project 
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6. Next pick how to locate the project in accordance with the following and click Next: 

• By Administrative Area – District or Statewide Projects.  Stop Sign 
replacements, warning sign replacements, etc.   

• Related to bridge(s) and/or signal(s) – Bridge joint or bearing projects affecting 
multiple bridges or traffic signal head upgrades affecting multiple signal 
locations, etc.  

• I’ll draw a polygon – Intersection improvement projects, bridge replacement 
projects, roadway improvement projects, etc.  These projects could be at 
multiple locations.  
 

In the example below a polygon is going to be drawn for the proposed project.  

 

Figure 354 - Locating a Proposed Project 
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7. Then draw a polygon for the proposed project by left clicking.  To close the polygon 
double click when you are on your last point.  If the polygon needs to be adjusted you 
can redraw the polygon before you click GO.   

 
This polygon should be drawn close to the State ROW line.  Use engineering judgement 
for where you think the ROW line is.  Future enhancements to ATLAS will have all the 
state ROW lines on a layer.   

 

Figure 355 - Locating a Proposed Project 

8. Then click Go. 

 

Figure 356 - Locating a Proposed Project 
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9. When the polygon is drawn ATLAS will return any road segments and any assets that 

are located within that polygon.  On the next screen deselect or select the applicable 
road segments and assets, then click next.  By default the local roads are not selected.   

 

Figure 357 - Locating a Proposed Project 

10. Then on the next screen click Go. 

 

Figure 358 - Locating a Proposed Project 
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11. On the next screen you will see the proposed project number that ATLAS assigned to 
the project and list of assets and road segments included in this project.  Then click 
Done. 

 

Figure 359 - Locating a Proposed Project 

The following details how to edit the location or Assets of a Proposed Project. 
1. Go to the ATLAS webpage - http://ec2-54-175-159-39.compute-

1.amazonaws.com/atlas/ 
2. Then at the top right of the screen click Login and enter your email and password.   

 

 

Figure 360 - Logging into ATLAS 

 
 
 
 
 

http://ec2-54-175-159-39.compute-1.amazonaws.com/atlas/
http://ec2-54-175-159-39.compute-1.amazonaws.com/atlas/
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3. Then turn on the Proposed Project Local Work Area layer as shown below.   

 

Figure 361 - Proposed Project Layer 

4. Next navigate to the area on the map where the proposed project is located.   
5. Then select the Identify tool. 

 

Figure 362 - Proposed Project Location 

6. Then draw a rectangle that includes part of the project. 

 

Figure 363 - Proposed Project Location 

7. On the next screen choose the applicable option. 
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• To add or remove a road segment or asset select “Roads and Assets” 

• If the polygon needs to be extended or shortened select “Redraw Area” 

 

Figure 364 - Editing a Proposed Project Location 

8. Based on what was selected in step 7, either select or deselect the assets or redraw the 
polygon.   Then click through the screens until the project location is updated. 

After a proposed project has been located a Proposed Project Information Form (PPI) will 
automatically be created in CPD.  This section shows how to fill out this form and submit for 
review and approval.  If you do not know the proposed project number follow section 14.1.2 
and when you get to step 7 click on the CPD link.  This will automatically get you to that project 
in the CPD.   

1. Go to the CPD Website:  http://dot-sdcdts303v/PW_CompositeData/MainMenu.aspx 
Note:  To access the CPD the user will need to be on the CTDOT Network.  

2. Then click on Proposed Project Information. 

 

Figure 365 - Proposed Project Information 

 
 
 
 

http://dot-sdcdts303v/PW_CompositeData/MainMenu.aspx
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3. Select the PPI number that needs to be updated. 

 

Figure 366 - Updating a PPI Form 

4. Next fill in any of the fields in the form and click the save project data button.   

 

Figure 367 - Saving Project Data 

When this button is clicked a ProjectWise project container will be created under the 01.2 – 
Projects – Proposed area in ProjectWise.  This will take about 5 minutes to show up in 
ProjectWise.  This folder will be used to store any document during the proposed project phase 
of the project.  This folder is also where the completed PPI form will uploaded for signature.   

 

Figure 368 - Proposed Project Area in ProjectWise 

5. The following steps show how to complete the PPI form for capital planning.  Note:  If 
an asset needs to be added or removed this must be done in ATLAS. Go to ATLAS by 
clicking on the ATLAS Link. 
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Figure 369 - Updating Assets for a PPIF 

6.   First fill out the General Information.   

 

Figure 370 - PPI Form General Area 

7. Then fill out the Environmental Classification, Cost Estimate Information, Schedule 
Information, and add any comments.  

 

Figure 371 - PPI Form 

 
8. Then verify the proposed road section information.  If information needs to be edited, 

click on Select and edit the information.   
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Figure 372 - PPI Form Road Section Area 

9. Then fill out the Asset information.  Select if there is a pavement treatment and enter 
any bridge work codes if there is a bridge on the project by clicking on Select next to 
the bridge.   

 

Figure 373 - PPI Form Asset Area 

10. After the form is completed print the form to PDF.  First click on the printer and then 
print. 

 

Figure 374 - Printing to PDF 

 
11. Then select the Bluebeam Printer and click Print. 
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Figure 375 - Printing to PDF 

12. Then save the file to your computer.   
13. Next open the file and add the following four signature fields for approvals.  

 

Figure 376 - PPI Form Approval Area 

14. Then upload the PPI form into the corresponding proposed project folder in 
ProjectWise.   Fill in the label and description attribute fields with PPI Form for the 
label and a project description in the description field. 

 

Figure 377 - PPI Form Upload 

15. Next have the form digitally signed by the submitter, Principal Engineer, Manger, and 
Engineering Administrator by sending a ProjectWise link to the PPI form. 

All documents created during the proposed project stage shall be stored under that proposed 
project’s container in ProjectWise in the 01.02 – Projects – Proposed area.   
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Figure 378 - Proposed Project Area in ProjectWise 

After the proposed project moves through the Recommended Project Memorandum (RPM) 
process and an official project number is assigned to that project, all the documents in the 
proposed project area shall be moved to the 600_Project Initiation Documents folder under the 
project container in the 01.0 – Projects – Active area in ProjectWise.  

 

Figure 379 - Project Initiation Documents in ProjectWise 

 Project Asset Form (PAF) – Under Development 
The project asset form (PAF) is used to manage project information after the RPM process 
through construction.  This form manages the following information: 
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• Project Assets through the use of ATLAS 

• Project Asset Work Codes 
At RPM the Project Assets and Asset work codes will be transferred to the PAF from the 
Proposed Project Information Form (PPIF).   
 
The PAF is required to be continuously updated as changes happen through the duration of the 
project.   
 
The following details how to update the PAF. 
 

1. Go to the CPD Website:  http://dot-sdcdts303v/PW_CompositeData/MainMenu.aspx  
2. Then click on the Project Asset Form Button: 

 

Figure 380 - Project Asset Form 

3. Next pick the project that needs to be updated: 

 

Figure 381 - Project Asset Form 

4. Then update the Project Asset Area in accordance with the following: 

• Updating Asset Works Codes:  Click on Select next to the appropriate asset and 
then fill in the work codes.  

http://dot-sdcdts303v/PW_CompositeData/MainMenu.aspx
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Figure 382 - Asset Work Codes 

• Adding or Removing an Asset from the Project:  Send an email to 
DOT.AECApplications@ct.gov detailing the asset and if it is added or removed.   

5. After the PAF has been updated click on the Save Project Data button at the top right 
of the form.   

 

Figure 383 - Project Asset Form 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

mailto:DOT.AECApplications@ct.gov
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Appendix A - Initial Bluebeam Settings 

Initial Log into Bluebeam 
These steps only need to be completed the first time using Bluebeam or when the user logs into 
a new computer. 

1. Open Bluebeam by selecting the desktop icon:            

2. Then Open Bluebeam by double clicking on the shortcut. 

3. Click on REVU in the top left hand corner and click Preferences as shown below.  If you 
cannot find the settings icon in the top right, go to the Edit menu and select 
Preferences.    

 

Figure 384 - Bluebeam Preferences 
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4. Set the General options first. 

 

Figure 385 - General Options 

5. Click on Interface and then File Access and make sure the box is checked as shown below:  If 

ProjectWise is not listed click the plus sign, click Load, enter your ProjectWise Username and 

password and click OK.

 

Figure 386 - ProjectWise Integration 
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6. Next go to the Window option and select WebTab.  Then uncheck the box below. 

 

Figure 387 - Bluebeam Preferences 

Downloading the CTDOT Bluebeam Profile 
1. Download this file and save it to your desktop: CTDOT Bluebeam Profile 

2. Double click on the profile in the zipped folder on your desktop. 

 

Figure 388 - Importing the Bluebeam Tools 

Bluebeam Stamps 
The following steps are for CTDOT Engineering only.   
1. Select Markup>Stamp>Change  Stamp folder as shown below: 

https://portal.ct.gov/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
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Figure 389 - Changing the Stamp Folder 

 
2. Next browse out to this folder on the X: Drive and select your discipline 

X:\V8_Admin\Bluebeam Resources 

 

Figure 390 - Changing the Stamp Folder 

3.  Now your unit’s stamps will be available for use when Markup>Stamps is selected: 
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Figure 391 - Changing the Stamp Folder 
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Appendix B - Usability of PDF Documents 

Usability of PDF Documents  
This section contains information about viewing digital contract documents.   

Structure of Digital Plans  
Final Design Plans, Addendums, and Design Initiated Change Orders 
The contract plans are split up into discipline subsets, which are multiple sheet PDF documents 
digitally signed by the Designer.  Addendums and Change Orders are also submitted as discipline 
subset, with only the changed sheets.  For example, an Addendum that affects the 03-Bridge 
Subset will require the submission of a 03-Bridge_A1 subset.    
 
Digital Plans are located in the 100_Contract_Plans folder in ProjectWise.  Below is an example 
of a project’s discipline subsets in ProjectWise: 
 

 

Figure 392 - Discipline Subsets in ProjectWise 

As-Built’s 
As-built’s will be placed directly on the PDF Subsets using Bluebeam. 

Functionality of PDF Digital Plans 
The PDF digital plans have the following functions when the digital contract plans are created in 
accordance with this manual: 
Turn levels on and off  
Search for all text on the documents.   
PDF plans are measurable  
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The plans have the ability to have their levels turned off and on.  This can allow for easier 
viewing of the contract sheets.   See below for turning levels on and off: 
 

 

Figure 393 - Turning Levels On and Off 
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The plans can be searched for any text located on them.  This can be useful if searching for a 
certain pay item.   
 
See below for searching the PDF Plans for text.   
 

 

Figure 394 - Searching for Text in PDF Plans 
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Measuring on the Digital Plans 
The plans have the ability to be measured in PDF.  This is helpful because a paper set does not 
need to be created for on desk measuring.   
 
See below for measuring in PDF. 

 

Figure 395 - Measuring Tool 
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Digital Specification 
The FDP specification package will be one PDF document and located in the 
110_Contract_Special provisions folder.  This package includes all special provisions, Notice to 
Contractors, Wage information, etc.   
 
The Addendum special provisions prepared in the same way as the FDP specification package 
and will also be located in the 110_Contract Special provisions folder. 
 
The Design Initiated Change Order special provisions will be contained in one PDF document 
located in the 110_Contract Special provisions folder when they are released to the Contractor. 
 
Some useful features on the digital specification package are: 

• Search for any text in the document, see Searching Digital Plans 

• Bookmarks for each section in the specification package 
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Figure 396 - Bookmarks in the Spec. Package 

Document Compare Tools 
Bluebeam has the two tools for comparing documents:  (1) Compare Documents and (2) Overlay 
Pages.  Compare Documents will compare two documents and create a third document that 
clouds all the changes.  Overlay pages will create a third document where the pages of 
document A will become one color and the pages of document be will become another color.  
When the pages are overlaid you will be able to see the changes from the difference in these 
two colors.  Both of these tools can be used for single and multipage PDF documents.  The 
following shows how to perform a document compare and how to use the overlay page tool. 
 
Document Compare 

1. Open the Revised document first and then open the original document that you want to 
compare from ProjectWise or your computer.   

2. Next go to Document>Comparison>Compare Documents as shown below: 
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Figure 397 - Compare Documents 

3. In the window that pops up you will notice the two documents that were just opened.  
Click OK to run the document compare as shown below: 

 

Figure 398 - document Compare 

Overlay Pages 

1. Open the Revised document first and then open the original document that you want to 
compare from ProjectWise or your computer.  

2. Next go to Document>Comparison>Overlay pages as shown below: 
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Figure 399 - Overlay Pages 

3. In the window that pops up you will need to select which pages of each document you 
want to overlay.  To do this double click on a file, then in the window that pops up type 
the pages you want to overlay.  The example below shows pages 1-28.  Once you select 
the pages you want to overlay click OK. 

 

Figure 400 - Overlay Pages 

 

Figure 401 - Overlay Pages 
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Appendix C - Using the Set File 

Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature 
in Bluebeam.   

Opening the Set File 
Double click on the set file from ProjectWise and open as shown below:  This may take a while 

please be patient.  Note: The first time opening a set file will take longer than any subsequent 

times.  

 

Figure 402 - Opening a Set File 

Viewing the Plans Sheets within a Set File 
All the plans sheets will be combined and shown on the left hand side of the screen in a 
thumbnail view.  To view a sheet, simply click on that sheet and it will open up. 

 

Figure 403 - Viewing a Plan Sheet from a Set File 
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Marking Up a Set File 
1. Open up the set file.  You will notice on the left hand side of the screen will be 

thumbnails of all the sheets in the set file.   

 

Figure 404 - Sheets in the Set File 
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2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it.  

You will notice that sheet opens up on the right: 

 

Figure 405 - Marking Up a Sheet 
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3. Next to markup the document we must unlock it (Check Out of ProjectWise).  To do this, 

right click on the lock and select Check Out. 

 

Figure 406 - Checking Out a Document 

4. Notice the lock changes to a Check and you will be able to markup the document. 

 

Figure 407 - Checking Out a Document for Editing 

5. To mark up the plans use the tools located in the tool chest shown below:  
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Figure 408 - Marking up the Plan Sheets 

 
6. When finished, click Save and then right click on the Check and select “Check In”. 

 

Figure 409 - Saving Markups and Checking Into ProjectWise 
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Searching a Set File 
 
The Set feature in Bluebeam allows you to search across the entire set file.  The following shows 
how to search a set file: 

1. Click on the Search Set file icon and then type in what you want to search for as shown 

below: 

 

Figure 410 - Searching the Set File 

Printing the Entire Set File 
Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions.  
Printing the entire set will print all the sheets in the set file.  Printing the latest revisions will 
print the most up to date sheets and not print the previous revisions.  Printing the previous 
revisions will only print the sheets that were changed by a revision.   
The following shows how print a set file: 

1. Select the print set file icon and select the desired option: 
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Figure 411 - Printing a Set File 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 321 Version 5.01 
     

Appendix D – Consultant Submittal Review 

Stamps 

Consultant Designers can import the Bluebeam User Profile using the following link.  This profile 
imports all the commenting tools in the correct format.   
Download the profile from this link: CTDOT Bluebeam User Profile.  Just double click on the file 
located in the zip file and the profile will be imported.   
After the profile is imported the following must be done. 

1. Delete the Submittal Review stamp that is in the tool chest as shown below: 

 

Figure 412 - Deleting the Stamp 

2. Next Consultant Designers will need to save the following stamps to their computer and 

edit it to add their company name and address.  The following will show how to do that: 

3. This file contains the Designer’s Review stamp and Action Stamp.  Save these stamp files 

to your computer in a folder somewhere called Bluebeam Stamps.  Note:  The stamp 

files will be a PDF- Consultant Submittal Review Stamp 

 

 

 

https://portal.ct.gov/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
https://portal.ct.gov/-/media/DOT/documents/AEC/ContractorSubmittalReviewStamps.zip
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4. Open the stamp files using Bluebeam. 

5. Update the Company Name and Address on both the Action stamp and the Designer’s 

Review stamp as shown below: 

 

Figure 413 - Updating Stamp for Company Name and Address 

After the company name and address is updated it should look like the following: 

 

Figure 414 - Updated Stamp 
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6. After the stamps have been updated click save.   

7. Next go to Markup>Stamp> and Select Change Stamp Folder.   

 

Figure 415 - Changing the Stamp Folder 

8. Browse out to where the stamps had been saved and click OK: 

 

Figure 416 - Browsing to the Stamp 

9. Now when you click on Markup>Stamp the stamps will be in the list. 
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10. Next go into the tool chest and open the “Recent tools” as shown below: 

 

Figure 417 - Bluebeam Recent Tools 

11. Now place the stamps on any PDF document by selecting it in Markup>Stamp as shown 

below: 

 

Figure 418 - Placing a Stamp in Bluebeam 
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12. After the stamps have been placed you will see them in the recent tools.  Drag them 

from the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown 

below: 

 

Figure 419 - Adding the Custom Stamp to the Tool Chest 

13. Then Save Profile so the stamps will always be in the Tool Chest. 

 

Figure 420 - Saving Bluebeam Profile 
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Appendix E – COMPASS Resources 

A. COMPASS Training Resources 
The following resources are available for users to enhance their knowledge of MS Project 
Online, SharePoint and other Office 365 products. 
 
COMPASS Knowledge Center:  Website with Support resources and program updates. 
 
MS Project Online:  https://support.office.com/en-us/article/Projects-Tasks-b9766811-9f5f-
4bca-ac9c-202a183a1656#ID0EAABAAA=Projects 

B. COMPASS Data Sources and Computations 
The following table identifies the data source and / or computation of each item listed below. 

 ITEM DATA SOURCE(S) COMPUTATION(S) 

 

Town data Project Asset Form – 
“Location Towns” 

 

Project Description CORE – “Project 
Description” 

 

D
ET

A
IL

S 
P

A
G

E 

Project Title CORE – “Project Title”  

Tasks Count MS Project Schedule – 
total number of tasks 

 

Project Health  Average of Project Schedule and 
Budget scores 

ROW Expenditures ViewPort  

Construction Expenditures ViewPort, Site Manager  

PE Expenditures ViewPort  

ROW Estimated Budget ViewPort  

Construction Estimate 
Budget 

ViewPort  

PE Estimated Budget Obligation Plan  

Schedule Phase  RPM date, Design Approval date, 
FDP date, CCD date 

Schedule Milestones MS Project Schedule  

Permits ESTP  

ROW and Acquisitions Data IRMS  

EX
EC

U
TI

V
E 

D
A

SH
B

O
A

R
D

 

Overall Projects Score  Rounded average of all project 
health scores 

> 9 = Green / Good 
7-8.9 = Yellow / At Risk 
< 7 = Red / Poor 

Projects Health  Average of all Project Schedule 
and Budget scores 

> 89% = Green / Good 
70-89% = Yellow / At Risk 
< 70% = Red / Poor 

Budgets  Sum of outstanding projects 
> 95% = Red / Poor 
80-95% = Yellow / At Risk 
< 79% = Green / Good 

Schedule  Average of all past due project 

https://www.dotdata.ct.gov/Compass/support.html
https://support.office.com/en-us/article/Projects-Tasks-b9766811-9f5f-4bca-ac9c-202a183a1656#ID0EAABAAA=Projects
https://support.office.com/en-us/article/Projects-Tasks-b9766811-9f5f-4bca-ac9c-202a183a1656#ID0EAABAAA=Projects
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 ITEM DATA SOURCE(S) COMPUTATION(S) 

milestones 
> 89% = Green / Good 
70-89% = Yellow / At Risk 
< 70% = Red / Poor 

 

C. COMPASS Best Practices 

All project staff – including project managers, reviewers, designers, consultants, contractors, etc. 
– should monitor their COMPASS accounts daily to assess Ball-In-Court statuses and ensure 
there is no lag in reviewing and routing submittals. 

File names should not exceed 50 characters in length.  Characters include letters, numbers, 
symbols and spaces.  Submittal and file names should not contain any of the following restricted 
characters:  

~ “ # % & * : < > ? / \ { | }   
Submittal names should accurately describe the contents of the submittal. 
Individual file document names should be in the following format: 
 

Project Number [####-####] Submittal Type [WD, SD, RFI ###, RFC ###, etc.] [Description] 
Examples: 

1234-5678 WD Access Platform  
1234-5678 SD Exodermic Precast Panel 

1234-5678 RFI 001 Structural Steel 
1234-5678 Letter from Smith to Jones Winter Work 

If the submittal owner returns a shop drawing submittal with different dispositions stamped on 
each sheet, the Submitter / Contractor shall revise individual sheets as needed.  When the 
replacement document is ready to submit, the Submitter / Contractor shall combine into one 
file the approved sheets and replacement sheets.   

When an submittal owner returns a submittal via the Revise and Resubmit function, comments 
should be included to focus and guide the revision process.  For example, if a submittal contains 
three documents, two of which are accepted and one of which requires revision, the following 
details would be appropriate to provide in the pop-up comment box: 
 Submittal reviewed. 
 Two of three documents accepted. 
 One document to revise and resubmit. 
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D. COMPASS Frequently Asked Questions 

Devices 
COMPASS can be accessed through a desktop computer, laptop computer, tablet or mobile 
phone.  The device must have internet access.  For details on ensuring access to the COMPASS 
website, see Trusted Sites.  

Software Requirements 
COMPASS is a cloud-based application built on Microsoft SharePoint pages.  The following 
software and account requirements are necessary for CTDOT and Consultant users to 
experience full functionality of the COMPASS S&T application, including reviewing and routing 
Contractor submittals: 

• Office 365 / Microsoft online account 

• Project-specific access to COMPASS 

• Bluebeam Studio account (Site Owners and Submittal Owners only) 

• Bluebeam desktop application 

Maximum File Size 
SharePoint has a maximum file size of 250 MB.  This applies to individual file attachments and 
documents uploaded directly into the Internal Documents or Documents folders.  If a document 
exceeds this maximum, the user can break it up into multiple documents contained within the 
same submittal. 

E. COMPASS Troubleshooting 

Below is a list of troubleshooting tips for users to implement if problems are encountered when 
trying to access COMPASS: 

• Confirm the user has the proper permissions to access the project. 

• Confirm the correct log-in name and password are used. 

• Confirm all Trusted Sites are added. 

• Completely sign out of Office 365 and COMPASS, then log back in. 

• Press CTRL+F5 to perform a hard refresh on the page. 

• Delete the browser history and cache. 

• Verify with local IT support that there are no firewalls, securities or other issues that 

would interfere with connecting to COMPASS. 

• Attempt access using more than one web browser. 

Problem:  I need to reset my Office 365 sign in password. 
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Figure 421 - Reset Password 

Solution:  CTDOT users cannot reset their passwords via the “reset it now” default prompt that 
comes with O365.  See Office 365 Login Instructions for sign in name and password information. 

Problem:  When I sign in to Office 365, I do not have any apps. 

 

Figure 422 - O365 Apps 

Solution:  Ensure the correct Office 365 Sign In credentials are inputted to access all the 
applications available with the CTDOT O365 license. 

Problem:  When I log-in to COMPASS, all I see is the COMPASS header and a spinning wheel that 
says “Loading Projects.” 
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Figure 423 - Loading Projects 

Solution:  Add COMPASS Trusted Sites to Internet Explorer web browser. 

Problem:  When I press the MS Project button in my COMPASS project, nothing happens.   

 

Figure 424 - MS Project does not Work 

Solution:  If the MS Project button does not open a schedule,  
1. Confirm with the PM that an MS Project schedule is attached to the COMPASS project 

site.  See Open MS Project from COMPASS PWA Site for instructions. 

2. Confirm that the user trying to access the schedule has an MS Project Online license.  

Contact Chris Smith in AEC Applications with any MS Project questions. 

Bluebeam Studio Session Finalization Process 
In order to maintain the Bluebeam integration with COMPASS, Studio Sessions should only be 
finalized via COMPASS as shown below and described in the Finalize Bluebeam Studio Session 
section.  Bluebeam Studio Sessions should not be finalized directly inside the Bluebeam Studio 
Session. 

YES: 

 

Figure 425 - Closing a Studio Session 
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NO:  

  

Figure 426 - Closing a Studio Session 

Bluebeam Studio Session Expiration Date 
A Bluebeam Studio Session created through COMPASS is set to expire by default one month 
after its creation.  If additional time is needed a user can either finalize the Session and launch a 
new one within COMPASS or extend the Session’s expiration date.   
To extend the Session’s expiration date: 
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Figure 427 - Studio Session Settings 

Restoring Archived Bluebeam Studio Session 
Only the user who started a Bluebeam Studio Session can restore the Session if it becomes 
archived.  The below information is only applicable within 30 days of a Session being archived.  
Bluebeam fully purges Studio Sessions from its server that have been closed in excess of 30 
days. 

1) Hover of the document link in COMPASS to identify the Bluebeam Studio Session ID. 

 

Figure 428 - Restoring a Studio Session 

2) Navigate to https://studio.bluebeam.com and enter the Session host’s log-in 

credentials. 

https://studio.bluebeam.com/
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Figure 429 - Studio Log In 

3) Locate and click on the archived Studio Session. 

 

Figure 430 - Restoring a Studio Session 

4) Change the status to Active, then Update data. 
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Figure 431 - Restoring a Studio Session 

Now the Session can be finalized inside COMPASS and the document in COMPASS will reflect 
any changes made in the Session. 

Edits not saving in COMPASS 
Q:  I set-up the integration, but changes are not being saved. 
A:  Manually map the SharePoint interface.  Open Preferences with CTRL+K. 

 

Figure 432 - Bluebeam Integration 
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Figure 433 - Bluebeam Integration 

PDF Documents Not Opening in Bluebeam 
Q:  I set-up the integration and am using Internet Explorer, but PDFs in SharePoint are still 
opening in the browser instead of Bluebeam. 
A:  Disable the Adobe Internet Explorer plug-in. 

 

Figure 434 - PDF Documents 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued April 2020 336 Version 5.01 
     

 

Figure 435 - PDF Documents 

Q:  I was incorrectly assigned Owner of a submittal.  What should I do? 
A:  The two most common reasons a submittal is assigned improperly are that the project PM 
incorrectly completed the Approval Matrix, or the Submitter / Contractor selected the incorrect 
Submittal type in the Document Submittal page.  If this occurs, do not Start the review session.  
First, check with the PM to ensure the Approval Matrix is properly set-up.  If this is confirmed, 
press Revise and Resubmit; in the comment pop-up box provide instructions to the Submitter / 
Contractor to select the correct Submittal Type in the drop-down menu.     

Q:  Information in COMPASS is incorrect.  How do I fix this data? 
A:  Alert the project PM to the incorrect information.  Take screen shots if possible.  The 
majority of the data found in COMPASS (e.g., finances, schedules, ROW, etc.) is pulled from 
source locations such as CORE.  The Staff names and Approval Matrix are manually inputted by 
the PM.  If there are errors in the data, the PM needs to correct manually inputted information 
or request a correction in the data source from which COMPASS is pulling information. 

To follow a COMPASS Submittal / Transmittal Pilot Project Site: 
1. Navigate to the Submittal / Transmittal page of the given pilot project. 

2. In the upper right hand corner of the screen, click Follow. 
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Figure 436 - Follow Projects 

3. When accessing the SharePoint Online dashboard, the project site will be listed in the 

Following section.  Clicking on the project number will route the user directly to the pilot 

project S&T page. 

 

Figure 437 - Projects that you Follow 

F. Data Dictionary – S & T Table 
COLUMN HEADINGS 

Column Description 

Submittal Submitter / Contractor enters manually in the “Submittal Name” field on 
the Document Submittal Page 

Sub Type Submitter / Contractor selects from “Submittal Type” drop-down list on 
the Document Submittal Page 

Item No. Optional.  Submitter / Contractor selects from “Item Number” project-
specific drop-down list on the Document Submittal Page.  One or more 
items can be selected. 

Review Status Updates automatically.  Identifies status of the submittal in the 
workflow.  Does not provide the Department’s disposition on the 
submittal or the documents contained therein. 

Ball In Court Updates automatically.  Identifies the person(s) responsible for taking 
the next action in the workflow.   

Submittal Date Auto-populates when the Submittal is first initiated. 

Final Due Date Owner sets Due Date on the Process Assignment Page 

REVIEW STATUS COLUMN 

Status Description 

Process Assignment First status to appear after a new submittal is added.  Based on the 
Approval Matrix, COMPASS automatically assigns the submittal owner to 
set-up the review process and schedule. 

In Review (# of #) Shows that the submittal is in review and identifies number of steps in 
the review series.  Submittal Owner is the final reviewer by default. 

Revise and Resubmit Alerts Submitter / Contractor to requested revisions.  Submitter / 
Contractor to review comments and/or marked-up documents. 
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Send Back Assigned reviewer declines the Owner’s review request and returns the 
submittal back to the Owner.   

Complete Review process is complete.  Submitter / Contractor to review comments 
and/or marked-up documents for the Department’s disposition. 

Draft A submittal is saved in draft form.  The submittal has not been advanced 
in the workflow but is available for the user to edit and process.   

 

G. COMPASS Support 

District COMPASS Rep. Email Phone 

District 1 Sabrina Pace   
Darlene Salokas 

sabrina.pace@ct.gov 
darlene.salokas@ct.gov 

860-258-4668 
860-258-4644 

District 2 Jim Paul 
Matthew Collins 

jim.paul@ct.gov 
matthew.collins@ct.gov 

860-823-3269 
860-823-3275 

District 3 Steve Hebert 
Aliaksei Sidarenka 

steven.hebert@ct.gov 
aliaksei.sidarenka@ct.gov 

203-389-3154 
203-389-3177 

District 4 Shawn Beaulieu 
Jason Cichon 

shawn.beaulieu@ct.gov 
jason.cichon@ct.gov 

203-232-5786 
203-591-3575 

District 5 Jennifer Sweeney 
Basel Hashem 
Sal Hussein 

jennifer.sweeney@ct.gov 
basel.hashem@ct.gov 
shalal.hussein@ct.gov 

203-401-5170 
203-401-5169 

OOC Doug Harz 
John Rorrio 

douglas.harz@ct.gov 
john.rorrio@ct.gov 

860-594-2681 
860-258-4643 

Name Email Phone 
Bruce Bourgoin bruce.bourgoin@ct.gov 860-594-2760 
John Dudzinski john.dudzinski@ct.gov 860-594-3196 
Julie Annino julie.annino@ct.gov 860-594-2730 
Chris Smith christopher.d.smith@ct.gov 860-594-2724 
Lynne Lofberg lynne.lofberg@ct.gov 860-594-3201 
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Appendix F – Bluebeam 2016 Integration 

To set-up the SharePoint / Internet Explorer integration using Bluebeam 2016: 
1. From the Start menu, open Bluebeam Administrator 2016. 

 
2. Select the Revu tab 

 
3. Check the box to Display PDF in Internet Explorer 

 
4. Select Apply 

 
5. Select OK to close the Bluebeam Administrator window 
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6. After setting up the PDF settings, use Internet Explorer to navigate to the correct 

submittal in the Submittals/Transmittals table. 
 

7. Select the preferred PDF submittal document. 
 

8. The PDF will open in an Internet Explorer viewer. 
 

9. Select the Bluebeam Revu button in the menu bar. 
 

 
10. A window may display, indicating that Bluebeam Revu is Communicating with 

SharePoint (COMPASS pages). 
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11. A Microsoft sign-in window will appear. Input the same Office 365 / Microsoft Online 
Sign-In information used to access COMPASS. 

 

 
12. A window titled SharePoint Open from Web Browser will appear. Select the Check Out 

& Open button. 

 
 

13. The document will open in Bluebeam Revu. The user can then edit, mark-up, scrub or 
digitally sign the document as needed. Previous versions of the document are preserved 
by COMPASS’s Version Control feature. 

 
14. When complete, press save. 

 
15. Close the document by closing the individual Bluebeam tab or closing the entire 

Bluebeam program. 
 

16. A window titled Close SharePoint Document will appear. Note: Comments inputted in 
this window will not be provided to the Submitter / Contractor. Comments intended for 
the Submitter / Contractor must be added to the PDF document itself or inputted in the 
COMPASS Comment Pop-Up Windows. 
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17. Select the Check In button to save any changes.  Press Release Checkout if no changes 

are made. 
 

 
 

18. A new version saves in COMPASS. The previous version(s) are preserved through 
COMPASS’s Version Control feature. 
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